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1 Concepts

The HP OpenView Smart Plug-in for WebSphere Application Server (WBS-SPI) is a
full-featured SPI that allows you to manage WebSphere servers from an HP OpenView
Operations console and also using the OpenView reporting product Reporter. This chapter
offers a basic introduction to WBS-SPI concepts in the following topics:

e  What WBS-SPI Adds to OVO for UNIX
e How WBS-SPI Works
e  WBS-SPI Components

What WBS-SPI Adds to OVO for UNIX

The WBS-SPI adds monitoring capabilities otherwise unavailable to HP OpenView
Operations (OVO) for UNIX®. Working in conjunction with OVO, the WBS-SPI offers
centralized tools that help you monitor and manage systems using WebSphere servers. From
the OVO console, you can monitor the availability, use, and performance of WebSphere
servers running on OVO-managed nodes. WBS-SPI metrics are automatically sent to the
Operations Agent and can be graphed using OpenView Reporter (purchased separately) to
help you analyze system-use trends.

Smart Plug-in Data Collection

After completing the WBS-SPI installation, you will find key server-related metrics that
covers the following areas:

server availability

server performance

memory usage

transaction rates

servlet executing times, time-outs, request rates
JDBC connection status

Web application processing

Smart Plug-in Data Interpretation

WebSphere server administrators can choose those metrics most crucial to the successful
operation of WebSphere servers by modifying WBS-SPI templates. These templates contain
settings that allow incoming data to be measured against predefined rules that generate
useful information in the form of messages. These messages with severity-level color-coding
can be reviewed for problem analysis and resolution. Corrective actions are often available in

Instruction Text as are automatically generated metric reports, available in the Annotations
area of a message.
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How WBS-SPI Works

WBS-SPI messaging, reporting, and action-executing capabilities are based on the OVO
concept of templates. The settings within these templates define various conditions within the
WebSphere server. Once in use, WBS-SPI templates allow information to be sent back to the
OpenView Operations management server to help you proactively address potential or
existing problems and avoid serious disruptions to Web transaction processing.

How WBS-SPI Collects and Interprets Server Performance/Availability
Information

The WBS-SPI, once configured and deployed to managed nodes, gathers data that is
interpreted and acted upon, according to settings within the deployed templates. Those
templates, described in a later section, define conditions that can occur within the WebSphere
server, such as queue throughput rates, cache use percentages, timeout rates, average
transaction times, etc. Default thresholds, set within the templates, monitor these conditions
and trigger messages to the console when a threshold has been exceeded.

How WBS-SPI Displays the Information

Messages in the Message Browser: Comparing the values gathered for WebSphere server
performance/availability against the monitor template settings relating to those specific
areas, OVO agent software forwards the appropriate messages to the OVO console. These
messages are displayed with color-coded severity levels in the OVO Message Browser.

and re-created but option is

Fri Aug 17 00:

Aug 17
AL
i Aug
i Aug

0 0 crollon

- Dwn | Highlight |  Details.. | 'erform Actio] Annotations.] Acknowledod |
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Instruction Text: Messages generated by WBS-SPI programs contain instruction text to
help diagnose and remedy problems. With each Message Details window, you can press the
Instructions button to view the text.
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You can usually find instruction text in the message details; this same text is also available in

the HP OpenView Smart Plug-in for WebSphere Application Server Reference manual metric
definition.

The average execution time for & serviet has exceeded the threshold

Potential

to the HTT

ASCII-Text Reports: In addition to the instruction text mentioned above, metrics with
alarms also have automatic action reports that are generated when a defined threshold is
exceeded. These reports show conditions of a specific WebSphere server instance. When a
report is available, like the instruction text, you can find it within the Message Details,
specifically in the Annotations area.

Generating Reports Using HP OpenView Reporter

The WBS-SPI also integrates with HP OpenView Reporter to provide you with over 20
management-ready, Web-based reports. WBS-SPI includes the templates for generating these
reports within its Report package, which you can install on the Reporter Windows system.
After you have installed the product and completed some configuration steps, you can expect
to see new reports of summarized, consolidated data generated nightly that can help you
assess how the WebSphere server is performing over time.
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The WBS-SPI reports can use WBS-SPI data to vividly illustrate servlet request rates,
transaction throughput rates, and average transaction execution time, to name just a few

generated reports.
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You can use WBS-SPI templates with no customization, or you can change them as you find
necessary. Possible minor modifications and major customizations are listed here:

Modification of Default Templates - Within a template you can change the default settings
for (1) collection interval, (2) threshold, (3) message text, (4) duration (5) severity level of
the condition, (6) actions assigned to the condition (operator-initiated or automatic).

Creation of Custom Template Groups - Create custom template groups, using default
templates as a starting point. To do this, see Chapter 4, Using and Customizing WBS-SPI.

Custom Metrics - The ability to define your own metrics or user-definable metrics (UDMs)
is a powerful feature that you can use to expand the monitoring capabilities of WBS-SPI.
Instructions are available in the HP OpenView Smart Plug-in User Defined Metrics User

Guide.

Chapter 1



WABS-SPI Components

The WBS-SPI components include applications and templates that allow you to configure and
receive data in the form of messages and short reports. These messages (available in the
Message Browser) and short reports (through applications or message details) provide you
with information about conditions present in the server(s) running on specific managed nodes.

WBS-SPI configuration applications let you configure the management server’s connection to
named server instances on specific managed nodes. After you have configured the connection,
you can assign templates to the nodes. With OVO agent software running on the manage
nodes, you can use WBS-SPI reporting applications to generate reports.

Chapter 2, Installing, Upgrading, and Removing the WBS-SPI details how to install the
components and use them to configure server instances on the managed nodes and then
deploy the template groups. The sections that follow here give you brief descriptions of all
components.

Applications

The WBS-SPI applications include configuration, troubleshooting, and report-generating
utilities. In the OVO Application Bank window the WBS-SPI applications are accessed by
double-clicking WBSSPI and are divided into three categories (all three categories are
available in both UNIX and Windows for a total of six application groups): WBSSPI Admin,
WebSphere, and WBSSPI Reports. Additional applications are available in the JMX Metric
Builder application group if you install the WASSPI-UDM-BUILDER software bundle.

WABSSPI Admin

This group contains configuration and troubleshooting applications requiring “root”
permission, so it is recommended the Admin group be assigned to the OVO administrator.
The applications in this group allow you to configure the connection to the server you are
monitoring and to turn collections and tracing on and off. The group contains subgroups and
applications that are nearly duplicate for UNIX and Windows nodes.

WBSSPI Admin applications allow you configure, control, and troubleshoot the WBS-SPI.
Application Group: WBSSPI Admin '

Start Monitoring

e
Wiews Error File
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The WBSSPI Admin group contains the following applications (additional information is
located in Appendix C, Applications):

Config WBSSPI - Launches the configuration editor and maintains the WBS-SPI
configuration.

Discover - Sets basic configuration properties needed for discovery.

Init Non-Root - Simplifies the configuration of a non-root HTTPS agent on a UNIX
managed node (OVO 8.x only). Refer to Configuring a Non-Root HTTPS Agent on a UNIX
Managed Node (OVO 8.x Only) on page 47 for all the steps necessary to configure a
non-root HTTPS agent on a UNIX managed node.

Self-Healing Info - Collects data to be sent to your HP support representative.

Start/Stop Monitoring - Starts/Stops the collection of metrics for the entire WBS-SPI or
for a selected server on the managed node.

Start/Stop Tracing - Starts/Stops tracing of the collections of metrics into a file. Run this
application only when instructed by your HP support representative.

Verify - Verifies that the WBS-SPI is properly installed on the server or managed node.
View Error File - View the contents of the WBS-SPI error log file.

View Graphs - View WBS-SPI metric data in OpenView Performance Manager i a web
browser (additional setup is required: see Task 1: Configure the Management Server to
Launch your Web Browser on page 33 for more information).

WebSphere

These applications offer a quick way of checking the status or logfiles of a WebSphere server
and starting or stopping a server.
WebSphere applications provide you with convenient access to WebSphere server functions.

You can open the WebSphere applications by double-clicking WBSSPI = WebSphere in the
Application Bank window.

|

Application Group: WehSphere | : |J

Map Actions Edit View Window Help

opc_adm [Read—Write]

Check WehSphere Start Vieh Sphere Stop Web Sphere

Auto—Layout] [Connection Labels Off]

The WebSphere group contains the following applications:

Check WebSphere - Does an interactive status check of selected WebSphere application
servers.

Start WebSphere - Allows an OpenView Operations user to start one or all WebSphere
application servers on a managed node (requires setup).

Stop WebSphere - Allows an OpenView Operations user to stop one or WebSphere
application servers on a managed node (requires setup).

View WebSphere Log - Allows a user to view the entire specified WebSphere log file.
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WABSSPI Reports

Generated manually by dragging the managed node onto the window/report you have
accessed by selecting
Application Bank > WBSSPI > WBSSPI Reports = <selected report>.

Definitions for the individual metrics contained in each report are available in the HP
OpenView Smart Plug-in for WebSphere Application Server Reference manual.

These reports reflect the current condition of all configured server instances on the managed
node at the time you generate it. WBS-SPI reports require that the targeted managed node
have a PMI level setting at or above the rating for the metric you are selecting.

WBSSPI Reports show collected data on all server instances on the targeted node.

Application Group: WBSSPI Beports

Map Actions Edit View Window

gl 8 S &2

1005 _JUR MemUt 1040 Sepe Sezsd 1041 Sepy Sessbct! 1042 Sepelne Se [212_ThreadPool 1213 Thread Pool Potilas
r r r r r r

1220_EJEPool 1221_EJEMethRe I222_EJEMethod 1224_EJEEntD 1246 _YWebipp Sen. 1247 _Webipp ServletErorR

JOECConn 1262_JOBCConnPo 1263 JDOBCCon 1264 _JOBCConr 1I265_JOBCConn PoolTimeoud
Q r ¥ ¥

opc_adm [Read—¥frite] [Autu—Layuut]

WBSSPI Reports Generated from Alarms

WBS-SPI reports are also used to capture the data on a current condition in a server. Such a
report is triggered by an alarm condition and shows an individual server instance on a
managed node. These reports are available by clicking the Annotations button in the OVO
Message Browser. If you have configured your Message Browser to display the SUITAONE
columns, an S the A column (adjacent to the message) indicates that a report has been
successfully generated and is waiting in the Annotations of the message.
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JMX Metric Builder Applications

If you install the WASSPI-UDM-BLDR software bundle, the following applications are
installed in the JMX Metric Builder application group (refer to the HP OpenView Smart

Plug-in User Defined Metrics User Guide for more information about these applications and
how to install the WASSPI-UDM-BLDR software bundle):

e Deploy UDM - Deploys the UDM file.

e Gather MBean Data - Collects MBean information to be used with the JMX Metric
Builder.

e JMX Metric Builder - Launches the JMX Metric Builder application that is used to create
UDMs and browse MBeans.

e Trace JMB - Launches the JMX Metric Builder application with tracing enabled.

e  UDM Graph Enable/Disable - Starts/Stops data collection for UDM graphs. Also starts/
stops the OVO subagent.

Template Groups and Templates

WBS-SPI template groups provide a means of organizing various OVO templates. The SPI for
WebSphere template group organizes templates into WebSphere High, Medium, and Low
Impact groups, based on the impact that their data collections incur on system performance.
The Low Impact group has only low impact metrics. The Medium Impact group has both
medium and low impact metrics. The High Impact group has all metrics: high, medium, and
low impact metrics. Please see the HP OpenView Smart Plug-in for WebSphere Application
Server Reference manual for complete listings of the specific metrics included in each group.

All data collection affects performance in some way, with impact varying according to metric
(counter). The overhead cost associated with each WBS-SPI metric is represented with a
rating of high, medium, or low. Metrics with medium or high ratings have higher performance
impacts. The calculations required for the collected data generally require multiplication,
division, or both. A metric with a low rating involves only a minor performance cost since its
calculation requires just a single addition or subtraction.

Templates Edit Wiew Window

Template Groups

The SPI for WebSphere template group contains the following template groups and individual
templates:
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e  WBSSPI-Logfiles - Contains templates that generate messages according to log file and
error text detected in both the WebSphere server log files and in the WBS-SPI log files.
The information captured from these log files includes errors that occur in the operation of
the WebSphere server or the WBS-SPI and changes to WebSphere server configuration.

e  WBSSPI-Metrics - Contains metric templates that monitor the performance levels and
availability of a WebSphere server.

Each metric template determines the threshold conditions for the monitored metric, the
message text that is sent to the OVO message browser when the threshold is exceeded,
the actions to execute, and instructions that appear.

e  WBSSPI-Monitors - Contains collector templates that specify the collection interval of
metric templates. Within the name of each collector template is its collection interval. For
example, the collection interval of template WBSSPI-40-High-1h is one hour (where 1h
represents one hour). Each collector template is assigned a collection interval of 5
minutes, 15 minutes, or one hour.

When you open any collector template, you see the metrics collected within the interval
(listed by number, following the -m option of the collector/analyzer command
wasspi_wbs_ca).

Each collector template controls when and what metrics are collected. Specifically, the
collector template does the following:

— Runs the collector/analyzer at each collection interval
— Specifies which metrics are collected

e WBSSPI-Messages - A single template that is used to intercept WBS-SPI messages for the
OVO message browser.

e  WBSSPI Discovery - A single template that updates the configuration on the OVO
management server and managed nodes.

WebSphere Template Groups and System PMI Levels

When you deploy a template group on a managed node, the PMI level of the node is
automatically adjusted to that of the template group. For example, deploying the WebSphere
High Impact template group on a node would result in a PMI setting of “high” for the node.

PMI levels, once set, do not automatically revert to lower impact levels, even after removing
templates from a node and/or deploying a lower impact level template group. To lower a PMI
level for a node requires that you manually reset the PMI level within WebSphere.
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2 Installing, Upgrading, and Removing the
WABS-SPI

This chapter covers installing, upgrading, and removing Smart Plug-in for WebSphere
Application Server (WBS-SPI) components.

The sections that follow provide instructions for:
e How to Install WBS-SPI
¢ How to Remove WBS-SPI

e How to Upgrade from a Previous Version

How to Install WBS-SPI

The OpenView Operations (OVO) management server and discovery package must be
installed before you can install the WBS-SPI. It is not necessary to stop OVO sessions before
beginning the WBS-SPI installation.

The discovery package and WBS-SPI are available on the HP OpenView Smart Plug-ins for
OVO/UNIX CD.

For a complete list of software requirements, refer to the Smart Plug-in for WebSphere
Application Server Release Notes.

) The instructions that follow cover a command line swinstall installation. For HP-UX systems,
you can also use the graphical user interface (GUI), even though the GUI method is not
covered here.

) If you are going to create UDMs, also install the WASSPI-UDM-BLDR software bundle. Refer to
the HP OpenView Smart Plug-in User Defined Metrics User Guide for more information about
this software bundle.

For an HP-UX 11.0 management server, enter:
swinstall -s /cdrom/OV_DEPOT/1ll.0HPUX.sdtape WBSSPI
For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape WBSSPI
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WABS-SPI Bundles/Filesets

The swinstall commands in the previous section install filesets for all managed node
platforms. If you have only one kind of managed node, you may want to install the filesets
only necessary for the platform you have. Instead of specifying “WBSSPI” on the swinstall
command, you can specify one or more of the bundle names listed below.

Bundle Name Filesets Description

SPIWebSphereHPUX |WBSSPI-CORE Filesets required for a managed node running
WBSSPI-HPUX on HP-UX.

SPIWebSphereSOL WBSSPI-CORE Filesets required for a managed node running
WBSSPI-SOL on Solaris

SPIWebSphereAIX WBSSPI-CORE Filesets required for a managed node running
WBSSPI-AIX on AIX.

SPIWebSpherelX86 |WBSSPI-CORE Filesets required for a managed node running
WBSSPI-LXx86 on Linux.

SPIWebSphereAll WBSSPI-CORE Filesets required for managed nodes running
WBSSPT -HPUX on HP-UX, Solaris, Windows, AIX, and Linux.
WBSSPI-SOL
WBSSPI-AIX
WBSSPI-LXx%86

How to Remove WBS-SPI

The complete removal of the WBS-SPI installation deletes all WBS-SPI components.
Complete the tasks in the order listed:

e Task 1: Remove the WBS-SPI Software from the Management Server

e Task 2: Remove WBS-SPI Software from the Node Group and Managed Nodes

e Task 3: Delete WBS-SPI Templates and Template Groups

e Task 4: Delete WBS-SPI Applications

e Task 5: Delete the WBS-SPI Message and Node Groups

e Task 6: Remove the WBS-SPI Directory

e Task 7: Remove the Report Package (Optional)

¢ Task 8: Remove the Graph Package (Optional)
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Task 1: Remove the WBS-SPI Software from the Management Server

1
2

Open a terminal window and log on as root.

In the terminal window, enter one of the following: /usr/sbin/swremove WBSSPI or
/usr/sbin/swremove SPIWebSphereAll

The swremove command removes the files from the file system only. The WBS-SPI templates
are still in the OVO data repository and must be deleted manually. Before the templates can
be deleted, they (and the WBS-SPI software) must be de-assigned from the managed nodes.

Task 2: Remove WBS-SPI Software from the Node Group and Managed Nodes

1
2

Open the Node Bank and, from the Actions menu, select Agents - Assign Templates.

Select the WebSphere node group and all managed nodes to which WebSphere templates
have been assigned.

Press the Remove nodes/groups button.
Open the Node Group Bank and select the WebSphere node groups.

From the Action menu select Install/Update SW & Config and check the following check
boxes:

e Templates

e Actions

® Monitors

e Commands

Select the Nodes in List option button.
Select the Force Update option button.

Click OK to remove the Templates, Actions, Commands and Monitors from the managed
node(s). The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors

Task 3: Delete WBS-SPI Templates and Template Groups

Starting from the SPI for WebSphere template group, delete all templates and template
groups. Once these templates and template groups have been deleted, delete the SPI for
WebSphere template group.

1

Open the Message Source Templates window and double-click the SPI for WebSphere
template group

Use SHIFT+Click to select all templates and template groups in the SPI for WebSphere
template group.

Click the Delete from All... button.
Select YES in response to the message:

Do you really want to delete the template(s)?
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5 If additional WBS-SPI templates and/or template groups are in the SPI for WebSphere
template group, repeat steps 2 -4 until you have deleted all WBS-SPI templates and
template groups from the SPI for WebSphere template group.

6 Go up one level and delete the SPI for WebSphere template group.

) If you have customized templates (copies of WBS-SPI default templates) residing in other
OVO template groups, you should remove them as well.

Task 4: Delete WBS-SPI Applications

Unlike templates, applications can all be removed in a single step.
1 Open the Application Bank.

2 Right-click the WBSSPI application group and select Delete.

3 Click Yes in response to the following message:

Do you really want to delete the application group?

Task 5: Delete the WBS-SPI Message and Node Groups

1 From the Window menu select Message Group Bank.

In the Message Group Bank window right-click the WBSSPI group and select Delete.
Repeat for the WebSphere group.

From the Window menu select Node Group Bank.

In the Node Group Bank window right-click the WebSphere (High, Low, and Medium)
node group and select Delete.

O A W N

Task 6: Remove the WBS-SPI Directory

1 From a command line, remove the WBS-SPI directory by entering:

rm -rf /var/opt/OV/wasspi/wbs

Task 7: Remove the Report Package (Optional)
If you installed the WBS-SPI report package (on your Windows system running Reporter),
remove it:

1 On the Windows system running Reporter, from the Control Panel, double-click on the
Add/Remove Programs icon.

2 Highlight the WBS-SPI report package and select Remove.

Task 8: Remove the Graph Package (Optional)

If you installed the WBS-SPI graph packages (on the OVO management server and on your
system running OVPM), remove them.
On the OVO management server, run the following command:

/usr/sbin/swremove WBSSPI-GRAPHS
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On a Windows system running OVPM, do the following:
1 From the Control Panel, double-click on the Add/Remove Programs icon.

2 Highlight the WBS-SPI graph package (HP OpenView SPI for WebSphere Application
Server - Graphing Component Integration) and select Remove.

On an HP-UX system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are removed in
Task 1: Remove the WBS-SPI Software from the Management Server on page 23):

1 Verify that the graph package is installed. Type swlist | grep WBSSPI-GRAPHS
2 Type swremove WBSSPI-GRAPHS

On a Solaris system running OVPM that is not the OVO management server, do the following
(if OVPM is installed on the OVO management server, the files are removed in
Task 1: Remove the WBS-SPI Software from the Management Server on page 23):

1 Verify that the graph package is installed. Type /usr/bin/pkginfo HPOvSpiWbsGc
2 Type /usr/sbin/pkgrm HPOvSpiWbsGc

How to Upgrade from a Previous Version

When you upgrade from a previous installation, all your configuration entries are preserved.
To upgrade the WBS-SPI, do the following:

e Task 1: Remove WBS-SPI Software from the Management Server

e Task 2: Delete WBS-SPI Templates

e Task 3: Delete WBS-SPI Applications

e Task 4: Upgrade the Management Server

e Task 5: Assign Operator Responsibilities

e Task 6: Assign Templates

e Task 7: Distribute Templates

e Task 8: Customize Templates

e Task 9: Update WebSphere Log Template

e Task 10: Move Nodes to New Node Group

e Task 11: Delete Node Groups

e Task 12: Distribute Actions, Monitors, Commands, and Templates on page 29
e Task 13: Run the Discover Application

e Task 14: Install the New Report Package (Optional)

e Task 15: Install the New Graph Package (Optional)

e Task 16: Configure a Non-Root Agent on a UNIX Managed Node (Optional)

Task 1: Remove WBS-SPI Software from the Management Server

1 Open a terminal window and log on as root.
2 In the terminal window, enter the following:

/usr/sbin/swremove WBSSPI
/usr/sbin/swremove WBSSPI-GRAPHS
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Task 2: Delete WBS-SPI Templates

>»

Delete all WBS-SPI templates and template groups that appear under the SPI for WebSphere
template group and the SPI for WebSphere template group itself. If you have customized any
of the default templates, note these changes (these customizations are not saved).

1 Open the Message Source Templates window and double-click the SPI for WebSphere
template group

2 Use SHIFT+Click to select all templates and template groups in the SPI for WebSphere
template group.

3 Click the Delete from All... button.
4  Select YES in response to the message:
Do you really want to delete the template(s)?

5 Repeat steps 2 -4 until you have deleted all WBS-SPI templates and template groups from
the SPI for WebSphere template group.

6 Go up one level and delete the SPI for WebSphere template group.

If you have customized templates (copies of WBS-SPI default templates) residing in other
OVO template groups, you should remove them as well.

Task 3: Delete WBS-SPI Applications

Unlike templates, all WBS-SPI applications can be removed in a single step.
1 Open the Application Bank.

2 Right-click the WBSSPI application group and select Delete.

3 Click Yes in response to the following message:

Do you really want to delete the application group?

Task 4: Upgrade the Management Server

The WBS-SPI software is available on the HP OpenView Smart Plug-ins for OVO/UNIX CD.

The instructions that follow show the command line usage of swinstall. For HP-UX systems,
you can also use the graphical user interface (GUI), but the GUI method is not covered.

For an HP-UX 11.0 management server, enter:
swinstall -s /cdrom/OV_DEPOT/1l1l.0HPUX.sdtape WBSSPI
For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape WBSSPI

Task 5: Assign Operator Responsibilities

1 Logon to OVO as administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and choose Modify.
3 Press Responsibilities in the Modify User:opc_adm user window.
4

For WBSSPI and WebSphere Message Groups, ensure all boxes are checked.
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5
6

Assign the WBSSPI Node or Message Groups to any other appropriate operators.
Click Close.

Task 6: Assign Templates

Assign the WBSSPI-Discovery and WBSSPI-Messages templates to the management server:

1
2

Open the Node Bank window and highlight the management server.

From the Actions menu, select Agents = Assign Templates. The Define Configuration
window displays.

Click Add. The Add Configuration window displays.
Click Open Template Window. The Message Source Templates window displays.

From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

From the Message Source Templates window, in the right pane, select the
WBSSPI-Discovery and WBSSPI-Messages templates.

From the Add Configuration window, click Get Template Selections. The WBSSPI-Messages
and WBSSPI-Discovery templates appear in the right pane.

From the Add Configuration window, click OK.

Task 7: Distribute Templates

Distribute the WBSSPI-Discovery and WBSSPI-Messages templates to the management
server:

1

o O AN

Open the Node Bank window and highlight the management server.

From the Actions menu, select Agents - Install/Update SW & Config.

In the Target Nodes section, select Nodes in List Requiring Update.

In the Install/Update Software and Configuration window check the Templates check box.
Select Force Update.

Click OK.

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates

The WBSSPI-Discovery and WBSSPI-Messages templates are distributed to the management
server.

Task 8: Customize Templates

If you noted any customizations in Task 2: Delete WBS-SPI Templates on page 26, make a
copy of the default templates, and then make these same customizations to the copies. In this
version of the WBS-SPI, the templates are no longer grouped by WebSphere version numbers.
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Task 9: Update WebSphere Log Template

Update the audit, deprecated, and informational suppress conditions for the WebSphere Log
Template:

1

From the Message Source Templates window, open the SPI for WebSphere template
group.
Select a WBSSPI-Templates impact group (High, Low, and Medium) and do the following:

a
b

C

e

Open the impact group.
Open the WBSSPI-Logfiles group.
Select the WebSphere Log Template and click Conditions.

Move the “Audit,” “Deprecated,” and “Informational” suppress conditions to the top of
list.

Message and Suppress Conditions

iLogfile: ere Log Template

Click Close.

Task 10: Move Nodes to New Node Group

Move all managed nodes that are in the SPI for WebSphere node groups to the new
WebSphere node group.

Open the Node Bank and select the SPI for WebSphere node group.

1
2

Double-click on each subgroup in the WebSphere 4.0 node group and note the managed
nodes in it.

Go back to the top level of the node bank (where the WebSphere node group is displayed)

Drag and drop or copy and paste the nodes (noted in step 2) from the IP submap to the
appropriate WebSphere node group.
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Task 11:

Delete Node Groups

Delete all versioned node groups that are in the SPI for WebSphere node group (WebSphere
4.0).

1
2

Open the Node Bank and select the SPI for WebSphere node group.
Select the WebSphere 4.0 and, from the Edit menu, select Delete.
Click Yes in response to the following message:

Do you really want to delete the node group?

Distribute Actions, Monitors, Commands, and Templates

At the OVO console, in the Node Bank window, select the node(s) or node group on which
to install the WBS-SPI.

From the Node Bank’s Actions menu select Agents — Install/Update SW & Config.

In the Install/Update OVO Software and Configuration window select the following
component check boxes:

e Templates

e Actions

e Monitors

e Commands

Using this dialog, deploy updated components to the managed node(s).
Check the Force Update check box.

Select the Nodes in list button. Upon completion, the following message and appears in
the Message Browser for each managed node:

The following configuration information was successfully distributed:
Actions Commands Monitors Templates

) You may see some WBS-SPI errors in the message browser which you can ignore (these errors
are the result of the transition to the updated programs). WBS-SPI templates/programs are
updated on the Management Server and selected managed node(s). These errors are resolved
when the upgrade is complete.

Task 13:

Run the Discover Application

You must run the Discover application but there is no need to re-enter any of the WBS-SPI
configuration data (all configuration data is preserved). To re-deploy the file, you can drag and
drop multiple nodes at once, node groups, or single nodes. When you re-deploy the file,
relevant information is updated, transmitted, and stored on the node.

1
2
3

At the OVO console, select the node(s) in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI - WBSSPI Admin — Discover. (If the items
do not appear, select Map = Reload.)

The “Introduction” window displays.

Select Next.
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5 A second “Introduction” window displays. This window displays information about which
properties may be required in order for the discovery process to work.

Read this information and select Next.
6 From the configuration editor, make any changes.

’ If you have set the GRAPH_SERVER property, please note that this property is no longer
supported in the WBS-SPI. Instead, set the GRAPH_URL property.

) If you have set the UDM_DEFINITIONS_FILE property, please note that this property will
not be supported in future versions of the WBS-SPI. Note the locations of the UDM files
on your managed nodes and delete any occurrence of the UDM_DEFINITIONS_FILE
property from your configuration.

If you individually configured UDMs on your managed nodes, you must instead configure
these UDMs on the management server in the /opt/0OV/wasspi/wbs/conf/
wasspi_wbs_udmDefnintions.xml file (or, set the UDM_DEFINITIONS_SOURCE property to
use another file).

Once you have consolidated your UDMs on the management server, delete your old UDM
files from the managed nodes and distribute the new UDM file to the managed nodes
using the Deploy UDM application.

7 Select Next to save any changes and exit the editor.
8 The “Confirm Operation” window displays. Select OK.

) If you select Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Discover application, select Next from the configuration editor, and then select OK.

’ Do not close the Discover application window until the discovery process has completed. The
discovery process may take several minutes to complete.

Task 14: Install the New Report Package (Optional)
If you installed an older version of the WBS-SPI report package (on your Windows system
running Reporter), you must uninstall it and install the new WBS-SPI report package.

1 On the Windows system running Reporter, from the Control Panel, double-click on the
Add/Remove Programs icon.

2 Highlight the WBS-SPI report package and select Remove.

3 Follow the steps to install the WBS-SPI report package in Integrating with HP OpenView
Reporter on page 69*.

Your upgrade is now complete.
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Task 15: Install the New Graph Package (Optional)
If you installed an older version of the WBS-SPI graph package (on your system running
OVPM), you must uninstall it and install the new WBS-SPI graph package.
On a Windows system running OVPM, do the following:
1 From the Control Panel, double-click on the Add/Remove Programs icon.

2 Highlight the WBS-SPI graph package (HP OpenView SPI for WebSphere Application
Server - Graphing Component Integration) and select Remove.

3 Follow the steps to install the WBS-SPI report package in Integrating with HP OpenView
Performance Manager on page 73.

On an HP-UX system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are automatically
updated when you install the SPI software):

1 Verify that the graph package is installed. Type swlist | grep WBSSPI-GRAPHS
2 Type swremove WBSSPI-GRAPHS

3 Follow the steps to install the WBS-SPI graph package in Integrating with HP OpenView
Performance Manager on page 73.

On a Solaris system running OVPM that is not the OVO management server, do the following
(if OVPM is installed on the OVO management server, the files are automatically updated
when you install the SPI software):

1 Verify that the graph package is installed. Type /usr/bin/pkginfo HPOvSpiWbsGc
2 Type /usr/sbin/pkgrm HPOvSpiWbsGc

3 Follow the steps to install the WBS-SPI graph package in Integrating with HP OpenView
Performance Manager on page 73.

Your upgrade is now complete.

Task 16: Configure a Non-Root Agent on a UNIX Managed Node (Optional)

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node,
refer to Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x Only) on
page 47 for more information.
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3 Configuring the WBS-SPI

This chapter covers configuring the Smart Plug-in for WebSphere Application Server
(WBS-SPI) for use with OpenView Operations (OVO). To successfully configure WBS-SPI, you
must complete all configuration prerequisites, complete WBS-SPI configuration (for managed
nodes and the management server), and complete additional configuration based on your
environment.

Configuration Prerequisites

On the OVO management server, complete the following tasks before configuring WBS-SPI:
e Task 1: Configure the Management Server to Launch your Web Browser

e Task 2: Assign Operator Responsibilities

e Task 3: Assign Templates

e Task 4: Distribute Templates

e Task 5: Update the remactconf.xml File (OVO 8.x Only)

Task 1: Configure the Management Server to Launch your Web Browser

WBS-SPI uses the ovweb utility to start your web browser for displaying graphed metrics
(which requires HP OpenView Performance Manager). If you do not use OpenView
Performance Manager (OVPM), skip this task.

1 Enter the browser invocation command in the ovweb. conf file. If no browser invocation
command is included in the ovweb. conf file, ovweb tries to start Netscape Navigator
(which must be version 6.0 or higher).

) The ovweb. conf file must be located in the directory specified by the environment variable
$OV_CONF (used by OVO). To find the OVO directory structure on your management server,
open the /opt/0V/bin/ov.envvars. sh file and look for the $0vV_CONF definition.

The browser invocation command must contain a %s to allow WBS-SPI to pass a URL to
the browser. Open the file and insert the command according to the entry syntax and
example as follows:

Syntax: Browser: <browser command> %s
Example: Browser: /opt/netscape/netscape %s

2 Check the Web browser setting. To display the WBS-SPI graphs, ensure that your browser
is JavaScript enabled. Check the setting within the browser’s Preferences.

3 In Task 3: Run Discover on page 42, set the following conditional properties:

e Ifyou are using OVPM, set the GRAPH_URL property.
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For more information about launching a browser in OpenView Operations, consult the man
pages for ovweb, ovweb.conf, and ov.envvars. To access instructions for enabling graph
displays, at a command prompt enter: man ovweb

Task 2: Assign Operator Responsibilities

1

2
3
4

Log on to OVO as administrator (opc_adm).
Open the User Bank window, right-click the opc_adm user, and choose Modify.
Press Responsibilities in the Modify User:opc_adm user window.

For WBSSPI and WebSphere Message Groups, ensure all boxes are checked.

nsibilities for Operator

5 Assign the WBSSPI Node or Message Groups to any other appropriate operators.
6 Click Close.

Task 3: Assign Templates

Assign the WBSSPI-Discovery and WBSSPI-Messages templates to the management server:

1

Open the Node Bank window and highlight the management server.
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2 From the Actions menu, select Agents = Assign Templates. The Define Configuration
window displays.

pefine Configuration

nagemert Servall

3 Click Add. The Add Configuration window displays.

ge Source Templates 1 [opc_adm]
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From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

From the Message Source Templates window, in the right pane, select the
WBSSPI-Discovery and WBSSPI-Messages templates.

From the Add Configuration window, click Get Template Selections. The WBSSPI-Discovery
and WBSSPI-Messages templates appear in the right pane.

Add Configuraticon

8

From the Add Configuration window, click OK.

Task 4: Distribute Templates

Distribute the WBSSPI-Discovery and WBSSPI-Messages templates to the management
server:

1

o O A WN

Open the Node Bank window and highlight the management server.

From the Actions menu, select Agents - Install/Update SW & Config.

In the Target Nodes section, select Nodes in List Requiring Update.

In the Install/Update Software and Configuration window check the Templates check box.
Select Force Update.

Click OK.

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates

The WBSSPI-Discovery and WBSSPI-Messages templates are distributed to the management
server.
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Task 5: Update the remactconf.xml File (OVO 8.x Only)

If you are running DCE-based agents on your managed node(s), the discovery process must be
allowed to run automatic actions on the management server. Do the following:

1 Merge (if you have updated this file) or replace the
/etc/opt/0OV/share/conf/OpC/mgmt_sv/remactconf.xml with the
/opt/0OV/wasspi/wbs/OV/remactconf .xml file.

2 Restart the OVO management server: opcsv -start (you must restart the management
server if you modify the remactconf .xml file)

If the remactconf.xml file is not updated, the discovery process fails.

WBS-SPI Configuration - Managed Nodes

To configure WBS-SPI, complete the following tasks (for each managed node):
e Task 1: Verify the Application Server Status

e Task 2: Collect WebSphere Login Information

e Task 3: Enable PMI

Task 1: Verify the Application Server Status

Verify that your application servers are running.

For WebSphere Server version 4, check the server’s status from the WebSphere
administrative console. Under the General tab, a colored marker appears next to the
Application Server name. A green marker means the server is running. A red marker means
the server is not running.

- -] ]

Console Yiew Tools Help
ele @ ¥ x -
= %8 WebSphere Administrative Donain |- Hame
(3 Virtual Hosts )0 Installed EJB Hodules
2 Server Groups A2 Installed Web Modules
=} B2 Modes E
= @ dukat .
2} B fpplication . . A
Sﬂ : rGener'al rﬂduanced I?ile I ranzaction r.T'u'M Settings rSer'uwes rCustom |
B2 Generic Ser rs
2 Enterprise Applications : Application Server name: Default Serw
(2 Resources :
Modet dukat
Environment | Enviromment., ., .
borking directory: |#opt AMsbSphere fppSarvar/bin
Mode startup state: |Last state v| _
Maximum =tartup attempts: |2 |attempts

Type | Time | Event Message Source | Optians
B 1716703 10:... Console Ready. - QP
Ietails, .,
Clear

|
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For WebSphere Server version 5, check the server’s status from the WebSphere
administrative console.

‘3 websphere Administrative Console - Microsoft Internet Explorer provided by He ard 5 =191 x|
| Ho Ed Vew Favortes ook Heb E
| ek - = - @D [2] 4} Qioearch [Giravories (Fristory | [ S @ - ]
| address [&] htp:jrodes 9090/ schinsecurelogon.do ] @ | |links *
bSphere 1d 0 i
24 . &
Home | Save | Preferences | Logout | Help | a[a]
User IOk adrmin Application Servers > =
OVRNTTE3 serverl
& Servers [
An application server |s & server which provides services required to run erterprise sppilcations. 1]
Lgpication Servers
B Apsications Runtime || configuration
[E Resources
E Sscurity
[® Environment Mame server] [1] The dispésry name tor the

[E Syslem Administration -erver.

@ Troubleshooting Intiail Staée |[Ztarted =] il The execution state requested
vhen the serves is first started.
LS| LSS SIUGUET AL [|Muttple v (i) Specities whether there is &
single clagsioader for all
| applcations (“Single") or & T|
WebSphere Status [i] <Previous MNeds March 12, 2004 308:31 AMPST & | [
WebSphere Configuration Problems
Total Configuration Problems .0 O Dictal o |0
total [total ﬂ
& [ 1€ Local intranet 5

If you cannot verify the server’s status using the administrative console, run the following
commands on the managed node:

e UNIX: <webSphere Install_Dir>/bin/serverStatus.sh -all

For example: /opt/WebSphere/AppServer/bin/
serverStatus.sh -all

e  Windows: <WebSphere Install_Dir>\bin\
serverStatus.bat -all

For example: C: \Program Files\WebSphere\AppServer\bin\
serverStatus.bat -all

Task 2: Collect WebSphere Login Information

If security is enabled on the WebSphere server, collect the username and password for each
WebSphere Admin Server. The user must have the correct privileges assigned for the
WebSphere Admin Server.

The username and password are needed by the WBS-SPI discovery process to gather basic
configuration information and by the WBS-SPI data collector to collect metrics.

Configuration of WBS-SPI is simplified if the same username and password are used by each
WebSphere Admin Server.

If you are using WebSphere version 5.1.0 or earlier, you must use the default WebSphere
Admin Server username and password (the username and password configured when the
WebSphere application server was installed/configured).

If you are using WebSphere version 5.1.1 or later, you should be able to use the username and
password for users/groups assigned to the administrator or operator role.
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Task 3: Enable PMI

If you are running WebSphere server version 5, enable PMI using the WebSphere
administrative console and restart the server. Refer to http:/publib.boulder.ibm.com/
infocenter/ws51help/index.jsp?topic=/com.ibm.websphere.base.doc/info/aes/ae/
tprf_prfstartadmin.html for more information.

PMI is necessary for collecting metrics.

WBS-SPI Configuration - Management Server

To configure WBS-SPI, from the management server, complete the following tasks:
e Task 1: Assign the WBSSPI-Messages Template

e Task 2: Distribute Templates, Actions, Monitors, and Commands

e Task 3: Run Discover

e Task 4: Verify the Discovery Process

e Task 5: Add Nodes to a WBS-SPI Node Group

e Task 6: Distribute WBS-SPI Templates

e Task 7: Completing Configuration

e Task 8: Run the Verify Application

Task 1: Assign the WBSSPI-Messages Template

Assign the WBSSPI-Messages template to the managed node(s):
1 Open the Node Bank window and highlight the managed node(s).

2 From the Actions menu, select Agents = Assign Templates. The Define Configuration
window displays.

pefine Conftiguration

Managed Node
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Click Add. The Add Configuration window displays.

add Configuration

WESSPI-Templates-Med:

Lraup £
Message WESSPI-Messages
G aup WESSPI-Discovery

From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

From the Message Source Templates window, in the right pane, select the
WBSSPI-Messages template.
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7  From the Add Configuration window, click Get Template Selections. The WBSSPI-Messages
template appears in the right pane.

Add Configuraticon

8 From the Add Configuration window, click OK.

Task 2: Distribute Templates, Actions, Monitors, and Commands

1 Highlight the managed node(s) on which to install the SPI components.
2 From the Node Bank window’s Actions menu select Agents - Install/Update SW & Config.

3 In the Install/Update VPO Software and Configuration window select the following
component check boxes:

e Templates
e Actions

¢ Monitors

e Commands

Using this dialog, you deploy program components to the managed node(s).
Install { Update ITO Software and Configuration
Components larget Nodes
Agent Software SR
MNodes in list

" Templates

roses22222228. Get Map

" Actions Selections
" Monitors

v Commands
Delete

Additional Node:

Dptions

% Force Update

Cancel Help

_. -
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4 Check the Force Update check box.
5 Select the Nodes in list button.
6 Click OK.

Upon completion, the following message appears in the Message Browser for each managed
node:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors

The WBS-SPI is now installed on the management server and selected managed node(s). If
you want to install the WBS-SPI on other managed nodes, repeat these steps.

Task 3: Run Discover

1 At the OVO console, highlight the node(s) in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin and double-click
Discover. (If the above does not appear as described, select Map - Reload.)

4  The “Introduction” window displays. This window contains brief information about the
Discovery application.

Select Next.

5 A second “Introduction” window displays. This window displays information about which
properties may be required in order for the discovery process to work.

Read this information and select Next.

6 If you have already set the LOGIN and PASSWORD properties, the configuration editor
displays. Go to the next step.

If you have not set the LOGIN and PASSWORD properties, the “Set Access Info for Default
Properties” window displays.

. Info for De|r

If security is not enabled on the application server, leave these fields blank, select Next,
and go to step 9.
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If security is enabled on the application server, the WebSphere Admin Server login
information is required. Enter the username and password collected in Task 2: Collect
WebSphere Login Information on page 38. The LOGIN and PASSWORD properties are set to
this information.

The LOGIN and PASSWORD properties set in this window are used as the default WebSphere
Admin Server login and password (they are set at the global properties level). That is, if
no NODE level or server-specific LOGIN and PASSWORD properties are set, this WebSphere
login and password are used by WBS-SPI to log on to all WebSphere Admin Servers. For
more information about the configuration structure, refer to Structure on page 129.

If the WebSphere Admin Server login and password are the same for all WebSphere
application servers on all OVO managed nodes, do the following:

a Set the LOGIN and PASSWORD properties in the “Set Access Info for Default Properties”
window.

b  Select Next.
¢ Gotostep9.

If the WebSphere Admin Server login and password are different for different instances of
WebSphere, you must customize the WBS-SPI configuration by setting the LOGIN and
PASSWORD properties at the NODE or server-specific level (for more information about the
configuration structure, refer to Structure on page 129):

a Set the LOGIN and PASSWORD properties to the most commonly used WebSphere login
and password in the “Set Access Info for Default Properties” window.

b Select Customize to open the configuration editor.

7 From the configuration editor, set the configuration properties. Refer to Appendix B, The
Configuration, for more information about using the configuration editor.

8 Select Next to save any changes and exit the editor.

9 The “Confirm Operation” window displays. Verify the nodes on which the operation is to
be performed. Select OK.

’ If you select Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Discover application, select Next from the configuration editor, and then select OK.

) Wait for the discovery process to complete before going to the next task. The discovery
process may take several minutes to complete.

Task 4: Verify the Discovery Process
1 Verify that the following messages appear in the Discover application window (the
Discover application has completed successfully):

Discovery started on node: <node>
Finished running the Discovery application

If the Discover application does not complete successfully, the following message appears
in the application window:

Failed to run discovery on node <node>
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Refer to Troubleshooting the Discovery Process on page 85 for information on how to
troubleshoot the discovery process.

2  Verify that the following message appears in the message browser for each managed node:

WASSPI-602- Updating the WBSSPI configuration data with discovered
information

Depending on the number of managed nodes in your environment, it may take several
minutes for these messages to display for all managed nodes.

3 IfService Navigator is already running, select File > Reload Configurations. In the Services
tree, open the Application node and look for the WebSphere service.

4  Run the Config WBSSPI application to verify the properties set by the discovery process.
Refer to Configure WBSSPI on page 154 for more information about the configuration
editor.

If you are having problems with the discovery process, refer to Troubleshooting the Discovery
Process on page 85 for information on how to troubleshoot the discovery process.

Task 5: Add Nodes to a WBS-SPI Node Group

WBS-SPI automatically creates three node groups which have been assigned the matching
WebSphere High, Medium, or Low template group:

e WebSphere High
e WebSphere Medium
e WebSphere Low

When you assign a managed node to a WBS-SPI node group, you are also assigning the
templates you want to deploy on the node.

) When data collection for the template group begins, the PMI level of the node is adjusted as
necessary to comply with the template group’s impact level. For example, data collection for a
WebSphere High Impact group results in a PMI level adjustment to high for the node if the
WebSphere PMI level is currently not at high. See WebSphere Template Groups and System
PMI Levels on page 19 for additional details.

The High template group contains all WBS-SPI metrics, while the Medium group contains
Medium and Low metrics and the Low contains only Low metrics.

To add nodes to a WBS-SPI node group, do the following:

1 From the Window menu, open both the Node Group Bank and the Node Bank to display
(side-by-side) the WBS-SPI node group and the managed nodes.

2 Drag and drop managed nodes running a WebSphere server into the appropriate
WBS-SPI node group, according to the PMI level desired for the node.

Task 6: Distribute WBS-SPI Templates

1 Open the Node Group Bank window and highlight a WBS-SPI node group.

From the Actions menu, select Agents - Install/Update SW & Config.

In the Target Nodes section, select the Nodes in List Requiring Update radio button.

In the Install/Update Software and Configuration window check the Templates check box.

g A W N

Select Force Update.
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6 Click OK.
The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates

The WBS-SPI templates are now distributed to the selected node group. WBS-SPI monitors
now begin running according to their specific collection interval.

) If you use HP OpenView Reporter, please see the Chapter 5, Using HP OpenView Reporting
and Graphing Products with WBS-SPI for information on integrating WBS-SPI with
Reporter for generating WebSphere server reports that show more consolidated information.

Task 7: Completing Configuration
Before configuration is complete, the configuration information on the management server
and managed nodes must be updated. You can either:
e Wait 10 minutes for the automatic configuration template to run; or

¢ Run the Config WBSSPI application (which updates the configuration information on the
management server and managed nodes). Refer to Configure WBSSPI on page 154 for
more information.

Task 8: Run the Verity Application
Run the Verify application to verify that WBS-SPI is properly installed and configured (refer
to Verify on page 162 for more information about this application):
1 At the OVO console, select a WebSphere node group in the Node Group Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click Verify.
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Additional WBS-SPI Configuration

Based on your WebSphere server configuration and application needs, you must finish
WBS-SPI configuration by setting additional configuration properties and/or installing and
configuring additional components. Setting additional properties and configuring additional
components depends on your environment.

Conditional Properties

Based on your WebSphere configuration and application needs, you may need to set one or
more conditional properties. If you meet a condition, set the properties listed to the left of the
condition (these properties are not automatically discovered by the discovery process). For
more information about the properties, refer to Configuration Properties on page 141.

Table 1 Conditional Properties

Conditional Property

When Required

ALIAS

Required if more than one application server on a system
share the same server name. The discovery process
automatically sets the ALIAS property, but you may want to
edit this value as this is the name used in messages, reports,
and graphs.

COLLECT_METADATA

Required if you want to utilize MBean information in the
JMX Metric Builder application to create UDMs.

JAVA_HOME Required only if using a Java version not supplied with the
WebSphere server.
Required if there are multiple Java installation directories.
ADDRESS Required if a WebSphere server is configured to a virtual IP
address or is on a remote node.
START_CMD, Required if you want to start and stop a WebSphere
STOP_CMD, and application server from the OVO console.
USER
LOGIN and Required if security is enabled on a WebSphere server.
PASSWORD

MAX ERROR_LOG_SIZE

Required if you want an error logfile larger than 2 MB.
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Setting Conditional Properties

1 At the OVO console, select the node(s) in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin - Config WBSSPI. (If the
items do not appear, select Map - Reload.)

The Introduction window displays.
4 Select Next.

5 From the configuration editor, set the properties. Refer to Using the Configuration Editor
on page 131 for more information about using the configuration editor.

6 Optionally, select Save to save any changes made to the configuration. Once you save your
changes, you cannot automatically undo them.

7  Select Finish or Next to save any changes and exit the editor.
If you selected Next, the “Confirm Operation” window displays. Select OK.

’ If you select Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the Config
WBSSPI application, select Next from the configuration editor, and then select OK.

8 Ifyou have added an application server or added/edited the HOME and/or PORT properties,
run the Discover application on the managed nodes on which the application server/
properties were added or edited. Running the Discover application updates the Service
Navigator map.

Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x
Only)

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node
(OVO 8.x only), do the following:

’ You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo
is free software available from http://www.sudo.ws. The OS-dependent software packages
are located at the bottom of the download page (http:/www.sudo.ws/sudo/download.html).
Refer to the release notes for more installation information.

1 Switch the HTTPS agent to a non-root user. Refer to the HT'TPS Agent Concepts and
Configuration Guide for more information. This document is available from
http://ovweb.external.hp.com/lpe/doc_serv/ under the product Operations for UNIX,
version 8.x.

2 On the managed node, set the OV_SUDO variable. As root or with OVO agent user
privileges, do the following:

a Stop all OVO agents. Run the following command:
opcagt -kill

b Set the OV_SUDO variable. Run the following command.:
ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo program>

where <sudo_program> is the location (including the absolute pathname) where
sudo is installed (for example, /usr/local/bin/sudo).
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c¢ Start the OVO agents. Run the following command:
opcagt -start
d Verify OV_SUDO is set. Run the following command:

ovdeploy -cmd set | grep SUDO
The following displayed:

OV_SUDO=<sudo_program>

3 Configure the managed node. These steps MUST be completed to successfully run the SPI
in a non-root HTTPS agent environment.

a From the OVO management server, deploy actions, commands, and monitors to the
managed node.

b  Select the node in the Node Bank window.

¢ From the Application Bank window, select WBSSPI > WBSSPI Admin — Init Non-Root.
4 Edit the /etc/sudoers file using the visudo editor (installed with sudo):

a On the managed node, log in as root.

b Open the /<SPI_Config DIR>/wasspi_wbs_sudoers file

where <SPI_Config_ DIR>is the location of the SPI’s configuration files on a
managed node. Refer to Managed Node File Locations on page 127 for more
information.

¢ In a separate window, run the visudo command (for example, type:
/usr/local/sbin/visudo).

d From the wasspi_wbs_sudoers file, copy and append the following lines to the
sudoers file:

Cmnd_Alias WBSSPI_ADMN = /opt/OV/nonOV/perl/a/bin/perl -S wasspi_wbs_admin *
Cmnd_Alias WBSSPI_COLL = /opt/OV/nonOV/perl/a/bin/perl -S wasspi_wbs_ca *
Cmnd_Alias WBSSPI_DISC = /opt/OV/nonOV/perl/a/bin/perl wasspi_wbs_discovery.pl
Cmnd_Alias WBSSPI_LFEN = /opt/OV/nonOV/perl/a/bin/perl -S wasspi_wbs_le *
Cmnd_Alias WBSSPI_SHSC = /opt/OV/nonOV/perl/a/bin/perl -S shs_collector.pl *

Cmnd_Alias WBSSPI_ADMNP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/0OV/bin/instrumentation/wasspi_wbs_admin *
Cmnd_Alias WBSSPI_COLLP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/0OV/bin/instrumentation/wasspi_wbs_ca *

Cmnd_Alias WBSSPI_DISCP = /opt/OV/nonOV/perl/a/bin/perl \
/var/opt/0OV/bin/instrumentation/wasspi_wbs_discovery.pl
Cmnd_Alias WBSSPI_LFENP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/0OV/bin/instrumentation/wasspi_wbs_le *

Cmnd_Alias WBSSPI_SHSCP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/0OV/bin/instrumentation/shs_collector.pl *

<OV_Agent_username> <nodename> = NOPASSWD: WBSSPI_ADMN, WBSSPI_COLL, \
WBSSPI_DISC, WBSSPI_LFEN, WBSSPI_SHSC, WBSSPI_ADMNP, WBSSPI_COLLP, \
WBSSPI_DISCP, WBSSPI_LFENP, WBSSPI_SHSCP

where <OV_Agent_username> is the OVO agent user account and
<nodename> is the name of the managed node.

e Save the file and exit the visudo editor. Type :wqg

’ Steps 3 and 4 must be performed every time the agent user is switched.
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4 Using and Customizing WBS-SPI

As you become familiar with the Smart Plug-in for WebSphere Application Server (WBS-SPI),
you can determine which templates are most useful to you and which you might want to

change. This chapter assists you by providing more detail on the templates and how to make
those changes.

The following topics are covered:

e Basic Template Customizations

e Advanced Template Customizations

¢ Monitoring a WebSphere Server on Unsupported Platforms
¢ Re-installing the WBS-SPI Templates

e Using Templates/Applications to View Annotation Reports
e Checking WBS-SPI Nodes for License Count

Basic Template Customizations

>»

After using the WBS-SPI, you may decide that some WBS-SPI templates need some
modification. Basic customization, such as changing a threshold (by modifying a metrics
template) or modifying alarm generation, are covered in this section.

Make copies of the original templates so that the default templates remain intact. Otherwise,
your customizations are overwritten when you upgrade to the next version.

Modifying Metrics Templates

Many metric attributes can be easily modified for all monitored instances of a WebSphere
server by following these steps:

1 Open the Message Source Templates window.
Open the SPI for WebSphere template group.
Open the desired impact template group and then the WBSSPI-Metrics template group.

Double-click the desired metric to open the Message and Suppress Conditions window.

O A W N

Double-click the desired condition to modify (there is usually only one).
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Condition

Object Pattern

Threshold Duration

= Suppress Matched Condition Advanced Options...

= Suppress Unmatched Condition

@ + Message on Matched Condition
Set Attributes
Severity Application Message Group Object
critical
Message Text
I-86 Admin 5

Service Name

Message Type
Instructions... |Message Correlation...
Actions
On Server Log Only (put directly into History Log)
Node Command

Automatic
Operator initiated

Forward to Trouble Ticket

Notification

0K Cancel Test Pattern Matc

The following attributes can be modified:

50

Threshold. Enter a value for the metric data that when exceeded would signify a
problem either about to occur or already occurring.

Duration. The length of time that the incoming data values for a metric can exceed
the established threshold before an alarm is generated.

Severity. Click the Severity button and select the desired severity setting.

Message Text. Be careful not to modify any of the parameters—surrounded by <>
brackets, beginning with $—in a message.

Actions. This field provides the ability to generate metric reports, or to add custom
programs. In the WBS-SPI, automatic actions are configured to generate metric
reports showing data values at the time an exceeded threshold occurred. You can view
a generated WBSSPI report by opening the message’s Annotations.
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The following illustration of the Condition window shows a threshold setting of 95 for
WBSSPI-0005.2. This metric monitors the total number of times per minute clients must
wait for an available EJB (enterprise java bean). A value of more than 95 would start to
impact the server response time the client experiences, generating an alarm (a warning

message).
Description
WBSS5PI-000%,2: Major threshol
Condition
Ohject Pattern
Threshold
6 Click OK.
7 Re-distribute the modified template (described in Task 6: Distribute WBS-SPI Templates
on page 44).

Modifying Alarm Generation
An alarm can be generated once or multiple times, depending on its Message Generation
setting in the Modify Threshold Monitor window.
To change the change the Message Generation, do the following:
1 Open the Message Source Templates window.
Open the SPI for WebSphere template group.
Open the desired impact template group and then the WBSSPI-Monitors template group.
Select the template to modify.
Click Modify.

g A W N
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The Modify Threshold Monitor window displays.
E

Monitor Name Description

UM Hempey Uiilizativd

Monitor

External =

Threshold Type Message Generation

Maximum Minimum with Reset without Reset Continuous

Message Defaults

Severity Application Message Group Object

Service Name

Cancel

6 Modify the Message Generation:

e with Reset. Alarms are generated once when the threshold value is exceeded. At the
same time a reset threshold value is activated. Only when the reset threshold value is
exceeded, does the original threshold value become active again. Then when the
threshold value is again exceeded, another alarm is generated and the process starts
all over again.

e Without Reset. Alarms are generated once when the monitoring threshold value is
exceeded. Alarms reset automatically when metric values are no longer in violation of
the thresholds and are generated again when the threshold is exceeded.

e Continuously. Messages are sent/alerts generated each time the metric values are
collected and the threshold is exceeded.

7  Click OK.
8 Re-distribute the modified template (described in Task 6: Distribute WBS-SPI Templates
on page 44).

Advanced Template Customizations

The template changes suggested here range from making copies of default template groups in
order to customize a few settings, to deleting whole groups of metrics within a template’s
command line. This section is considered advanced because all changes described here,
whether simple or complex, require some advanced knowledge of the WBS-SPI metrics.
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Choosing Metrics To Customize
Determine which metrics you want to customize and what templates within the group you
want to use. Then, do the following:
1 Open the Message Source Templates window.

Highlight the group you want to use and select the Copy... button.

Rename and save the group.

Within the renamed template group, copy each original template and rename it.

Delete the originals from the new group.

o A WN

Customize the renamed templates within the group, as necessary.

Creating a new template group allows you to keep custom templates separate from the
original default templates, which you copy and place within the new group.

Templates Edit Yiew Window

Template Groups :

[Toplevell] A Monitor
BEASPI1E Monitor
SPI for WebSphere Monitor
Monitor

Monitor

Monitor

Monitor

Monitor

Monitor

Monitor

Monitor

Monitor

Using the WBS-SPI Collector/Analyzer Command

The wasspi_wbs_ca command is used in every collector template, named according to its
collection interval. You can view the default command line parameters within each collector
template in the Monitor Program or MIB ID text box in OVO.
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The WBS-SPI Collector/Analyzer Command Parameters

WBS-SPI data collections are started with the wasspi_wbs_ca command, to which you can add
other parameters, as identified in the following table.

Parameter Description Syntax

-C Required. Specifies the collector template | -¢c <collector template name>

(collector) name and must match the collector Example: -c WBSSPI-40-Low-05min
template name in which it appears.

-m Specifies the metric numbers or number -m <metric_number>

(metric) ranges on which to collect data. Example: -m 1,3-5,9-11,15

-matchver Specifies the specific WebSphere -matchver <version_number>

(match version)

application server version to monitor. This
option may not be used with the -minver nor
-maxver options. If no matching versions
are found, the command does not execute.

Example: -matchver 4

-maxver
(maximum version)

Specifies the highest WebSphere
application server version to monitor. Use
with -minver to specify a range of versions.
If no versions are found, the command does
not execute.

-maxver <version number>

Example: -maxver 5

-minver
(minimum version)

Specifies the lowest WebSphere application
server version to monitor. Use with -maxver
to specify a range of versions. If no versions
are found, the command does not execute.

-minver <version number>

Example: -minver 4

-r Generate an ASCII report for the specified |-r
(report) metric(s)
-t Create a new template group by adding a | -¢c <prefix>-<collector _template>
(tag) prefix to an existing collector template -m <metric_number> -t <prefix>-
along with the metric number(s). Example: -¢ DEV-WBSSPI-40-Low-05min
-m 220-223 -t DEV-
-1 List specific servers to monitor. May not be | -i <server_name>
(include) used with the -e option. Example: -i serverl,serverd
-e Exclude specific servers from being -e <server._name>
(exclude) mopitored. May not be used with the -i Example: -e server2,serverd
option.
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Parameter Description Syntax
-X Specify a property/value: -X <property>=<property value>
alarm: when off, overrides any default -x alarm=off

alarming defined for the metric.

prefix: Default: JMXUDM_. Specify the -x prefix=SALES_
prefix of the metric ID.

print: when on, prints the metric name, -X print=on
instance name, and metric value to
STDOUT in addition to any configured
alarming or logging.

log: when off, prevents graphing or -x log=off
reporting functions.

Examples

To specify metrics to collect:

To collect specific data on all configured servers:

wasspi_wbs_ca -c WBSSPI-40-Low-05min -m 10-14, 25,26

To collect data from specific servers only:

wasspi_wbs_ca -c¢ STAGE-WBSSPI-40-Low-05min -m 245,246,260 -i serverl, server2
To not collect data from specific servers:

wasspi_wbs_ca -c STAGE-WBSSPI-40-Low-05min -m 220-225 -e serverl, server2

Changing the Collection Interval for Scheduled Metrics

To change the metric collection interval, simply change the Polling Interval in the appropriate
collector template. For example, to change the collection of default metrics from 5 minutes to
10 minutes for the WebSphere High Impact template group, follow these steps:

1
2

N o0 0 AW

Open the Message Source Templates window.

Select the template group SPI for WebSphere and open WebSphere-Templates-High-Impact -
WBSSPI-Monitors-High.

Select the collector template WBSSPI-40-High-05min.
Click Modify... .

Change the Monitor Name to WBSSPI-40-High-10min.
Change the Polling Interval from 5m to 10m.

Modify the command line -c parameter to reflect the new template name
(WBSSPI-40-High-10min) as follows:
wasspi_wbs_ca -c WBSSPI-40-High-10min....

Distribute the new templates (described in Task 6: Distribute WBS-SPI Templates on
page 44).
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Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector template
and rename with a name reflecting the new interval, deleting all but the metrics you are
changing. Set the new interval. Edit the original template to remove the changing metrics.
For example, to change the collection interval to 10 minutes for metrics 221-225, you would
follow these steps:

1 Open the Message Source Templates window.

2  Select the template group SPI for WebSphere and open
WebSphere-Templates-High-Impact - WBSSPI-Monitors-High.

Select the collector template WBSSPI-40-High-05min.
Click the Copy... button and change the monitor name to WBSSPI-40-High-10min.
Change the entry following -c to WBSSPI-40-High-10min.

o 0 AW

In the Monitor Program or MIB ID text box, delete all metrics after the -m except 221-225.

Description

: Server 4.0 SPI collector/

Polling Interwval

ST

7 Change the Polling Interval to 10m.
Click OK.
9 Select the WBSSPI-40-High-05min template.
10 Delete 221-225 from the Monitor Program or MIB ID text box.

11 Re-distribute the modified templates as described in Task 6: Distribute WBS-SPI
Templates on page 44.

Customize the Threshold for Different Servers

Customize the threshold as needed. For example, you may want to set the threshold to 20 for
SERVER_1 for metric 0212 and leave the threshold at 10 for all other servers. To do so, copy
the existing condition and modify it to serve as the exception. Follow these steps:

1 Double-click on the metric to open the metric for customization (for example, double-click
on WBSSPI-0212).

The Message and Suppress Conditions window is displayed.

2  Select the desired condition and press Copy... to make a copy of the condition.
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3 Name the condition WBSSPI-0212.2.

4 In the Object Pattern field, enter the desired characters to use for pattern matching (in
this example SERVER_1). For example, to match on all servers with a specific character
string in the name, enter the string in the Object Pattern field. (see the OVO online Help
or the OVO Administrators Task Guide for pattern matching syntax).

5 Click Test Pattern Matching... to test the pattern and verify pattern matching (you must set
up a match file first).

6 Change the value in the Threshold field from 10 to 20.

Creating Custom, Tagged Templates

Another advanced customization option is to use the tag option (-t on the command line),
which allows the collector/analyzer to recognize customized templates that have a tag
attached to the name. This option provides you with the flexibility of using more than a single
set of templates to define conditions pertaining to specific installations of a WebSphere
server. It also preserves templates from being overwritten when an upgraded version of the
WBS-SPI is installed.

When multiple nodes are managed by a number of groups, this option allows you to create
specially tagged templates that are obviously separate from your original setup. In such a
case, you would make copies of the templates, rename them with the tag, re-work the collector
template to pick up the tagged names, then assign them to the various groups.

For example, you might create a group of templates and change each template name to
include CLIENTO1 in it. A metric monitor template might be named
CLIENTO01-WBSSPI_0212 (retaining the metric number, which must be used). The collector
template name would be named FIRST_CLIENT-40-05min. You could then set up another
group for SECOND_CLIENT and change all those templates to include the CLIENTO0Z2 in the
name.

To create the new template group:

1 Copy the original template group. In the Message Source Templates window select the
group and click Copy....

2 Name the new group according to how you plan to identify the new monitor and collector
templates; for example, if you are including CLIENTO1 in the template names, include
that within the new template group name.

3 In the Message Source Template window expand the new template group to show all
templates and select each template you plan to use, click Copy..., and rename it according
to your naming scheme.

¢ The names you give the new metric monitor templates in the group would contain the
new name followed by the original metric number. For example, a copy of
WBSSPI-0001 could be called CLIENT01-WBSSPI_0001.

¢ The name you give the new collector monitor template would also contain the
identifying name. You would also modify the scheduled collection for the new group by
inserting the -t property on the command line. For example:

wasspi_wbs_ca -c¢ FIRST CLIENT-40-15min -m 16 -t CLIENTO1l-

In this case the copied collector template has been renamed:
CLIENTO01-WBSSPI40-15min

4 Delete all original templates from the new group.

Using and Customizing WBS-SPI 57



58

Template Variables

The following variables are used by the WBS-SPI templates. If you are creating your own
templates, you may use these variables.

Name Description

instancename The instance for which the metric is being reported for multi-instance
metrics.

map_port See port. This variable may be deprecated in future releases.

map_servername

The application server name with spaces replaced with underscores (“_”).
Used for service map keys where spaces are prohibited.

Example: my_server

node The node on which the application server is running.
Example: mool.hp.com

port The port on which the application server is listening. Corresponds to the
PORT configuration property.
Example: 9001

servername The application server name. Corresponds to the NAME configuration

property.

Example: my server

Monitoring a WebSphere Server on Unsupported Platforms

The WBS-SPI supports monitoring WebSphere server systems running on HP-UX, Solaris,
Linux (Red Hat), AIX, and Windows 2000. However, it is possible to configure the WBS-SPI to
monitor WebSphere server systems running on unsupported platforms—systems we refer to
as “remote systems.”

The intent of this section is to help you determine if your environment is conducive to setting
up remote monitoring. If you determine that your environment meets the criteria described
below, you have some expertise in using the WBS-SPI, and you have expertise in using the
WebSphere server, this section offers an example to get you started.

Requirements for Monitoring Remote Nodes

For a WebSphere server system running on an unsupported platform, you can use WBS-SPI
to monitor that remote system if the following conditions apply (the last condition is optional):

¢ The remote system is covered by a purchased license (using Tier 1 pricing).

e The WBS-SPI runs on at least one managed node on a supported platform: HP-UX,
Solaris, Linux (Red Hat), AIX, or Windows 2000.

e The local/proxy system and remote system must be running the same version of
WebSphere server. For example if the proxy system is running WebSphere server version
5, the remote system must also be running WebSphere server version 5.

e The remote system runs on a platform supported by the OVO agent software (optional, for
logfile monitoring).
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Overview

The following section provides an overview of remote monitoring and shows how it is
implemented. Also included are details on how to set up the WBS-SPI to access WebSphere
server metrics and logfiles on unsupported platforms by using both the WBS-SPI and OVO
agent software.

Remote Monitoring: How It Works

In a standard configuration, WBS-SPI programs/templates are deployed on the local,
managed node. In a non-standard configuration, the local system is used as a proxy through
which remote metric information becomes accessible.

Remote system data collection/interpretation relies on the local, managed node to act as the
proxy on which data collection is configured.
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Configuration entries requirement: Within the configuration, entries for both local and
remote systems are included. You can include multiple remote system entries in a local
system’s section. Please refer to the example on Task 1: Configure the Remote WebSphere
Server System on page 60, showing how the remote entry appears (with system IP address).

Template deployment requirement: Templates for the correct WebSphere PMI level should be
deployed on the local node. If you need a separate template group (for example High Impact or
Medium Impact) to cover a different level, you can copy and rename the existing templates
and specify the WebSphere Server name on the command line using the -i or -e options. Refer
to a previous section in this chapter Using the WBS-SPI Collector/Analyzer Command on
page 53 for details on using these command line parameters.
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OVO agent deployment requirement (optional logfile monitoring): To access remote
WebSphere server logfiles, the OVO agent software must be installed on the remote system.
Using standard OVO processes, you can modify the standard logfile templates included with
the WBS-SPI to specify the correct logfile names, then deploy them to the remote system.

) Monitoring remote systems using logfile versioning is not supported.

Configuring Remote System Monitoring

You can monitor a WebSphere server on remote systems (running on platforms other than
HP-UX, Solaris, Linux, AIX, or Windows 2000) by completing the following tasks.

Task 1: Configure the Remote WebSphere Server System

Using the Config WBSSPI application in the OVO WBSSPI Application Bank, you configure
each local managed node that communicates with a remote WebSphere server. In the
configuration you include additional entries for remote WebSphere servers.

1

Choose a WebSphere server managed node from which to monitor the remote WebSphere
server.

At the OVO console, start the Config WBSSPI application. In the Application Bank window
select WBSSPI - WBSSPI Admin = Config WBSSPI.

In the configuration that appears, include an entry for each remote WebSphere server
system: SERVER<n>_ ADDRESS=<DNS server name or IP address>

Be sure that NUM_SERVERS is set to the correct number of servers (<n>) and that HOME and
JAVA_HOME are set at the global level.

The illustration below shows how local and remote WebSphere servers are configured in
the same file. Notice, however, that for the remote servers, the

SERVER<n>_ ADDRESS=<IP_address> (SERVER2_ADDRESS=15.75.27.109 or
SERVER2_ADDRESS=harley.rose.hp.com) line is added:

HOME=/opt /WebServer/AppServer
JAVA_HOME=/opt/WebServer/AppServer/java
NODE local_node {

NUM_SERVERS=2

SERVER1_NAME=lara

SERVER1_PORT=900

SERVER2_NAME=harley

SERVER2_PORT=905
SERVER2_ADDRESS=harley.rose.hp.com

}

There are two WebSphere servers configured in the preceding configuration. SERVER1 is
the local server, running on an HP-UX managed node. SERVER2 is running on an
OVO-managed node, that is a non-Red Hat Linux system (a platform unsupported by
WBS-SPI). The remote system is configured similar to that of the local system but
contains the new line SERVER2_ADDRESS=harley.rose.hp.com.

To verify that the SPI is monitoring the remote node, run the following command:

wasspi_wbs_perl -S wasspi_wbs_ca -m 5 -i <remote_server NAME|ALIAS>
-x print=on

You must use ALTIAS if it is set for the remote server.
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Task 2: Integrate the OpenView Performance Agent (Optional)

Since the OpenView Performance Agent (also known as the MeasureWare Agent) collection
occurs on the managed node (not the remote system), if you use PerfView and would like to
graph the remote system data, you must ensure that MeasureWare integration is enabled on
the (local) managed node.

Task 3: Assign Local Node to a WBS-SPI node group

Assign the local managed node to the appropriate node group. For example, you would assign
the local node to the WBS High node group if the local and remote managed nodes are to
collect metrics that require the system be set at a high WebSphere PMI level.

Configuring Remote Logfile Monitoring (Optional)

Monitoring remote system logfiles is supported if the following is true:
e The remote system that has an OVO agent running on it and
e The system does not re-version logfiles when they roll.

To set up logfile monitoring, at the OVO console you copy the WBS-SPI logfile template and
then configure, assign, and deploy the copied logfile template to the remote system.

Configure the Logfile Template for Remote Logfiles

1 Open a copy of the WebSphere Log Template located under WBSSPI-Logfiles in the SPI
for WebSphere group. For example, SPI for WebSphere > WBSSPI-Lodfiles.

2 In the Logfile text box, enter the location of the logfile on the remote system: /<path>/
<file name>.

3 Assign and deploy the logfile template to the remote OVO-managed node.
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The log file template and the OVO agent, both present on the remote system, make
WebSphere server logfile monitoring possible.
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Remote Monitoring Limitations

e The WBS-SPI and the OVO agent do not support access to logfiles that are re-versioned
each time the logs are rolled.

e  When no OVO agent is present on the remote system, monitoring of WebSphere server
logfiles on the remote system cannot occur.

¢ In the OpenView Operations Application Bank, WBS-SPI applications cannot be executed
on remote systems.

¢ The proxy system and remote system must be running the same version of the WebSphere
server.
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Re-installing the WBS-SPI Templates

When WBS-SPI templates are installed in OVO, the commands shown below automatically
uploads them when swinstall is run. Any customized template settings you may have done for
the previous installation are overwritten.

To restore the default SPI for WebSphere template group(s) you originally installed:
1 Delete all current templates.

— Run the command:
/opt/0OV/bin/OpC/opccfgupld -silent -replace \
-subentity var/opt/OV/share/tmp/OpC_appl/wasspi/wbs_set

Alternatively, you can use the -verbose option instead of the -silent option.

Using Templates/Applications to View Annotation Reports

Some templates have actions defined with threshold violations or error conditions that
automatically cause reports to appear in the message Annotations. These reports are
snapshots of data values collected form the server around the time that the alarm occurred.

’ The reports discussed in this section should not be confused with those generated by
OpenView Reporter, which show more consolidated, historical data generated as Web pages
in management-ready presentation format.

You can access the data as follows:

e To view the Message Details. Double-click a message in the OVO message browser, or just
select the message and click Annotations. Reports are available there, showing data
values on a single server.

e To view reports. Open both the Node Bank and Application Bank windows. Continue to
open application windows WBSSPI - WBSSPI Admin — Reports. Select a node and drag
it onto the WBS-SPI metric report you need. These reports show all server data on a node.

Automatic Action Reports
Many metrics generate Automatic Action Reports. These reports show data on a single

WebSphere server instance with an exceeded threshold. They are generated as soon as the
alarm is triggered in OVO.
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How you know a report has been generated

When an Automatic Action Report is executed from OVO, the server is queried for additional
data. If your message browser is set to display the SUTAONE column, you will see an “S”
under the “A” column (see illustration), which indicates that a successfully generated report is
available in the Annotations area of the Message Details.
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How to view An Auto-Action report

To view an automatically generated metric report relating to an alarm condition, click
Annotations... in the Message Browser. Column descriptions provide further clarification.

Application Bank Reports

Application Bank reports run for all WebSphere server instances configured on the managed
node. The reports generated from the Application Bank reflect the current state of a
WebSphere server on the managed node. You manually generate these reports in OVO by
dragging the managed node from the Node Bank window to a specific metric report among
those shown in the Application Bank window.

WBS-SPI reports require that the targeted managed node have a PMI level setting at or
above the rating (as shown in the table below) for the metric you are selecting.

Table 2 Performance Impact Ratings (PMI Levels) of Reporting Metrics
Low 5,42,222,224, 247, 265

Medium 40, 221, 246, 262,
High 41, 212, 213, 220, 261, 263, 264,
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When manually generated, a report from the Application Bank > WBSSPI Reports window
shows that metric data for ALL WebSphere server instances on the managed node.

Application Group: WBSSPI Beports

Map Actions Edit View Window

D

Output of Application MNo. 1

Virtual Machinae Profila

_Close | _stop | Save.. | fety. |
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Checking WBS-SPI Nodes for License Count

You can use an OVO reporting utility to check the number of templates you have installed on
your managed nodes. In reviewing the number of templates per managed node, you can see if
you have consistently installed templates across your managed systems. In addition, by

running this report, you can also ensure that the number of licenses you have purchased is in
compliance with the report results.

To run the report:

1 At the OVO console select the node or node group that you want to check.

2  From the Actions menu select Utilities = Reports....

3 In the Reports window among the reports listed select WBSSPI License Check.
4

Select an output destination and click OK.
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5 Using HP OpenView Reporting and Graphing
Products with WBS-SPI

The Smart Plug-in for WebSphere Application Server (WBS-SPI) can be integrated with the
following HP OpenView reporting and graphing products (these products must be purchased
separately):

e HP OpenView Reporter (Reporter)

e HP OpenView Performance Agent (OVPA)

e HP OpenView Performance Insight (OVPI)

e HP OpenView Performance Manager (OVPM)

HP OpenView Reporter. Reporter produces management-ready, web page reports, showing
historical and trending information. This is not the version of Reporter that is included with
HP OpenView Operations.

Working in conjunction with Reporter, the WBS-SPI produces a variety of reports showing
consolidated information on the WebSphere Application Server.

Refer to Integrating with HP OpenView Reporter on page 69 for more information on how to
integrate WBS-SPI with Reporter. After integrating WBS-SPI with Reporter, every night,
Reporter generates reports that show the performance and availability of a WebSphere
Application Server on configured managed nodes.

HP OpenView Performance Agent. OVPA collects, summarizes, time stamps, and detects
alarm conditions on current and historical resource data across your system. It provides
performance, resource, and end-to-end transaction response time measurements, and
supports network and database measurement information. Refer to the HP OpenView
Performance Agent for UNIX User’s Manual for more information about OVPA.

If you are using OVPA, WBS-SPI automatically uses it. If you want to use the HP OpenView
Operations subagent (CODA) that is included with HP OpenView Operations (does not
support OVPA), you must configure your managed nodes to do so. Refer to Using CODA on
page 68 for more information.

HP OpenView Performance Insight. OVPI is a network management system that collects,
processes, and reports data. The data is used to generate reports. Refer to the HP OpenView
Performance Insight Administration Guide for more information about OVPI. Refer to the
Application Server Report Pack User Guide for more information about WBS-SPI reports and
how to integrate WBS-SPI with OVPI.

HP OpenView Performance Manager. OVPM provides graphing capability of WBS-SPI
metrics. This is not the version of OVPM that is included with HP OpenView Operations.

Refer to Integrating with HP OpenView Performance Manager on page 73 for more
information on how to integrate WBS-SPI with OVPM. After integrating WBS-SPI with
OVPM, graphs are available the following day.
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Using CODA

The WBS-SPI can detect if you are using OpenView Performance Agent (OVPA or
MeasureWare Agent). If you are, the WBS-SPI installation automatically uses it.

If you want to use the HP OpenView Operations subagent (CODA) included with OVO 7 x,
you must configure the managed nodes to do so. Note that this configuration does not support

OVPA.

To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1 On the managed node, create a nocoda. opt file in the following directory:

Operating System

File Location

HP-UX, Linux, Solaris

/var/opt/0OV/conf/dsi2ddf/

AIX

/var/lpp/0OV/conf/dsi2ddf/

Windows

\usr\ov\conf\dsi2ddf\

If the directory dsi2ddf does not exist, create it.

2 Save the empty file.
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Integrating with HP OpenView Reporter

WBS-SPI must be installed and configured before it can be integrated with Reporter.

If you are upgrading the WBS-SPI report package, you must remove the old version before
installing the new version. Refer to Task 14: Install the New Report Package (Optional) on
page 30 for information on how to remove the WBS-SPI report package.

The WBS-SPI report package must be installed on the Windows system running Reporter:

1 On the Windows client system, insert the Smart Plug-ins CD-ROM (that contains the
reporting packages) into the CD-ROM drive, and in Windows Explorer, double-click:

\OV_REPORTER\WEBSPHERE_SPI_A.04.00\WBSSPI-Reporter.msi
2 Follow the instructions as they appear.
3 Check the Reporter status pane to note changes to the Reporter configuration.

) For Windows 2000 managed nodes, during the installation, an error message may appear
that indicates the installer has detected an older version of the installer on your system.
You can safely ignore the message and continue.

The Reporter main window displays IBM WebSphere Availability and Performance
reports.
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You can find instructions in the Reporter Help for assigning WBS-SPI reports to the
targeted nodes. To access Help, select Reports or Discovered Systems in the left panel of
the Reporter main window and right-click it. Select Report Help or Discovered Systems
Help from the submenu that appears. See the topic “To assign a report definition to a
Discovered Systems Group.”

4 Add group and single system reports by assigning reports as desired. (See the Reporter
Help and the online Concepts Guide for complete information.)

>»

WBS-SPI Reporter Reports

Group and single system WBS-SPI reports require that you identify systems by their full
name. For example, abc.xyz.com is acceptable while abc is not.

The reports available through the integration of HP OpenView Reporter and WBS-SPI show
consolidated data on server performance and availability on all WebSphere server systems. In
addition, other reports show data for single systems. These reports are available the day
following your installation of the WBS-SPI report package on the Reporter Windows system.
(Please refer to Integrating with HP OpenView Reporter on page 69 if you have not yet
completed the report package installation.)

The two tables that follow show all pre-defined reports.

Table 3  All/Group Reports

Report Title Description Metric
Availability Shows the percent uptime for all WebSphere servers by day. 2
Top 20 Servers— Transaction | Shows the average throughput for the top 20 execute queues of | 77
Throughput all servers.

Top 20 Servers—JDBC Shows the average throughput for all connections pools on the 66
Connection Pool Throughput server for the top 20 servers.

Top 20 Servers—Servlet Shows the total servlet request rate for the top 20 servers. 45
Request Rate

Top 20 Servers— Servlet Shows the total servlet sessions being handled by the top 20 41
Sessions servers.

Top 20 Servers— Servlet Shows the average response time for the top 20 requested 245
Average Response Time servlets for all servers for the reporting period.

Top 20 Servers— EJB Method | Shows the number of all EJB method calls per minute for the top | 22
Calls Rate 20 servers.

Top 20 Servers— Entity EJB Shows the number of all Entity EJB loads and stores to/from the | 24

Load/Stores Rate

database per minute for the top 20 servers.
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Table 4 Single System Reports

Report Title Description Metric
Server Availability Details Contains spectrum graphs showing minutes of uptime by day and | 2
hour for each WebSphere server.
Admin Server Availability Shows the uptime percent for each WebSphere Admin server by |4
Details day.
EJB Average Response Time Shows the average response time for the top 20 EJBs for a server| 221
for the reporting period.
EJB Method Calls Rate Shows the number of all EJB method calls per minute for the top | 22
20 EJBs for a server.
Entity EJB Load/Stores Rate Shows the number of all EJB loads and stores to/from the 224
database per minute for the top 20 EJBs on a server.
EJB Pool Utilization Shows the EJB pool utilization as a percent for the top 20 EJBs | 220
on a server.
EJB Pool Misses Percent Shows the percent of time that a call to retrieve an EJB from the | 225
pool was not successful during the collection interval for the top
20 EJBs.
EJB Pool Size Shows the average pool size for the top 20 EJBs for one server for | 223
each day.
JDBC Connection Pools Charts the throughput against the utilization for the JDBC 263
Throughput vs. Utilization connection pools on the selected server, one chart for each
connection pool.
JDBC Connection Pools - Charts the connection pool size against the average wait time for | 260
Size vs. Wait Time a connection for the JDBC connection pools on the selected
server, one chart for each connection pool.
JDBC Connection Pools - Charts the number of clients waiting for a database connection | 265
Clients Waiting vs. TimeoutRate| from the pool against the timeout rate for waiting clients for the
DB connection pools on the selected server, one chart for each
connection pool.
JCA Connections Utilization - Shows the JCA resource connection pool utilization as a percent. | 250
Top 20 Resources
Transaction Throughput Shows the average transaction throughput for the selected server| 77
by day.
Thread Pool Activity Charts the average size of the thread pool against the average 211
number of active threads for all thread pools on the selected
server, one chart for each thread pool.
Servlet Request Rate Shows the request rate (per second) for the top 20 servlets for one | 245
server for each day.
Servlet Average Response Time -| Show the average response time for the top 20 requested servlets | 246
Top 20 Servlets for one server for the reporting period.
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WABS-SPI OVPI Reports

The reports available through the integration of HP OpenView Performance Insight and
WBS-SPI show consolidated data on server performance and availability on WebSphere
application server systems. Refer to the Application Server Report Pack User Guide for more
information about WBS-SPI reports and how to integrate WBS-SPI with OVPI.

The table that follow shows all pre-defined reports.

Report Title Description Metric
Server Availability— The server availability chart plots the availability status |2, 77
Throughput of the application server on an hourly, daily, and monthly
basis. The transaction throughput chart displays the
number of transactions processed by the application
server per second.
EJB Pool Utilization The percentage of EJB pool utilization. 20
JDBC Throughput— The percentage of available JDBC connection in the 66, 263
Utilization connection pool and the number of clients serviced by the
connection pool per second.
Near Real Time Server | The server status for the last six hours. 2,77
Availability
Servlet Request Rate— | The servlet request rate measures the number of requests | 45, 246
Response Time for a servlet per second. The servlet response time chart
shows the average execution time for an individual
servlet.
EJB Load-Stores Rate | The number of all entity EJB loads and stores to and from | 24
the database per minute for the top 20 servers. For the
selected server, it lists the top 20 EJBs.
EJB Method Calls Rate | The number of all EJB method calls per minute for the top| 22
20 servers.
EJB Top 20 The percentage of EJB retrievals that were not successful | 25,
during the collection interval, the average pool size, and | 221,
the average response time in milliseconds for the top 20 | 223
EJBs.
JDBC Connection Pool | The average number of connections allocated per day for |61, 65,
Details the top 20 servers. The DB pool is shown along with 260,
clients waiting, client timeout rate, average pool size, and | 266
average wait time.
Servlet Sessions The total number of servlet sessions being handled by the | 41
top 20 servers.
Thread Pool Activity Comparison of the average size of thread pools with the | 210,
average number of active threads on the selected server. | 211
Transaction Throughput | The average number of transactions processed per second | 77

by the top 20 servers for the previous day.
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Integrating with HP OpenView Performance Manager

To integrate WBS-SPI with OVPM, do the following:

1 Install and configure the WBS-SPI. Verify that you have completed Task 1: Configure the
Management Server to Launch your Web Browser on page 33. Also, verify that you have
set the GRAPH_URL property. Refer to Property Definitions on page 143 for more
information about the GRAPH_URL property.

2 Ifyou are upgrading the WBS-SPI graph package, you must remove the old version before
installing the new version. Refer to Task 15: Install the New Graph Package (Optional) on
page 31 for information on how to remove the WBS-SPI graph package.

3 Install the graph package.
On a Windows system running OVPM, do the following:

a Insert the Smart Plug-ins CD-ROM (that contains the reporting packages) into the
CD-ROM drive, and in Windows Explorer, double-click:

\OV_PM\WEBSPHERE_SPI A.04.00\WINDOWS\HPOvSpiWbsGc-4.00.000.msi
b  Follow the instructions as they appear.

On an HP-UX system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are already
swinstalled when you install the SPI software):

a Mount the Smart Plug-ins CD-ROM (that contains the reporting packages) and type:

swinstall -s <mount_point>/OV_PM/WEBSPHERE_ SPI A.04.00/HPUX/
HPOvSpiWbsGc-4.00.000.sdtape WBSSPI-GRAPHS

On a Solaris system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are already
installed when you install the SPI software):

a Mount the Smart Plug-ins CD-ROM (that contains the reporting packages) and type:

/usr/sbin/pkgadd -d <mount_point>/OV_PM/WEBSPHERE SPI_A.04.00/SOLARIS/
HPOvSpiWbsGc-4.00.000.sparc all

4  To graph any WebSphere server metric, use the data source name WBSSPI_RPT_METRICS

Refer to the OVPM documentation for information on how to view the graphs. Graphs are
available the day following integration.

Data Source Description

Metrics collected by the WBS-SPI are stored in the WBSSPI_RPT_METRICS data source and
can be graphed. The values can be viewed for trend analysis.

Class WBSSPI_RPT_METRICS

Column Attribute

1 INTERVAL
2 METRICID
3 “17

4 VALUE
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Column Attribute

5 VALUEID

6 SERVERNAME

7 PREFIX and OBJECTNAME
8 SORTID

WABS-SPI Metrics Available for

The table that follow show the

Graphs

graphs available for mapping collected metric values. Use

OVPM to view any one of the metrics included in any of these tables.

Table 5 JVM

Metric Number/Name

Metric Description

1005_JVMMemUtilPct

Percentage of heap space used in the JVM.

Table 6 Server Performance

Metric Number/Name

Metric Description

1013_ ThrdPoolPctMax

Percentage of time Number of threads in pool reached
configured maximum size.

1014_ThrdPoolCrtRt

Number of threads created per minute.

Table 7 Enterprise Java

Beans (EJB)

Metric Number/Name

Metric Description

1020_EJBPoolUtil

Percentage of active beans in the pool.

1022_EJBMethCallsRt

Number of EJB method calls per minute.

1024_EJBEntDatLdStRt

Number of times an EJB was written to or loaded from the
database per minute.

1025_EJBPoolMissPct

Average Percentage of time a call to retrieve an EJB from the
pool failed.

1026_EJBConcLives

Average Number of bean objects in the pool.

Table 8 Servlets

Metric Number/Name

Metric Description

1040_ServSessAvelLife

Average lifetime of a servlet session in milliseconds.

1041_ServSessActSess

Number of sessions currently being accessed.

1042_ServInvSessRt

Number of sessions being invalidated per second.
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Table 9

Web Applications

Metric Number/Name

Metric Description

1045_WebAppServReqRt

Number of requests for a servlet per second.

1047_WebAppServErrRt

Number of errors in a servlet per second.

1048_WebAppServLoad

Number of servlets currently loaded for a web application.

1049_WebAppServRelRt

Number of servlets reloaded for a web application per
minute.

Table 10 JDBC

Metric Number/Name

Metric Description

1061_JDBCConPoolWait

Average number of threads waiting for a connection from
connection pools

1062_JDBConPoolWtTim

Average time that a client waited for a connection in
milliseconds.

1065_JDBConPoolTimRt

Number of times a client timed out waiting for a connection
from the pool per minute.

1066_JDBCConPoolThru

Number of connections allocated and returned by
applications per second.

Table 11 Transactions

Metric Number/Name

Metric Description

1070_TranGlobDur

Average duration of global transactions.

1071_TranLocDur

Average duration of local transactions.

1072_TranGlobCommDur

Average duration of commits for global transactions.

1073_TranLocCommDur

Average duration of commits for local transactions.

1074_TranRollbackRt

Number per second of global and local transactions rolled
back.

1075_TranTimeoutRt

Number per second of timed out global and local
transactions.

1076_TranCommitRt

Number per second of global and local transactions that were
committed.

1078_TranStartRtt

Number per second of global and local transactions that were
begun.
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Example Integration

The following is an example of how to graph multi-instance data stored in a data source by
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all
data for all instances are reported in one graph. The data for each SERVERNAME can also be
displayed in a separate graph.

This example also uses the Java interface option of OVPM.

1 Start the Java Interface option of OVPM. The Performance Manager Java Interface
window displays.

| Display | Design | :
O) New g3 open... B Save [ Save As.. X Delete.. [& Preview B Hep [
General

Dalasource; i Metrics |

Default Selection: Moot Sources

Mote: The default selection 15 onky wsed during araph design to preview the graph and retriesa metric m
information. dnce you finish design and save the graph, you can then make mulliple selections to 2L

draw the graph. _ T-Filter_|

[~ Complex Graph Design using multiple sources

2 From the Performance Manager Java Interface window,

a Click the Display tab at the top of the window, and then the Sources tab at the right
of the window.

b Click - | next to the Datasource text box and select a data source
(WBSSPI_RPT_METRICS).

¢ Click - | nexttothe Default Selection text box and select the node on which the data
source resides.
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3 Click the General tab at the right of the window.

Display | Design |

] General
Sublifie; I Metrics

Type: IIahIE - Sources

Deszcription: _......J
Highlight
rDate Range Foints Every: T-Filter
Duration: |3 [days | |5 minutes -
Ending: ©  Mow = Last Limit Mumber of Points to:

" Date: Time: E
25 2004_gffo: o}
Shift
[ Cwerride Shift Defaults
Start [00: 00 /= Stop : 594 I~ Skip Hol
Days ¥ Sun P won [ Tue Fiwed FThu W Fri [ Sat

Metric Display Order:
 Ayerage data value

* Label {alphabetical)

T i lmey MaEe s fams blslslas bs ey

4 From this window,
a Select 1ine from the Type drop-down list. This generates a line graph.
b Enter a Date Range.
c¢ Enter an interval using the Points Every drop-down list.

d Click Label (alphabetical) if you want the graph key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection
window displays.

Metric Selection <

- [3# cPU =]
- [ NETIF
=B Fs
- [ DISK
- [ WBSSPI_METRICEWBSSPI_METRICS
=8 Iﬁwassm RPT_METRICSWESSPI_RPT_METRICS
w7 [§ INTERWAL
-~ [§ mETRICID
l‘ § OBJECTNAME
~I7 [ SERVERMAME
=" [§ soRTID
7 B waLuE 1
“7 [§ vALUEID

Label: |
Type: Iline 'I
' A |Ieft 'I

Calor: |:|Auta Ll
~Line Style

Style: ISDIid 'I Marker: Inane 'I Width: |1—
~Fill Style

sie: [solid <]

Mizsing Data: Ihidden vI
Filter: | |
(6] 34 I Cancel | Help |

6 From the Metric Selection window,
Next to the WBSSPI_RPT_METRICS data source, click + to expand it in the tree.
b  Select the check box next to VALUE.

a

C

Click OK.
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7 Inthe window with the Metrics tab selected, VALUE is displayed. Select the line on which
VALUE is displayed and click Properties. The Metric Properties window displays.

Metric Properties - WESSPI_RPT_METRICS:WBSSPI_RPT_METRICS:V...
Label |[(@@SERVERNAME @@0BJECTHAME
Type: [lable =|
¥ s [left =]
Color. I:l."«ml:l j

Line Siyle

Style: | | Marker | =] wadt: |

Fill Stde

side: Jsolid ]
Mizsing Data: W Sum Im
Instance: | |
Filter: kSERVERNAME="@" &&0BJECTNAME= @ J

QI Cancel | Help |

8 From the Metric Properties window,
a In the Label text box, enter:

— @@SERVERNAME : @@OBJECTNAME if you are creating one graph with all
SERVERNAMESs

— @E@OBJECTNAME if you are creating one graph with one SERVERNAME
b In the Marker drop-down list, select any marker other than none.
¢ In the Missing Data drop-down list, select:
— previous to use the previous value if data is missing from the data source

— zero to use the value zero if data is missing from the data source

d Click - | next to the Filter text box. The Metric Filter window displays.
2 Metric Filter
WETRICID = |z =] 1

0] 4 Cancel |

9  From the Metric Filter window,
a Select METRICID from the first drop-down list.
b Select = from the second drop-down list (if it isn’t already selected).
¢ Enter a metric number (for example, 11) in the text box.
d Click OK.
10 From the Metric Properties window,

a In the Filter text box, append the following:
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— &&SERVERNAME=@&&OBJECTNAME=@@ if you want one graph to display all
SERVERNAME/OBJECTNAME combinations.

— &&SERVERNAME=" <server name>"&&OBJECTNAME=@ if you want one graph to
display one SERVERNAME and all OBJECTNAMEs associated with the
multi-instance metric.

If you cannot edit the Filter text box, you can edit this item in the graph template file.
Refer to step 13 for more information.

b Click OK.
11 Click Save As at the top of the window. The Save As window displays.
rSave As ﬂ
Farmily: | j
Categony: | j
Marme: | j

12 From the Save As window,

a

Enter a family (for example, WBSSPI_Graphs) in the Family text box. The family
name serves as a group to organize the graphs.

Enter a name (for example, metric_11) in the Name text box to uniquely identify the
graph.

Entering text into the Category text box is optional.

Click OK. The information is saved in a graph template file named
VPI_GraphsUser<family>.txt (for example, VPI_GraphsUserWBSSPI_Graphs. txt).

For more information about this window, refer to the online help.
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13 Edit the graph template file. The file is located in the OpenView data directory on the
system of the OVPM instance on which you are working. The graph file may look similar
to the following:

#*********************************************

#* OpenView Performance Manager
#* user Defined Graph Templates
#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] mool

#**********************************************

FAMILY: WBSSPI_Graphs

GRAPH: Metricll
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: WBSSPI_RPT METRICS:WBSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=Q&&OBJECTNAME=@
LABEL: @Q@SERVERNAME :@@OBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT METRICS
METRIC: VALUE

FILTER: METRICID=11

LABEL: @Q@SERVERNAME :@@OBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

There can be more than one set of data for a graph in the graph template file.

a Add SUMFROMRAW: to the end of the first section of each graph (in the example above,
add SUMFROMRAW: after SYSTEMNAME : mool). This allows OVPM to summarized data
from the data source and cannot be added using the GUI.

b If you were unable to edit the Filter text box in the Metrics Properties window in
step 10, edit the FILTER field.
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c¢ Save the file. The graph file now contains the following:

#*********************************************

#* OpenView Performance Manager

#* user Defined Graph Templates

#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] mool
#**********************************************
FAMILY: WBSSPI_Graphs

GRAPH: Metricll

GRAPHBACKGROUND: None

DATERANGE: 1 day

GRAPHMULTIPLEGRAPHS: Yes

POINTSEVERY: raw

DATASOURCE: mwa

SYSTEMNAME: mool

SUMFROMRAW :

CLASS: WBSSPI_RPT _METRICS:WBSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=Q&&OBJECTNAME=@
LABEL: @Q@SERVERNAME :@QOBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool
SUMFROMRAW :

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @Q@SERVERNAME :@@OBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:
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14 From the Performance Manager Java Interface window, click the Display tab.

| Display | Design |

Select one or more sources to see a list of avallable graphs,

Shirt
[~ Owerride Shift Defaulls
. =
Star = Stop
Days [+ [+

Logon

SoUrces: |Indiidual Systems = Graphs:
-+ 5} jmoal il = gal Userhlick
H- B8R A [*-g&il UserPauling
- 8 HP-UX =] | E-5E UserPauling Test
[=1-gall WebSphere SPI
Add... ] Clear ‘ Find... 24 Metric1 1
—— — — ?r‘ HBD‘IH‘I_T
Systam Information -l test
Date Range Foints Every.
Duration: [1 [days =] | |5 minutes -
Ending: &+ How  Last [ Display graph in HTML
™ Date: Time:

=

Dirawd

Help

15 In this window,

a In the window below the Sources text box, navigate to the server on which the data

source resides.

b In the Graphs window, navigate to the family of graphs and select the graph you

created.

¢ Enter information into the Date Range dialog box and Points Every text box.

d Click Draw. The graph displays.

) If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from the

graph template file. You must edit the graph template file and re-enter this entry.

16 From the SPI, enable graphing

a From the OVO console, open the Node Bank window and select a node or groups of

nodes on which you want to enable graphing.

Open the Application Bank window.

In the Application Bank window select WBSSPI - WBSSPI Admin.
Double-click UDM Graph Enable.
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6 Basic Troubleshooting and Error Messages

Using the Self-Healing Info Application

Preferred troubleshooting method: Troubleshooting information is enhanced with
cross-referencing capabilities available through the HP support site: http:/
support.openview.hp.com/self_healing.jsp. To access this information and the search
capabilities available on the site, you must first download and configure the Self-Healing
Services client software, an added benefit of your HP support contract. A link is then
automatically set up to the self-healing services web site, where your SPI problem can be
matched to similar SPI problems/solutions for increased troubleshooting effectiveness. Refer
to the Self-Healing Services section in the SPI CD Installation Guide for information on how
to download, configure, and use the software and its automatic link to the HP web site
support service.

Alternative troubleshooting method: If self-healing services is not installed/configured on
the node, you can use the Self-Healing Info application. This application also gathers SPI
troubleshooting data and stores it in a file that you submit to HP support for assistance. Refer
to Self-Healing Info on page 158 for more information about using this application.

Troubleshooting the Discovery Process

If the discovery process does not automatically discover multiple installations on a Windows
managed node, set the HOME_LIST property and run the Discover application.

If the discovery process does not automatically discover and update the WBS-SPI
configuration do the following:

1 Check for errors in the message browser of the managed nodes not being discovered.
Follow the instruction text of any error messages displayed.

2 Verify that a WebSphere application server is installed on the managed node. If an
application server is not installed, install an application server, and complete the
configuration tasks listed in Chapter 3, Configuring the WBS-SPI.

3 Verify the WebSphere application server status. The application server must be running.
See Task 1: Verify the Application Server Status on page 37 for more information.

4 On a Windows managed node, verify the installation directory of the server (\Program
Files\WebSphere\AppServer or \WebSphere\AppServer). If the WebSphere application
server is not installed in the default path, configure the HOME property using the
non-default installation path.
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On a UNIX managed node, if the WebSphere application server processes are not running
(use the ps -ef to check for these processes), verify the installation directory of the server
(see WebSphere Application Server Default Installation Path (UNIX) on page 86 for the
default path). If the WebSphere application server is not installed in the default path,
configure the HOME property using the non-default installation path.

Table 12 WebSphere Application Server Default Installation Path (UNIX)

Operating System Default Installation Path
AIX /usr/WebSphere/AppServer
HP-UX, Linux, Solaris /opt/WebSphere/AppServer
6  Verify that the Config WBSSPI application is not running. Only one process can access

the configuration at a time. If Config WBSSPI is running, other processes that must
access the configuration (like the discovery process) hang until the configuration becomes
available.

Check if the OVO management server is suppressing duplicate messages:

a From the OVO console, select Actions > Server - Configure. The Configure
Management Server window displays.

b  Look for the “Suppress and count duplicate messages” check box. If this box is
checked, uncheck it.

Check the /<%0VAgentDir>/wasspi/wbs/log/discovery. log file for additional
information.

Restart the OVO management server:
a Stop all OVO GUIs that are running by selecting File — Exit.

b  Stop the OVO management server processes. Enter: /opt/0V/bin/ovstop opc
ovoacomm

¢ Delete all OVO temporary files. All pending messages (messages not saved in the
database) and all pending actions (automatic actions, operator-initiated actions,
scheduled actions, and command broadcast) are lost. Enter:
rm -f /var/opt/OV/share/tmp/OpC/mgmt_sv/*

d Restart the OVO management server process. Enter:
/opt/0OV/bin/OpC/opcsv -start
/opt/0OV/bin/OpC/opcsv -status

e Restart the OVO GUI. Enter: opc
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Troubleshooting Applications

Message | Configuration variable SERVER<n> START_CMD missing
for server "Default Server"

Solution | Before you can successfully run the Start WebSphere
application, you must set the START cMD and USER properties.
Set these properties using the Config WBSSPI application.
Refer to Configure WBSSPI on page 154 for more
information about this application.

Message | Configuration variable SERVER<n>_STOP_CMD missing
for server "Default Server"

Solution | Before you can successfully run the Stop WebSphere
application, you must set the sTop_cMp and USER properties.
Set these properties using the Config WBSSPI application.
Refer to Configure WBSSPI on page 154 for more
information about this application.

Error Messages

This section provides information on error messages resulting from conditions detected in the
operation of the Smart Plug-in for WebSphere Application Server (WBS-SPI), not the
WebSphere server. The error messages discussed here are all within the WBSSPI Message
Group.

For any given problem, only the most recent error message is displayed (the older error
message is automatically acknowledged). This reduces the number of error messages
displayed in the message browser.

WASSPI-1

Description | Unable to create the lock file <filename>. File already exists.

Severity Critical

Help Text Probable Cause: Temporary lock files are used to avoid collisions when multiple WBS-
SPI data collector processes attempt to access the same data file. This error occurs when
the lock file cannot be created after several attempts because it already exists.

Suggested Action: If a file by the same name already exists, it may not have been deleted
by a previous run of the WBS-SPI data collector. You should delete this file manually.
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WASSPI-2

Description | Cannot access the SPI configuration.

Severity Critical

Help Text Probable Cause: A WBS-SPI configuration file could not be located or accessed. Either
the file does not exist or there was a problem reading the file.

Suggested Action:

1 Verify that the collector template that runs the WBS-SPI data collector specifies the
correct directory on the command line. The option
-Dwasspi.config.dir=<configDirectory> must be specified on command line
invocation of the data collector. Refer to Managed Node File Locations on page 127 for
the configuration directory <configDirectory>.

2 Verify that the WBS-SPI configuration files SiteConfig and SPIConfig are located in
the directory specified on the command line in step 1. If not, run the WBS-SPI
configuration utility from the application bank to reinstall the files.

3 Refer to the text following the error message in the WBS-SPI error log to help identify
the underlying cause of the problem (for example, an I/O exception).You can view the
SPI error log for a managed node by using the View Error File application accessed
from Application Bank = WBSSPI » WBSSPI Admin. The error message can be identified
by the date/time stamp.

WASSPI-3

Description | Error parsing command line.

Severity Critical

Help Text Probable Cause: The WBS-SPI data collector command line is incorrectly specified in a
collector template.
Suggested Action:

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the data collector command line syntax error. You can view the SPI error log for a
managed node by using the View Error File application accessed from Application Bank
- WBSSPI > WBSSPI Admin. The error message can be identified by the date/time
stamp.

2 Ifthe error occurred in a collector template that shipped with the WBS- SPI, reinstall
the SPI.

3 Ifthe error occurred in a collector template not shipped with the WBS-SPI, correct the
collector template that contains the incorrect command line. See Using the WBS-SPI
Collector/Analyzer Command on page 53 for more information on the WBS-SPI data
collector command line.
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WASSPI-4

Description | Error getting the metric definitions.
Severity Critical
Help Text Probable Cause:

The WBS-SPI data collector could not read the metric definitions XML document. This
error can be caused by a missing configuration property, an I/O error, an XML parsing
error, a missing file, or a corrupted serialized data file.

Suggested Action:

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the View Error File application accessed from Application Bank - WBSSPI -
WBSSPI Admin. The error message can be identified by the date/time stamp.

2 If the UDM_DEFINITIONS_FILE property is missing from the WBS-SPI configuration,
reinstall the SPI and run the WBSSPI Config application accessed from Application
Bank > WBSSPI -» WBSSPI Admin.

3 Ifthe problem is with the metric definitions file (MetricDefinitions.xml) that is
shipped with the WBS-SPI, then reinstall the SPI. Run the WBSSPI Config application
accessed from Application Bank - WBSSPI - WBSSPI Admin.

4 TIf the problem is with a user-defined metric definitions file that is not shipped with the
WBS-SPI, verify that this XML file adheres to the MetricDefinitions.dtd
specification. Refer to the HP OpenView Smart Plug-in User Defined Metrics User
Guide for more information on writing user-defined metrics. Reinstall your
user-defined metric definition file. Run the WBSSPI Config application accessed from
Application Bank - WBSSPI > WBSSPI Admin and verify that the
UDM_DEFINITIONS_FILE property in the SPI configuration, is specified correctly.

5 If the underlying error is ClassNotFound, this is an internal error. Report this to your
HP support representative.

WASSPI-5

Description | Error processing metric <metric_number>.
Severity Major
Help Text Probable Cause: An error occurred while trying to collect data or perform calculations

for the specified metric.

Suggested Action: Refer to the text following the error message in the WBS-SPI error log
to help identify the underlying cause of the problem. The error messages previous to this
one provide more information about the problem. You can view the SPI error log for a
managed node by using the View Error File application accessed from Application Bank -
WBSSPI » WBSSPI Admin. The error message can be identified by the date/time stamp.
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WAGSSPI-6

Description | Required property <property_name>is missing from the WBS-SPI configuration.

Severity Major
Help Text Probable Cause: A required property is missing from the WBS-SPI configuration.
Suggested Action:

1 Run the WBSSPI Config application accessed from Application Bank - WBSSPI -
WBSSPI Admin. Verify that you have specified the correct server information for the
WebSphere instances on this managed node.

2 Verify that the property is specified correctly in the WBS-SPI configuration file on the
managed node (/var/opt/0V/wasspi/wbs/conf/SiteConfig or
/var/opt/0V/conf/wbs/SiteConfig on UNIX platforms and /usr/0vV/wasspi/wbs/
conf/SiteConfig on Windows platforms).

WASSPI-7

Description | Unable to contact server <server._name> at url=<URL>, port=<port>.

Severity Major
Help Text Probable Cause: The specified server is not running at the specified port.
Suggested Action:

1 Run the WBSSPI Config application accessed from Application Bank > WBSSPI > WBSSPI
Admin. Verify that you have specified the correct server name and port information for
the WebSphere instances on this managed node.

2 Verify that the properties SERVER<n>_NAME and SERVER<n>_PORT are specified correctly
in the WBS-SPI configuration file (/var/opt/0OV/wasspi /wbs/conf/SiteConfig or
/var/opt/0V/conf/wbs/SiteConfig on UNIX platforms or
/usr/0V/wasspi/wbs/conf/SiteConfig on Windows platforms) on the managed node
in question.

3 Verify that WebSphere is running on the managed node.
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WAGSSPI-8

Description | Error saving graphing or reporting data to file <file name>.

Severity Critical

Help Text Probable Cause: The specified graphing or reporting data file could not be found or an I/
O error occurred when trying to access the file.

Suggested Action:

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the View Error File application accessed from Application Bank - WBSSPI -
WBSSPI Admin. The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.
Turn on tracing (by using the Start Tracing application accessed from Application Bank
- WBSSPI - WBSSPI Admin) and reproduce the problem. Tracing information is saved to

/<OvAgentDir>/wasspi/wbs/log/trace.log (archived files have a three digit number
appended to the filename) where /<OvAgentDir>/ is typically /var/opt/0V/.

4 Contact your HP support representative with the information gathered in the previous
steps.

WASSPI-9

Description | Unable to retrieve property <property.name>.

Severity Critical

Help Text Probable Cause: A required property is missing from one of the WBS-SPI configuration
files.
Suggested Action:

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the missing property. You can view the SPI error log for a managed node by using the
View Error File application accessed from Application Bank - WBSSPI - WBSSPI Admin.
The error message can be identified by the date/time stamp.

2 Run the WBSSPI Config application accessed from Application Bank - WBSSPI -
WBSSPI Admin. Verify that you have specified the correct information for the
WebSphere instances on the managed node in question.

3 Verify that the missing property is now specified in the WBS-SPI configuration file
(/var/opt/OV/wasspi/wbs/conf/SiteConfig or
/var/opt/0V/conf/wbs/SiteConfig on UNIX platforms or
/usr/0V/wasspi/wbs/conf/SiteConfig on Windows platforms) on the managed node
in question.
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WASSPI-10

Description | Encountered problem accessing file <filename>.
Severity Critical
Help Text Probable Cause: The specified file could not be found, created, or accessed. This file could

be a temporary file.
Suggested Action:

1

Refer to the text following the error message in the WBS-SPI error log to help identify
the file in question and the underlying cause of the problem. You can view the SPI error
log for a managed node by using the View Error File application accessed from
Application Bank » WBSSPI - WBSSPI Admin. The error message can be identified by the
date/time stamp.

2 Verify that you have enough disk space to create temporary files.

WASSPI-11

Description

No servers have been specified in the WebSphere SPI configuration file.

Severity

Major

Help Text

Probable Cause: The number of WebSphere instances specified in the WBS-SPI
configuration for the managed node in question is 0.

Suggested Action:

1

Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin. Verify the server name and port information for the WebSphere
instances on this managed node.

If set, verify that the property NUM_SERVERS in the WBS-SPI configuration file
(/var/opt/0OV/wasspi/wbs/conf/SiteConfig or
/var/opt/0V/conf/wbs/SiteConfig on UNIX platforms or
/usr/0V/wasspi/wbs/conf/SiteConfig on Windows platforms) is set to the number
of WebSphere instances on this managed node.
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WASSPI-12

Description

Opcmon returned an error code of <error._number> for the command <opcmon_command>.

Severity

Critical

Help Text

Probable Cause: The opcmon process started by the WBS-SPI collector has returned an
error (non-zero) exit code.

Suggested Action:
1 Identify the steps to reproduce the problem.

2 Turn on tracing by using the Start Tracing application accessed from Application Bank -
WBSSPI » WBSSPI Admin and reproduce the problem.

3 Tracing information is saved to /<OvAgentDir>/wasspi/wbs/log/trace.log
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/0OV/.

4 Contact your HP support representative with the information gathered in the previous
steps.

WASSPI-13

Description | Exception occurred while running an opcmon process.
Severity Critical
Help Text Probable Cause: The WBS-SPI data collector attempted to run a process to execute an

opcmon call. Either the process could not be created or was interrupted.
Suggested Action:

For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC are
set high enough to allow process creation.

WASSPI-14

Description

Unable to find file <file name>.

Severity

Critical

Help Text

Probable Cause: A file required by the WBS-SPI data collector could not be found.

Suggested Action:

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the file in question and the underlying cause of the problem.You can view the SPI error
log for a managed node by using the View Error File application accessed from

Application Bank » WBSSPI - WBSSPI Admin. The error message can be identified by the
date/time stamp.

Reinstall the WBS-SPI.

3 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.
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WASSPI-15

Description | Error parsing XML document <file name>.
Severity Critical
Help Text Probable Cause: An error occurred while parsing the specified XML document.

Suggested Action:

1

Refer to the text following the error message in the WBS-SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the View Error File application accessed from Application Bank - WBSSPI -
WBSSPI Admin. The error message can be identified by the date/time stamp.

If the XML document was provided by the user, correct the document. Refer to the HP
OpenView Smart Plug-in User Defined Metrics User Guide for more information about
the correct format for a user-defined metric definition document.

If the XML document is a document that is shipped with the WBS-SPI, run the Config
WBSSPI application accessed from Application Bank - WBSSPI - WBSSPI Admin to
reinstall the WBS-SPI configuration files.

WASSPI-16

Description | A bad filter (<filter value>) was specified for metric <metric_number>.
Severity Major
Help Text Probable Cause: A metric filter is incorrectly specified in the metric definitions XML
document.
Suggested Action:
1 If the metric is specified in an XML document that was provided by the user, correct
the document. Refer to the HP OpenView Smart Plug-in User Defined Metrics User
Guide for more information about the correct format for a user-defined metric
definition document.
2 If the metric is a pre-defined metric that is shipped with the WBSPI, run the Config
WBSSPI application accessed from Application Bank - WBSSPI - WBSSPI Admin to
reinstall the WBS-SPI configuration files.
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WASSPI-18

Description | Error logging to datasource <datasource_class_name>. Logging process returned exit
code <exit_code>.

Severity Critical

Help Text Probable Cause: The ddflog process started by the WebSphere SPI data collector

returned a non-zero error code.
Suggested Action:
1 Identify the steps to reproduce the problem.

2 Turn on tracing (by using the Start Tracing application accessed from Application Bank
- WBSSPI - WBSSPI Admin) and reproduce the problem.

3 Tracing information is saved to /<OvAgentDir>/wasspi/wbs/log/trace.log
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/0V/.

4 Contact HP support with the information gathered in the previous steps.

WASSPI-19

Description | Encountered problem instantiating XSLT transformer with <file name>.
Severity Major
Help Text Probable Cause: The XSL document that specifies the auto action report output contains

errors.
Suggested Action:
1 Reinstall the WBS-SPI.

2 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

WASSPI-20

Description | Encountered problem creating report for metric <metric_number>.
Severity Major
Help Text Probable Cause: An error occurred while producing a text report for the specified metric.

Suggested Action:
1 Reinstall the WBS-SPI.

2 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.
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WASSPI-21

Description | Encountered problem instantiating factory implementation
'<class name>'.
Severity Critical
Help Text Probable Cause: The java property specifying the class name is incorrect or the class

does not implement the AppServerFactory interface.

Suggested Action: Verify that the java property appserver.implementation is set to
the fully qualified name of the class which implements the AppServerFactory interface.

For example, if set on the java command-line:

-Dappserver.implementation=com.hp.openview.wasspi.WBSAppServerFactory

WASSPI-22

Description | The PMIinstrumentation level was changed from <old Ilevel>to <new_level> for
module <module name>in server <server name>.

Severity Warning

Help Text Probable Cause: A requested metric's impact rating exceeded the instrumentation level
settings of the application server. The instrumentation level of the appropriate PMI
module was raised to enable collection of the requested metric.
Suggested Action: No action necessary. This message is meant for information purposes
only.
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WASSPI-23

Description | Error initializing collector analyzer for server <server_name>.

Severity Critical

Help Text Probable Cause
An exception was encountered while preparing to monitor the specified server.
Suggested Action

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the problem. You can view the SPI error log for a managed node by using the View
Error File application accessed from the Application Bank > WBSSPI > WBSSPI Admin
windows. The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing (by using the Start Tracing application accessed from the Application
Bank - WBSSPI > WBSSPI Admin windows) and reproduce the problem.

Tracing information is saved to /<OvAgentDir>/wasspi/wbs/log/trace.log
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/0OV/.

4 Run the Gather Info application (by using the Gather Info application accessed from
the Application Bank > WBSSPI > WBSSPI Admin windows).

5 Contact your HP support representative with the information gathered in the previous
steps.

WASSPI-24

Description | Error logging in to server <server_name>with login <login>.

Severity Critical
Help Text Probable Cause: A security exception occurred while logging in to the specified server.
Suggested Action:
1 Run the Config WBSSPI application accessed from Application Bank - WBSSPI =
WBSSPI Admin.

Verify the LOGIN and PASSWORD configuration properties are set correctly.
3 Verify that the WebSphere login has the correct permissions.
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WASSPI-25

Description | Performance monitoring service is not enabled on server <server._name>.
Severity Warning
Help Text Probable Cause: PMI service is not enabled on the specified server.

Suggested Action:

1 Use the WebSphere administrative console to enable PMI on the specified server. Refer
to http:/publib.boulder.ibm.com/infocenter/ws51help/index.jsp?topic=/
com.ibm.websphere.base.doc/info/aes/ae/tprf_prfstartadmin.html for more information
about enabling PMI.

2 Restart the specified server.

WASSPI-26

Description | The data logging process for <server_name> timed-out.

Severity Major

Help Text Probable Cause
Depending on your configuration, either OVPA or CODA failed to exit before the time-out.
Suggested Action
1 Restart OVPA using the command mwa restart.
2 Restart CODA using the command opcagt -start.
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WASSPI-27

Description | RMI collector unable to process <command>.
Severity Warning
Help Text Probable Cause

An exception was encountered while performing an rmid related operation.

Suggested Action

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the problem. You can view the SPI error log for a managed node by using the View

Error File application accessed from the Application Bank > WBSSPI > WBSSPI Admin
windows. The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

Turn on tracing (by using the Start Tracing application accessed from the Application
Bank - WBSSPI > WBSSPI Admin windows) and reproduce the problem.

Tracing information is saved to /<OvAgentDir>/wasspi/wbs/log/trace.log
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/0OV/.

4 Run the Gather Info application (by using the Gather Info application accessed from
the Application Bank > WBSSPI - WBSSPI Admin windows).

5 Contact your HP support representative with the information gathered in the previous
steps.

WASSPI-30

Description | Failed to start <rmid path> on port <port>.
Severity Critical
Help Text Probable Cause: The specified path is already in use.

Suggested Action: Specify an rmid port which is not in use by setting the RMID_PORT
property in the WBS-SPI configuration file on the managed node
(/var/opt/OV/wasspi/wbs/conf/SPIConfig or /var/opt/OV/conf /wbs/SPIConfig on
UNIX platforms and /usr/0V/wasspi/wbs/conf/SPIConfig on Windows platforms. To
avoid being overwritten, RMID_PORT must be added following the Dynamic definitions
comment.

WASSPI-31

Description | Lost connection to RMI collector while processing <command>.
Severity Warning
Help Text N/A
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WASSPI-32

Description | Unable to retrieve metadata for mbean <JMx-ObjectName>.
Severity Warning
Help Text N/A

WASSPI-33

Description | No actions matched server <server name>, version <version>.
Severity Warning
Help Text Probable Cause: JMXAction element(s) define FromVersion and ToVersion tags which

do not match the server version.

Suggested Action: If the action is valid on the server, then either adjust the JMXAction
definition's FromVersion/ToVersion elements or the server's VERSION property.

WASSPI-34

Description | Metric <metric id>does not define any actions.
Severity Warning
Help Text Probable Cause: The metric ID specified with the action -m option does not define a

JMXActions element.

Suggested Action: Correct the action -m option if an incorrect metric ID was specified.
Otherwise, add a JMXActions definition to the metric definition.

WASSPI-35

Description | Error executing action <action command-line>.
Severity Serious
Help Text Probable Cause: An unexpected error occurred while executing the action.
Suggested Action: View the managed node's errorlog to determine the root cause which
is logged following the error message.
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WASSPI-36

Description | MBean <JMX objectname> on server <server name>, does not expose operation
<operation name>.

Severity Warning

Help Text Probable Cause: An action's JMXCalls element defines an operation not exposed by the

specified MBean.

Suggested Action: Correct the JMXCalls element or remove the operation from the
element.

WASSPI-37

Description | MBean <JMX objectname> on server <server name>, does not expose attribute
<attribute name> for write.

Severity Warning

Help Text Probable Cause: An action's JMXCalls element defines a write attribute exposed by the

specified MBean as read-only.

Suggested Action: If it is a custom MBean, update the MBean's management interface
so the attribute is writable. Otherwise, remove the attribute definition from the JMXCalls
element.

WASSPI-38

Description | MBean <JMX objectname>on server <server name>, does not expose attribute
<attribute name>.

Severity Warning

Help Text Probable Cause: An action's JMXCalls element defines an attribute not exposed by the

specified MBean ObjectName.

Suggested Action: Correct the JMXCalls element or remove the attribute from the
element.

WASSPI-39

Description | Error invoking operation <operation name>on MBean
<JMX objectname>.
Severity Serious
Help Text Probable Cause: An unexpected error occurred while invoking an operation on the

specified MBean. The managed resource may have thrown an exception.

Suggested Action: View the managed node's errorlog to determine the root cause which
is logged following the error message.
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WASSPI-40

Description | Error setting attribute <attribute name>on MBean
<JMX objectname>.
Severity Serious
Help Text Probable Cause: An unexpected error occurred while setting an attribute on the specified

MBean. The managed resource may have thrown an exception.

Suggested Action: View the managed node's errorlog to determine the root cause which
is logged following the error message.

WASSPI-41

Description | Error getting attribute <attribute name>from MBean
<JMX objectname>.
Severity Serious
Help Text Probable Cause: An unexpected error occurred while getting an attribute from the

specified MBean. The managed resource may have thrown an exception.

Suggested Action: View the managed node's errorlog to determine the root cause which
is logged following the error message.

WASSPI-42

Description

Error running command <command>.

Severity

Critical

Help Text

Probable Cause

A command started by the WBS-SPI collector reported an error.
Suggested Action

1 Identify the steps to reproduce the problem.

2 Turn on tracing (by using the Start Tracing application accessed from the Application
Bank - WBSSPI > WBSSPI Admin windows) and reproduce the problem.

Tracing information is saved to / <OvAgentDir>/wasspi/wbs/log/trace.log
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/0V/.

3 Run the Gather Info application (by using the Gather Info application accessed from
the Application Bank > WBSSPI > WBSSPI Admin windows).

4 Contact your HP support representative with the information gathered in the previous
steps.
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WASSPI-43

Description | Error publishing event <event-type>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action

View the managed node’s error log to determine the cause (follows the error message).

WASSPI-201

Description File <filename> not found.
Severity Critical
Help Text Probable Cause: A configuration file could not be found.

Suggested Action:

1 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

2 Verify that the correct information has been specified for the WebSphere instances on
the managed node on which the error occurred.

WASSPI-202

Description | Cannot read file <filename>.
Severity Critical
Help Text Probable Cause:

e A file could not be opened or it could not be found.
¢ Permissions may be incorrect or a directory may be corrupt.
Suggested Action:

1 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

2 Verify that you have specified the correct information for the WebSphere instances on
the managed node on which the error occurred.

3 Verify that the permissions are correct for the OVO user to read this file.
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WASSPI-203

Description Cannot write file <filename>.

Severity Critical
Help Text Probable Cause: Permissions may be incorrect, or a file or directory may be corrupt.
Suggested Action:
1 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

2 Verify that you have specified the correct information for the WebSphere instances on
the managed node on which the error occurred.

3 Verify that the permissions are correct for the OVO user to write this file.

WASSPI-204

Description | Error sending opcmsg <message>.

Severity Critical

Help Text Probable Cause: There was a problem running opcmsg. ‘opcmsg’ may be missing or not
have permissions to execute (OVO installation errors) or the system process table may be
full.
Suggested Action:

1 Confirm that OVO is properly installed and deployed to the managed node.

2 Ensure that the process table is not full. If it is, consider having the system
administrator increase it.

WASSPI-205

Description | Error sending opcmon <command>.

Severity Critical

Help Text Probable Cause: There was a problem running opcmon. ‘opcmon’ may be missing or not
have permissions to execute (OVO installation errors) or the system process table may be
full.
Suggested Action:

1 Confirm that OVO is properly installed and deployed to the managed node.

2 Ensure that the process table is not full. If it is, consider having the system
administrator increase it.
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WASSPI-206

Description | Cannot read directory <directory>.
Severity Critical
Help Text Probable Cause: The permissions on the directory prevent the OVO user from reading it

or the directory is corrupt.

Suggested Action: Verify that the permissions are correct for the OVO user for this
directory.

WASSPI-207

Description | Cannot move <filename>to <filename>.
Severity Critical
Help Text Probable Cause:

1 Insufficient permissions.

2 Insufficient disk space.

3 File table problems.

Suggested Action:

1 Verify that the permissions are correct for the OVO user.
2 Verify that there is enough disk space to create files.

3 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

WASSPI-208

Description | WBSSPI must be configured before it can be used.
Severity Critical
Help Text Probable Cause: The SPI has not been configured on this node.

Suggested Action:

1 Run the Config WBSSPI application accessed from Application Bank > WBSSPI -
WBSSPI Admin.

2 Verify that you have specified the correct information for the WebSphere instances on
the managed node on which the error occurred.

3 Run the Verify utility accessed from Application Bank > WBSSPI > WBSSPI Admin to
confirm that the SPI has been successfully configured.
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WASSPI-209

Description | Cannot contact WebSphere.
Severity Critical
Help Text Probable Cause:

e The server could be down or not responding.

¢ The SPI may be configured incorrectly.
Suggested Action:

1 Verify that WebSphere is up and running properly.

2 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

3 Verify that you have specified the correct information for the WebSphere instances on
the managed node on which the error occurred.

4 Run the Verify utility accessed from Application Bank > WBSSPI > WBSSPI Admin to
confirm that the SPI has been successfully configured.

WASSPI-210

Description | Cannot configure WBSSPI.
Severity Critical
Help Text Probable Cause: The SPI configuration process failed.

Suggested Action:

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the underlying cause of the problem. The error messages previous to this one provides
more information about the problem. You can view the SPI error log for a managed
node by using the View Error File application accessed from Application Bank - WBSSPI
- WBSSPI Admin. The error message can be identified by the date/time stamp.

Reinstall the WBS-SPI.

Run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

WASSPI-211

Description | Cannot create directory <directory>.

Severity Critical

Help Text Probable Cause: There are insufficient permissions for the OVO user to create the
directory or there is insufficient disk space.
Suggested Action:
1 Verify that the permissions are correct for the OVO user for this directory.
2 Verify that there is enough disk space.
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WASSPI-213

Description

Improper parameters to program <name>. Usage: <usage>.

Severity

Critical

Help Text

Probable Cause: The parameters to the program are incorrect.
Suggested Action: Correct the parameters.

WASSPI-214

Description Cannot run program <program name>.
Severity Critical
Help Text Probable Cause: The program failed to run. It may be missing, permissions may be

incorrect, or the process table may be full.
Suggested Action:

1 Verify that the file exists. If it is a SPI program and the file is missing, reinstall the SPI
and run the Config WBSSPI application accessed from Application Bank - WBSSPI -
WBSSPI Admin.

2 Verify that the permissions are correct for the OVO user.

WASSPI-216

Description | Configuration variable <name> missing for server <server_ name>.
Severity Critical
Help Text Probable Cause: A required SPI configuration property was not found.

Suggested Action:

1 Run the Config WBSSPI application accessed from Application Bank > WBSSPI -
WBSSPI Admin.

2 Verify that the correct information has been specified in the configuration for the
managed node on which the error occurred.
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WASSPI-218

Description

WebSphere monitoring has been turned OFF for <server_name>.

Severity

Warning

Help Text

Probable Cause: Collection has been turned off for the specified server.

Suggested Action: If desired, collection can be turned on by setting COLLECT = ONin the
SiteConfig file in the SPI configuration directory on the managed node. The configuration
directory is /var/opt/OV/wasspi/wbs/conf/ or /var/opt/0V/conf/wbs/ on UNIX
platforms or /usr/0OvV/wasspi/wbs/conf/ on Windows platforms.

WASSPI-219

Description

WebSphere monitoring has been turned ON for <server name>.

Severity

Critical

Help Text

Probable Cause: Collection has been turned on for the specified server.

Suggested Action: If desired, collection can be turned off by setting COLLECT = OFF in
the siteConfig file in the SPI configuration directory on the managed node. The
configuration directory is /var/opt/OV/wasspi/wbs/conf/ or

/var/opt/0V/conf/wbs/ on UNIX platforms or /usr/0vV/wasspi/wbs/conf/ on Windows
platforms.

WASSPI-221

Description | <file name>does not exist.
Severity Critical
Help Text Probable Cause: The specified file does not exist.

1 Ifitis alog file, no entries have ever been logged to it.
2 Ifit is a property file, then it has not been configured.
Suggested Action:

1 Log files: If there have never been any entries written to the file, no action is necessary.
Otherwise, run the Config WBSSPI application accessed from Application Bank -
WBSSPI - WBSSPI Admin.

2 Property files: Run the Config WBSSPI accessed from Application Bank - WBSSPI -
WBSSPI Admin.
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WAGSSPI-222

Description | <file name>is empty.
Severity Critical
Help Text Probable Cause: The specified file is empty.

Suggested Action:

1 Ifitis a log file, no entries have ever been logged to it, or the entries have been cleaned
out.

2 Ifitis a property file, then it is not properly configured. Run the Config WBSSPI
application accessed from Application Bank > WBSSPI > WBSSPI Admin.

3 Ifthe file is a configuration file, run the Config WBSSPI application accessed from
Application Bank > WBSSPI » WBSSPI Admin.

WASSPI-223

Description | Cannot read <file name>.
Severity Critical
Help Text Probable Cause:

1 A file could not be opened or it could not be found.
2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action:

1 Run the Config WBSSPI application accessed from Application Bank > WBSSPI -
WBSSPI Admin. Verify that you have specified the correct information for the
WebSphere instances on the managed node on which the error occurred.

2 Verify that the permissions are correct for the OVO user to read this file.
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WASSPI-224

Description | ddfcomp returned an error configuring <name>.
Severity Critical
Help Text Probable Cause: ‘ddfcomp’ returned an error. This could be because neither

MeasureWare nor CODA is installed on the system or because of an error configuring
MeasureWare or CODA.

Suggested Action:
1 If MeasureWare nor CODA is not installed, this error can be ignored.
2 Identify the steps to reproduce the problem.

3 Turn on tracing (by using the Start Tracing application accessed from Application Bank
- WBSSPI - WBSSPI Admin) and reproduce the problem.

4 Tracing information is saved to /<OvAgentDir>/wasspi/wbs/log/trace.log
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/0V/.

5 Contact your HP support representative with the information gathered in the previous
steps.

WASSPI-225

Description | No logfiles were found. Did you run ‘Config WBSSPI'?

Severity Critical

Help Text Probable Cause: The logfile list is empty.
Suggested Action:
1 Reinstall the SPI.
2 Run the Config WBSSPI application accessed from Application Bank - WBSSPI -

WBSSPI Admin.
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WASSPI-226

Description | Cannot read file <file name>.
Severity Critical
Help Text Probable Cause:

e A file could not be opened or it could not be found.
e Permissions may be incorrect or a directory may be corrupt.
Suggested Action:

1 Run the Config WBSSPI application accessed from Application Bank - WBSSPI =
WBSSPI Admin.

2 Verify that you have specified the correct information for the WebSphere instances on
the managed node on which the error occurred.

3 Verify that the permissions are correct for the OVO user to read this file.

WASSPI-227

Description | No OpenView performance agent is installed. Data source will not be configured.
Severity Warning
Help Text Probable Cause: If a performance tool is available, the SPI integrates with it. This

warning just indicates that none is available.

Suggested Action: If performance software has been installed, verify that it is installed
correctly and is running. If none has been installed purchase it from HP or ignore the
message.

WASSPI-228

Description

ddflog returned an error logging <datasource>: <message>

Severity

Critical

Help Text

Probable Cause: Some error occurred when the SPI was trying to transfer data to the
performance tools into the indicated data source. The specific error message is displayed.

Suggested Action: Review the message provided and use troubleshooting information
from the performance tools.
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WASSPI-229

Description | Cannot connect to directory <dir>
Severity Critical
Help Text Probable Cause: An attempt was made to connect to directory <dir>, but the attempt

failed. The directory may not exist for some reason or the protection on the directory
prevents the user from making the connection.

Suggested Action: Check protection of the directory and correct it if necessary. If the
directory does not exist, try reconfiguring the SPI on the specified managed node.

WASSPI-230

Description | Cannot get lock <file> after <time>
Severity Critical
Help Text Probable Cause: The lock file <file>was not cleared in the <time>indicated. This could

be due to a very slow running SPI process, a hung SPI process, or a SPI process was killed
before the lock it had open had been cleared.

Suggested Action:
1 Make sure no SPI processes are running.
2 Manually remove the lock file.

WASSPI-231

Description

Error starting JRE <JvM_file>: <message>

Severity

Critical

Help Text

Probable Cause: Some error occurred starting or running Java. For example, the
specified JVM does not exist or the collector had some error.

Suggested Action:
1 Check for other errors generated at the same time that may indicate the real cause.

2 If the specified file does not exist, check your JAVA_HOME or HOME properties in the SPI
configuration. Run the Config WBSSPI application accessed from Application Bank -
WBSSPI - WBSSPI Admin.
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WASSPI-232

Description | Server <name> specified on command line, but not in configuration
Severity Critical
Help Text Probable Cause: There was a -i or -e specified on the collector command line which

specified a server name that was not listed in the SPI configuration. The collector only
knows about servers listed in the configuration.

Suggested Action:

1 Make sure the WebSphere server names are correctly listed and spelled on the
command line of the collector call.

2 Make sure the WebSphere server names are correctly listed and spelled in the SPI
configuration. Run the Config WBSSPI application accessed from Application Bank -
WBSSPI - WBSSPI Admin.

WASSPI-234

Description | Error running program <file>, return value: <n>
Severity Critical
Help Text Probable Cause: The SPI attempted to run some tool or auxiliary program and

encountered an error doing so. The tool or program is shown in the message as <file>and
the return code is <n>.

Suggested Action: If the tool is a SPI tool, make sure the SPI has been installed and
configured correctly. If not, reinstall or reconfigure the SPI. If it is a system tool, make
sure there are no system problems that prevent the tool from running.

WASSPI-235

Description | Restart of MeasureWare agents failed
Severity Warning
Help Text Probable Cause: The SPI attempted to automatically restart the MeasureWare agents

and the automatic attempt failed.

Suggested Action: Restart the MeasureWare agents manually using the mwa restart
server command.
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WASSPI-236

Description | Failure when running XSLT on <xml> with stylesheet <xs1>: <message>
Severity Critical
Help Text Probable Cause: As part of setting up graphing for user defined metrics, a translation of

the UDM XML is done. This message indicated that translation failed.

Suggested Action: Review the message shown. It is most likely that there is an error in
the XML. Refer to the HP OpenView Smart Plug-in User Defined Metrics User Guide for
more information about the correct format for a user-defined metric definition document.

WASSPI-237

Description | Setting up Data Source <datasource>
Severity Information
Help Text This is an informational message that indicates that the identified datasource is being

created and that it is available to the various reporting and graphing tools.

WASSPI-238

Description | No User Defined Metrics found
Severity Warning
Help Text Probable Cause: The UDM Graph Enable application was run, but no UDM metrics

definitions exist.

Suggested Action: Check that the UDM XML file has been named correctly. Run the
Config WBSSPI application accessed from Application Bank > WBSSPI -» WBSSPI Admin and
verify that the UDM_DEFINITIONS_FILE property is set correctly.

WASSPI-240

Description UDM Data Logging integration Complete
Severity Information
Help Text The UDM Graph Enable application successfully executed and UDM graph metrics will be
available for graphing.
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WASSPI-241

Description | Cannot delete file <file>
Severity Critical/Warning
Help Text Probable Cause: The SPI attempted to delete a file, but was unable to do so. It may be

that the protection of the file is set so that the OVO user cannot delete it, or that there is
some system problem preventing the file from being deleted.

Suggested Action: Make sure the protection of the file is correct.

WASSPI-242

Description UDM graphing successfully disabled.
Severity Information
Help Text The UDM Graph Disable application successfully executed.

WASSPI-303

Description

The SPI configuration for <node name> was updated by discovery in the OVO server.

Help Text

This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. This message is sent to inform an operator
that the WBSSPI Discovery has:

e found WebSphere application server(s) on a managed node that have not been
configured,

e found new WebSphere application server(s) on a configured node, or
¢ detected changes in the application server(s) configuration.

The WBSSPI-Discovery components automatically update these changes in the SPI
configuration.

Please review the new configuration details that are included as part of the message text
and verify the information for correctness.
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WASSPI-501

Description | Retrieving configuration data from the OVO server

Help Text This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. Upon successful operation, the entry in the
"A" (Action) column for this message should change from R (running) to S (success).
However, if the entry in this column changes to F (fail), the operation was not completed
successfully. Please select this node and run the Discovery application again.

If the problem persists, please refer to the document HP OpenView Smart Plug-in for
WebSphere Application Server Configuration Guide. The chapter called "Configuring the
WBS-SPI" provides instructions on how to manually configure the WBS-SPI.

WASSPI-502

Description | Updating the WBSSPI configuration data with discovered information

Help Text This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. Upon successful operation, the entry in the
"A" (Action) column for this message should change from R (running) to S (success).
However, if the entry in this column changes to F (fail), the operation was not completed
successfully. Please select this node and run the Discovery application again.

If the problem persists, please refer to the document HP OpenView Smart Plug-in for
WebSphere Application Server Configuration Guide. The chapter called "Configuring the
WBS-SPI" provides instructions on how to manually configure the WBS-SPI.

WASSPI-503

Description | The configuration for <node_name> node has been automatically updated by the WBSSPI
Discovery ...

Help Text This is a normal operation performed by the WBSSPI Discovery policy action. It sends this
message to inform an operator that the WBSSPI Discovery either discovered WebSphere
application server(s) on a managed node that has not been configured or detected changes
in the application server(s) configuration. The Discovery components automatically update
these changes in the SPI configuration.

Please review the new configuration details that are included as part of the message text
and verify the information for correctness. The new configuration can also be viewed by
launching the "WBSSPI Configure" tool.

WASSPI-541

Descriptionl No running WebSphere application servers found
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Help Text |Probable Cause: A WebSphere application server is not present (or not running) on the node.

Verification: Verify the presence of an application server on the node, and check that the
application server is running.

Suggested Action: Create or start one or more application servers on the node. Select the
node and run the Discovery application again.

Please make sure that all of the application servers you wish to monitor are running, before the
WBSSPI-Discovery template is deployed or the Discovery application is launched. Only the
servers that are running will be automatically configured.

NOTE: If it has been confirmed that WebSphere application servers exist on the system and
are in the running state, then this message indicates that the WBSSPI Discovery is unable to
discover the application servers. Please try the followings:

1 Launch the Discovery application.

2 Select the "Default Properties" item corresponding to this managed node. Select the
HOME_LIST property from the "Select a Property to Set..." menu and click Set Property.

3 Enter the HOME directory where WebSphere application server programs are installed on
this node. If there are more than one installation instance of WebSphere, enter the HOME
directories, separated by a semicolon. (For example, /opt/WebSphere/AppServer;/opt/ibm/
WebSphere5/AppServer).

Click Next and complete the operation.

5 Allow the WBSSPI Discovery application to complete. (A message starting with
"WASSPI-303" appears in the Message Browser with the node name embedded in the
message text).

If the WBSSPI configurations are not properly updated and the application servers are not

displayed on the Service Navigator's Services tree, check the WBSSPI Discovery log file called

<OvAgentDir>/wasspi/wbs/log discovery.log on the managed node for any ERROR log
entries.

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if security
is enabled. Please also make sure that the LOGIN and PASSWORD properties for this node are
present and valid in the WBSSPI configuration. Launch the "Config WBSSPI" application and
verify the accuracy of the information. The PASSWORD information is encrypted for security
purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct LOGIN/

PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

WebSphere Application Server Version 4
Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start the
WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the port
number is not the default value (port 900) or if multiple instances of the AdminServer are
present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-561

Description

Failed to communicate with the WebSphere 4 AdminServer on port: <port_number>

Help Text

Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start
the WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-562

Description | Security access failure. Missing or invalid LOGIN/PASSWORD parameter for WebSphere 4
AdminServer on port: <port_number>

Help Text Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configuration or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

WASSPI-563

Description Security access failure. Invalid LOGIN/PASSWORD parameter for WebSphere 4 AdminServer
on port: <port_number>

Help Text Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties) for
this node are present and valid in the WBSSPI configurations. Launch the "Config
WBSSPI" application and verify the accuracy of the information. The PASSWORD
information is encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-564

Description

Security access failure. Unable to communicate with the WebSphere 4 AdminServer on
port: <port_number>

Help Text

Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start
the WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the "Config WBSSPI"
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-565

Description | Security access failure. Unable to log in to the WebSphere 4 AdminServer on port:
<port_number>

Help Text Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the "Config WBSSPI"
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-571

Description

Failed to communicate with WebSphere Application Server

Help Text

WebSphere Application Server versions 5 and 6

Probable Cause: A WebSphere application server is not present (or not running) on the
node.

Verification: Verify the presence of an application server on the node, and check that the
application server is running.

Suggested Action: Create or start one or more application servers on the node. Select the
node and run the Discovery application again.

Please make sure that all of the application servers you wish to monitor are running,
before the WBSSPI-Discovery template is deployed or the Discovery application is
launched. Only the servers that are running will be automatically configured.

WebSphere Application Server versions 5 and 6

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the "Config WBSSPI"
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

WASSPI-572

Description

WebSphere Login Error - Missing Login Data

Help Text

WebSphere Application Server versions 5 and 6

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the "Config WBSSPI"
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.
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WASSPI-573

Description

WebSphere Login Error - Invalid Login Data

Help Text

WebSphere Application Server versions 5 and 6

Probable Cause: The discovery application was unable to authenticate itself in a secured
WebSphere server environment. This is likely due to incorrect values for the LOGIN and
PASSWORD properties being provided in the WBSSPI configurations for this node.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the "Config WBSSPI"
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow the
WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere

Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

WASSPI-581

Description

INTERNAL ERROR - <error _message>

Help Text

Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application may not function
properly due to one (or more) of the following conditions on the managed node:

e A WBSSPI Discovery application, script, or data file is missing, has been removed, or is
placed in non-standard directory paths.

e There were problems with the OpenView agent installation.
¢ The OpenView agents installation directory cannot be determined.

¢ OpenView operator account that runs the WBSSPI Discovery does not have the
permission to open/read the specified file or execute the required script/command.

¢ General network errors.
Suggested Action: Check with the OpenView or the IT specialist in the organization on

matters related to these issues. Once the problems have been resolved, select the node and
run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

Contact your HP support representative if the problem cannot be resolved or if further
assistance is needed.
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WASSPI-585

Description

SYSTEM ERROR - <error._message>

Help Text

Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application may not function
properly due to one (or more) of the following conditions on the managed node:

¢ Operating system commands used by WBSSPI Discovery are missing, have been
removed, or are placed in non-standard directory paths.

¢ The system's PATH variable has not been set for certain system commands.

¢ Required operating system file(s) or software installation registry cannot be found or is
in a non-standard directory path.

¢ OpenView operator account that runs the WBSSPI Discovery does not have the
permission to open/read system files or execute the necessary system commands.

® General network errors.

Suggested Action: Check with the OpenView or the IT specialist in the organization on

matters related to these issues. Once the problems have been resolved, select the node and
run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.

WASSPI-591

Description

WEBSPHERE ERROR - <error message>

Help Text

Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application may not function
properly due to one (or more) of the following conditions on the managed node:

e WebSphere commands used by WBSSPI Discovery are missing, have been removed, or
are placed in non-standard directory paths.

¢ OpenView operator account that runs the WBSSPI Discovery does not have the
permission to open/read files or execute commands in the WebSphere installation
directories.

Suggested Action: Check with the OpenView or the WebSphere application server
specialist in the organization on matters related to these issues. Once the problems have
been resolved, select the node and run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called "Configuring the WBS-SPI"
provides instructions on how to manually configure the WBS-SPI.
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All Other Errors

Description | An unknown error appears in the WebSphere SPI error log.

Severity Major

Help Text Suggested Action:

1 Refer to the text following the error message in the WBS-SPI error log to help identify
the problem. You can view the SPI error log for a managed node by using the View
Error File application accessed from Application Bank - WBSSPI » WBSSPI Admin. The
error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing (by using the Start Tracing application accessed from Application Bank
- WBSSPI > WBSSPI Admin) and reproduce the problem.

4 Tracing information is saved to /<OvAgentDir>/wasspi/wbs/log/trace.log
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/0V/.

5 Contact your HP support representative with the information gathered in the previous
steps.
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A File Locations

You can find the Smart Plug-in for WebSphere Application Server (WBS-SPI) configuration
files and error logs in specific directories.

OVO Management Server File Locations

Operating

System File File Location

HP-UX Configuration | /opt/OV/wasspi/wbs/conf
Solaris Configuration | /opt/OV/wasspi/wbs/conf

Managed Node File Locations

On DCE-based managed nodes or UNIX managed nodes that were already running the
WBS-SPI and are being switched to a non-root HTTPS agent environment (UNIX only: if
these directories do not exist, refer to the next table for file locations):

Operating System | File File Location

HP-UX, Solaris, Linux | Configuration | /var/opt/OV/wasspi/wbs/conf

HP-UX, Solaris, Linux | Error Logs /var/opt/OV/wasspi/wbs/log

AIX Configuration | /var/lpp/0V/wasspi/wbs/conf

AIX Error Logs /var/lpp/0OV/wasspi/wbs/log

Windows (DCE) Configuration |\usr\ov\wasspi\wbs\conf

Windows (DCE) Error Logs \usr\ov\wasspi\wbs\log

Windows (HTTPS) Configuration | \Program Files\HP OpenView\data\
wasspi\wbs\conf

Windows (HTTPS) Error Logs \Program Files\HP OpenView\data\
wasspi\wbs\log
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On newly configured WBS-SPI managed nodes in the non-root HTTPS agent environment

(UNIX only):

Operating System File File Location

HP-UX, Solaris, Linux | Configuration | /var/opt/0OV/conf/wbsspi
HP-UX, Solaris, Linux | Error Logs /var/opt/0V/log/wbsspi
AIX Configuration | /var/lpp/0OV/conf/wbsspi
AIX Error Logs /var/lpp/0V/log/wbsspi
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B The Contiguration

This appendix contains information about the configuration structure, how to use the
configuration editor, descriptions of the configuration properties, and samples of the
configuration.

Structure

See Sample Configurations on page 149 for examples of the configuration. The basic structure
of the configuration is (lines preceded by # are treated as comments and are ignored):

# Global Properties
<property>=<value> ...

# GROUP Block
GROUP <group_name>
{

<node_name> ...

}

# NODE Block

NODE <node_name | group_name>
{

<property>=<value> ...

}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. However, these global properties can
be overridden by properties set within a GROUP or NODE block or by server-specific
properties.

GROUP Block

# GROUP Block
GROUP <group_name>
{

<node_name> ...

}
GROUP blocks are used to group nodes together that have common properties.
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<group_name> identifies the group of nodes with common properties. If a GROUP block
<group_name> is repeated within the configuration, the last definition takes precedence.

<node_name> lists the nodes in the group and is the primary node name configured in OVO.
) The node name specified in a GROUP block matches the value returned by the OVO variable

$OPC_NODES, which is the primary node name configured in OVO.

Set the common properties of the group using the NODE block.

Using the configuration editor, view, set, or edit GROUP block properties by selecting the
Default Properties item in the <Group_Name> folder.

NODE Block

# NODE Block
NODE <node_name | group_name>

{

<property>=<value> ...

}

Properties set in a NODE block apply to nodes belonging to the group defined by
<group_name> (to set common properties for a group) or to the specified <node_name> (to set
properties for a single node).

For a group, enter the <group_name> defined by the GROUP block and define the group’s
common properties.

For a single node, enter the <node_name> and define the properties.

If a property definition is repeated within the NODE block, the last definition takes
precedence.

Using the configuration editor, view, set, or edit NODE block properties by selecting the
Default Properties item in the <Node_Name> folder.

Server-Specific Properties

Each property specified as SERVER<n>_property refers to a specific WebSphere server
instance. When more than one WebSphere server instance is running on a given managed
node, the number <n> differentiates the servers. Numbering begins at “1” and each
WebSphere server instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:
1 SERVER<n>_ property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)
4

<property> (global property)
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Using the Configuration Editor

Use the configuration editor to view and edit the configuration. You must update the
configuration using this editor only.

The main features of the configuration editor are:
e Tree
e Buttons

e Actions

Config WBSSPI - Tree

The Config WBSSPI tree, displayed in the left pane of the Config WBSSPI application’s main
window, displays the WBS-SPI configuration in a tree structure.

The following is an example of the tree.

’ If no application servers or groups are configured, the “Application Servers” and “Groups”
folders are not displayed. If you are running Config WBSSPI for the first time and you did not
select any nodes before you launched the tool, the “Nodes” folder is not displayed.

=F ] Configuration
=k 7 Defaults
I— Default Properties
=k T fpplication Servers
|— <App_Serverl_Name:
=F 7 Groups
.:l- 7 <Group_Mame:
I— Default Properties
=k T fpplication Servers
|— <App_Server?_Name:
=F ] Nodes
=k 7 <Mode_Name>
I— Default Properties
=k T fpplication Servers
|— <App_Server3_Name:

where the icons are defined as follows:
o | The configuration properties can be viewed.

The configuration properties can be viewed and set.
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The following table lists each item in the tree and a brief description of the item.

Item Name

Description

Application Servers

A folder that contains a list of all the application servers.
This folder can appear under Defaults (global properties),
Group_Name(s) (GROUP block), or Node_Name(s) (NODE
block).

<Application_Server_Name>

The server name as defined in WebSphere.

Configuration

A folder that contains all WBS-SPI configuration
information for the WebSphere environment.

Default Properties

Lists the configuration properties that have been set. This
item appears under Defaults (global properties),
Group_Name(s) (GROUP block), or Node_Name(s) (NODE
block).

Defaults

A folder that represents the global properties. Default
properties set at this level apply to all nodes. However,
these properties can be overridden by properties set under
the GroupName and Node_Name folders (refer to Property
Precedence on page 130 for more information).

Groups

A folder that represents the GROUP block.

<Group_Name>

A folder that identifies the name of a group of nodes with
common properties. Default properties set at this level
apply to all nodes that belong to the specified group. These
properties can be overridden by properties set under the
Node_Name folders (refer to Property Precedence on

page 130 for more information).

Nodes

A folder that represents the NODE block.

<Node_Name>

A folder that represents a single node whose name matches
the value returned by the OVO variable $OPC_NODES, which
is the primary node name configured in OVO. Default
properties set at this level apply to the specified node only
(refer to Property Precedence on page 130 for more
information).
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Config WBSSPI - Buttons

The following buttons are available in Config WBSSPI:

Button

Description

Cancel

Exit Config WBSSPI.

If you set configuration properties without saving them, these changes are not
saved.

If you added or removed an application server, node, or group without saving the
change or if you modified a configuration property, a “Confirm Cancel” window
displays. Select Save and Exit to save the changes before exiting, Exit without Save
to exit without saving the changes, or Return to Editing to continue editing the
configuration (changes are not saved).

Finish

Exit Config WBSSPI. Appears instead of the Next button if you launched Config
WBSSPI without selecting any nodes.

Next

Exit Config WBSSPI. Takes you to the “Confirm Operation” window that lists the
nodes you selected before you started Config WBSSPI. The selected managed
nodes’ configurations are updated with your changes. If you made changes to
nodes that were not selected (are not displayed in the “Confirm Operation”
window), the changes are saved to the OVO management server’s configuration,
but to make the changes to those managed node’s configuration, you must select
those managed nodes from the node bank, restart Config WBSSPI, and then exit.

Save

Save changes to the OVO management server’s configuration and continue
editing the configuration. You may also select File — Save to save your changes.

Config WBSSPI - Actions

Actions that you can perform depend upon the item that is selected in the tree and from where
you access the action. The following actions can be accessed from the Actions menu, File
menu, or by right-clicking on an item in the tree.

Action Description Selected Tree Item
Add Application Add an application server. See Add | :3 Application Servers
Server Application Server on page 134 for 9 Defaults
more information. a
<Group_Name>
3 <Node_Name>
Add Group Create a group to which you can 23 Any item in the tree
assign nodes that have common Any item in the tree
properties. See Add Group on
page 136 for more information.
Add Node Add a managed node to the Nodes 3 Any item in the tree
folder. Add Node on page 137 for Any item in the tree
more information.

The Configuration
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Action

Description

Selected Tree Item

Exit Exit the Config WBSSPI application.| :3 Any item in the tree

This action is available from the File | & Any item in the tree

menu. If any changes were made that

have not been saved, the “Confirm

Cancel” window displays.
Remove Application| Remove an application server or all | .3 Application Servers
Server/Remove ALL| listed application servers. See <Application Server Name>
App Servers Remove Application Server/Remove

ALL App Servers on page 137 for
more information.

Remove Group/
Remove ALL
Groups

Remove a WBS-SPI group or all
listed WBS-SPI groups. See Remove
Group/Remove ALL Groups on

page 137 for more information.

23 Groups

3 <Group_Name>

Remove Node/
Remove ALL Nodes

Remove a managed node or remove
all managed nodes. See Remove
Node/Remove ALL Nodes on

page 138 for more information.

3 Nodes
3 <Node_Name>

Save

Save changes to the configuration.
This action is available from the File
menu only if changes were made to
the configuration.

23 Any item in the tree
Any item in the tree

Set Configuration
Properties tab

Set WBS-SPI configuration
properties. See Set Configuration
Settings Tab on page 138 for more
information.

<Application_ Server. Name>
Default Properties

View Configuration
Settings tab

View WBS-SPI configuration
properties. See View Configuration
Settings Tab on page 139 for more
information.

23 Any item in the tree
Ef' Any item in the tree

Add Application Server

Add an application server at the global properties, GROUP, or NODE level in the WBS-SPI

configuration.

If a node contains duplicate server names (the NAME property is set to the same value), you are
prompted to set the ALTAS property (to uniquely identify each server). Refer to Property
Definitions on page 143 for more information about the ALTAS property.
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The Configuration

Before adding an application server,

for WebSphere If the WebSphere administrative server port number is the same for all
server version 4: | managed nodes, set the PORT property at the global properties level.

If the WebSphere administrative server port number is the same for a
group, set the PORT property at the GROUP level.

If the WebSphere administrative server port number is the same for a
node, set the PORT property at the NODE level

Setting the PORT property at those levels allows you to use the “Use
inherited Server Port” check box. See step 4 for more information about
this check box. Set Configuration Settings Tab on page 138 for more
information about setting the PORT property. See Configuration
Properties on page 141 for more information about the PORT property.

for WebSphere Set the PORT property to the application server’s BOOTSTRAP_ADDRESS
server version 5: | port number at the application server level of configuration (the

BOOTSTRAP_ADDRESS is unique for each server on a managed node). See
Set Configuration Settings Tab on page 138 for more information about
setting the PORT property. See Configuration Properties on page 141 for
more information about the PORT property.

To add an application server, do the following:

1

Right-click on one of the following items in the tree: Defaults (global properties level),
Application Servers (global properties level), <Group_Name> (GROUP level), or
<Node_Name> (NODE level) and select Add Application Server.

The “Config WBSSPI Application: Add App Server” window displays.

Enter the “Application Server Name.” This is the name of the application server as
defined in WebSphere and is case-sensitive.

Enter the “Server Port.”

For WebSphere server version 4, this is the bootstrap port number for the WebSphere
administrative server.

For WebSphere server version 5, this is the BOOTSTRAP_ADDRESS port number for the
application server.

If the “Use inherited Server Port” check box is selected, you may not enter a port number
in the “Server Port” field.

If available, select the “Use inherited Server Port: xxx” check box if you want to use the
specified port number (“xxx”).

If the PORT property is not set, the check box is not available.

If you do NOT want to use the specified port number, unselect the check box and enter a
port number in the “Server Port” field.

If you select the check box, you may not enter a port number in the “Server Port” field.

The specified port number is determined by the value set for the PORT property at the
global properties, GROUP, and/or NODE level:

e Ifthe PORT property is set at the global properties level, WBS-SPI is configured to use
this same port number on all nodes and groups for all WebSphere version 4
administrative servers or for all WebSphere version 5 application servers. For
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WebSphere version 5, if there is more than one application server per node, only one
server can use the inherited server port. The PORT property must be edited for the
other application servers.

e Ifthe PORT property is set at the GROUP level, WBS-SPI is configured to use this
same port number for the group for all WebSphere version 4 administrative servers or
for all WebSphere version 5 application servers. For WebSphere version 5, if there is
more than one application server per node in the group, only one server can use the
inherited server port. The PORT property must be edited for the other application
servers.

The port number set at the GROUP level takes precedence over the port number set
at the global properties level.

e Ifthe PORT property is set at the NODE level, WBS-SPI is configured to use this same
port number for that node for all WebSphere version 4 administrative servers or for
all WebSphere version 5 application servers. For WebSphere version 5, if there is
more than one application server per node, only one server can use the inherited
server port. The PORT property must be edited for the other application servers.

The port number set at the NODE level takes precedence over the port number set at
the global properties level.

Select OK.
The NAME and PORT properties are set.

The application server is added and its properties are displayed. You may also set
additional configuration properties for this server. Set Configuration Settings Tab on
page 138 for more information.

Select Save to save your changes.

If you do not want to add this application server, right-click on the application server
name, select Remove Application Server, and select Save.

Add Group

Assign nodes to a group that have common properties in the WBS-SPI configuration.

To add a group, do the following:

1

136

Right-click on any item in the tree and select Add Group.
The “Config WBSSPI Application: Add Group” window displays.

Enter the “Group Name.” The group name identifies the group of nodes with common
properties and is NOT case-sensitive.

Select OK.
The group is added and the Set Configuration Properties tab for the group displays.

Select Add Node to Group, select one node from the list to add to the group, and select OK.
Repeat this step until all nodes are added to the group.

Set the configuration properties for this group using the Select a Property to Set pulldown
list. See Set Configuration Settings Tab on page 138 for more information.

Select Save to save your changes.

If you do not want to add the group, right-click on the group name, select Remove Group,
and select Save.
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Add Node

Add a managed node to the WBS-SPI configuration.

To add a node, do the following:

1

Right-click on any item in the tree and select Add Node.

If no additional managed nodes are available to add to the configuration, the message A11
available managed nodes have been added to the configuration. displays. Click
OK to exit this action.

From the pulldown menu, select a node to add.
Select OK.
The node is added and the Set Configuration Properties tab for the node displays.

Set the configuration properties for this node using the Select a Property to Set pulldown
list. See Set Configuration Settings Tab for more information.

Select Save to save your changes.

If you do not want to add the node, right-click on the node name, select Remove Node, and
select Save.

Remove Application Server/Remove ALL App Servers

Remove a WebSphere server or all listed WebSphere servers from the WBS-SPI configuration.

To remove an application server, do the following:

1

Right-click on the application server name and select Remove Application Server.

The selected application server name is removed from the list and its configuration
properties are removed from the configuration.

Select Save to permanently remove the application server.

Select Cancel to cancel the removal of the application server (the application server name
appears the next time you run Config WBSSPI). In the “Confirm Cancel” window, select
Exit without Save.

To remove ALL application servers, do the following:

1

Right-click on the Application Servers folder and select Remove ALL App Servers.

The selected Application Servers folder and all application servers listed in the selected
folder are removed (all configuration properties for the listed application servers are
removed from the configuration).

Select Save to permanently remove the application servers.

Select Cancel to cancel the removal of all application servers (the Application Servers
folder and all application server names listed in the folder appear the next time you run
Config WBSSPI). In the “Confirm Cancel” window, select Exit without Save.

Remove Group/Remove ALL Groups

Remove a WBS-SPI group or all listed WBS-SPI groups from the WBS-SPI configuration.

To remove a group, do the following:

1

The Configuration

Right-click on the group server name and select Remove Group.
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The selected group is removed from the list and its configuration properties are removed
from the configuration.

Select Save to permanently remove the group.

Select Cancel to cancel the removal of the group (the group name appears the next time
you run Config WBSSPI). In the “Confirm Cancel” window, select Exit without Save.

Remove Node/Remove ALL Nodes

Remove a managed node or all listed managed nodes from the WBS-SPI configuration.

To remove a node, do the following:

1

Right-click on the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed
from the configuration.

Select Save to permanently remove the node.

Select Cancel to cancel the removal of the node (the node name appears the next time you
run Config WBSSPI). In the “Confirm Cancel” window, select Exit without Save.

To remove ALL nodes, do the following:

1

Right-click on the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all
configuration properties for the listed nodes are removed from the configuration).

Select Save to permanently remove the nodes.

Select Cancel to cancel the removal of all nodes (the Nodes folder and all node names
listed in the folder appear the next time you run Config WBSSPI). In the “Confirm
Cancel” window, select Exit without Save.

Set Configuration Settings Tab

Set WBS-SPI configuration properties at the global properties level or for the selected
application server(s), group(s) (GROUP level), or node(s) (NODE level).

Items with the p& icon are the only items for which you can set configuration properties
(Default Properties and <Application_ Server. Name>).

To set the configuration properties of an item, select the item and click on the Set Configuration
Properties tab in the right pane.

Setting a Property

To set a property in the configuration, do the following:

1

O A W N

Select a property from the “Select a Property to Set” pulldown menu.

Select Set Property. The property and an empty value filed appear in the table.
Click on the empty value field and enter a value.

Repeat steps 1 - 3 for each property to set.

Click on Save.

For the LOGIN and PASSWORD properties, when you select Set Property, a separate window
displays. Enter the login and password values in this window.
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See Configuration Properties on page 141 for more information about individual properties.

Modifying a Property

To modify a property (except LOGIN) in the configuration, do the following:
1 Select the property from the table.

2 Double-click on the value field.

3 Edit the value.

If a node contains duplicate server names (the NAME property is set to the same value), you
are prompted to set the ALIAS property (to uniquely identify each server). Refer to
Property Definitions on page 143 for more information about the ALIAS property.

4  Repeat steps 1 - 3 for each property to modify.

5 Click on Save.

To modify the LOGIN property in the configuration, do the following:

1 Select LOGIN/PASSWORD from the “Select a Property to add” pulldown menu.
Select Set Property. The “Set Access Info for Default Properties” window displays.
Enter the new password and verify password.

Click on OK.

g A W N

Click on Save.

See Configuration Properties on page 141 for more information about individual properties.

Removing a Property

To remove a property from the configuration, do the following:
1 Select the property from the table.

2  Click on Remove Property.

3 Repeat steps 1 - 2 for each property to remove.

4

Click on Save.

AUTO_DISCOVER

The AUTO_DISCOVER check box that appears near the bottom of the window sets the
AUTO_DISCOVER property. You can only set this property by selecting or unselecting the check
box.

Selecting the check box (default) causes the discovery templates (if distributed) to
automatically update the WBS-SPI configuration information in the service map and
configuration. If the discovery templates are not distributed, the service map is created but
not updated.

View Configuration Settings Tab

The Configuration

View all WBS-SPI configuration properties set in the configuration on the OVO management
server or the WBS-SPI configuration properties for the selected application server(s),
group(s), or node(s).

To view the configuration properties of an item, select the item and click on the View
Configuration Settings tab in the right pane.
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The following table describes the view when the specified item is selected.

Item Name Description of View

Application Servers View all configuration properties set for all the listed
application servers.

<Application_Server_Name> | View all configuration properties set for the application
server (these properties can be modified by selecting the Set
Configuration Properties tab).

Configurations View all configuration properties saved in the configuration
on the OVO management server.

Default Properties View all configuration properties that are set (these
properties can be modified by selecting the Set Configuration
Properties tab).

Defaults View all configuration properties set at the global properties
level.

Groups View all configuration properties set for all the listed groups.

<Group_Name> View all configuration properties set for the specific group.

Nodes View all configuration properties set for the listed nodes.

<Node_Name> View all configuration properties set for the specific node.

View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. By selecting
this check box, the view of the configuration properties changes to show all inherited
properties (those properties defined at a global properties level or GROUP level) that affect
the selected item. Inherited properties are denoted by “<*>” appearing after the property.

By unselecting this check box, the view shows only the configuration properties set at that
level for the selected item.

Inherited properties can only be modified at the level they are set. If “<*>” appears after the
property, the property cannot be modified at that level. For example, if the property HOME is
set at the global properties level (under the Defaults folder), it can only be modified in the
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” after
it) in a <Group_Name>'s Default Properties view, HOME cannot be modified at this level.

Properties set lower in the tree take precedence over those properties set higher in the tree.
For example, if the property HOME is set at the global properties level (under the Defaults
folder) and the property HOME is set at the GROUP level, the GROUP level property value
takes precedence.

Configuration property precedence is as follows (listed from highest to lowest:
1 Server-specific

2 NODE level

3 GROUP level

4 Global properties level
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Configuration Properties

The Configuration

Table 13 on page 142 lists all properties by WBS-SPI requirements, where:

Property Name of the property.

Requirements  Lists the property requirements for specific
components where:

R - Required: the property must be set.

C - Conditional: the property may need to be
set if certain conditions are met.

O - Optional: the property is not required for
the component to work.

blank - Not Applicable: the property does not affect
this component.

WBS-SPI Configuration requirements for the WBS-SPI to
work.

Discovery Requirements for the discover process to work.

Process

Auto-Discovered The property is automatically set by the discover

process.

Level of The level at which this property can be set within the
Configuration configuration structure.

Default The global, group, or node level within the
Properties configuration structure.

Application The server-specific level within the configuration
Server structure.

Refer to Configuration Properties on page 141 for a description of the property.
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Table 13 Properties Listed by WBS-SPI Requirements

142

Property Requirements Auto- Level of
Discovered Configuration
WBS-SPI| Discovery Default | Application
Process Properties Server

HOME. R C v v v
JAVA_HOME R v v v
NAME R v v
PORT R v v v
ADDRESS C v
ALIAS C v
AUTO_DISCOVER C v v
COLLECT_METADATA C o v v
GRAPH_URL C v

HOME_LIST C v

JMB_JAVA_HOME C v v
JMX_CLASSPATH C v v
LOGFILE C v
LOGIN C v v
PASSWORD C C v v
PROFILE_HOME C v v v
RMID_PORT C v

RMID_START TIME C v

START CMD C v
STOP_CMD C v
TYPE C v v
USER C v v
VERSION C v
MAX_ERROR_LOG_SIZE o v

TIMEOUT o v v
UDM_DEFINITIONS_SOURCE 0] v v
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Property Definitions

WBS-SPI

Property Requirements Description

ADDRESS Conditional The domain name or IP address where the server is
Required if the server |listening. If not specified, the server is listening on the
is running on a virtual primary IP of the node on which the server is running.
IP address or is on a Example: SERVER1_ADDRESS = product.hp.com
remote node

ALIAS Conditional Unique name on a managed node assigned to an

Required if more than
one application server
on a system share the
same server name

application server if more than one application server on a
system share the same server name. The alias, if set, is
the name used in messages, reports, and graphs
(otherwise, SERVER<n>_NAME is used).

If SERVER<n>_ALIAS is modified, the data for the old alias
is saved but is not mapped to the new alias.

Example:

NODE petstore.hp.com {
SERVER1_NAME=dog
SERVER1_ALTIAS=beagle
SERVER2_NAME=dog
SERVER2_ALIAS=dachshund

}

NODE flying ace.hp.com {
SERVER1_NAME=snoopy
SERVER1_ALIAS=beagle
SERVER2_NAME=snoopy
SERVER2_ALIAS=red_baron

}

AUTO_DISCOVER

Conditional

Required if you do not
want the discovery
templates to
automatically overwrite
the configuration
information

Default: AUTO_DISCOVER check box is selected.

Select the AUTO_DISCOVER check box to automatically
update the WebSphere configuration information in the
service map and configuration.

Unselect the AUTO_DISCOVER check box if you do not
want the discovery templates to automatically overwrite
the configuration information.

COLLECT_METADATA

Conditional

Required if you want to
use the MBean
Explorer in the JMX
Metric Builder
application.

Default: OFF. Enter “ON” to collect metadata (MBean
information) displayed by the JMX Metric Builder
application. The metadata is used to create UDMs (user
defined metrics).

Metadata for each MBean server is temporarily saved to
the following file: /var/opt/0OV/wasspi/wbs/
metadata/<managed node>/ <NAME / ALITAS>.xml or
/var/opt/0OV/metadata/wbs/<managed node>/

<NAME | ALTAS>.xml (UNIX) or
<%0vAgentDir%>\wasspi\wbs\metadata\
<managed_node>\<NAME | ALIAS>.xml (Windows)
where NAME and ALIAS are the properties set for the
managed node and ALIAS is always used if it is set.

The Configuration
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WBS-SPI

Property Requirements Description
GRAPH_URL Conditional The fully-qualified URL used to launch OVPM. Set at the

Required if you want to | global level only.

view graphs with Example: GRAPH_URL=http://systeml.hp.com/

OVPM HPOV_Reports/ovpm.htm (OVPM 4 on Windows)
GRAPH_URL=http://system2.hp.com:8080/0VPM/
index.html (OVPM 5 on UNIX or Windows)

HOME Required The directory where the WebSphere server is installed.
Example:
HOME = /opt/WebSphere/AppServer or
HOME = C:/WebSphere/AppServer

HOME_LIST Conditional For Windows managed nodes only. A list of WebSphere server

Required if the discover installation directories, each directory separated by a semicolon. Set

process does not find this property only if there are multiple installations of the

multiple server installations| WebSphere server on a Windows managed node that the discover
on the same node process does not find. After setting this property, run the Discover
application.
JAVA_HOME Required The directory where Java is installed that is used by the

Required if using a
Java version not

collector. The java engine is expected to be
$JAVA_HOME/bin/java.

supplied with Example: $JAVA_HOME = /opt/WebSphere/AppServer/
WebSphere java
JMB_JAVA_HOME Conditional The directory where Java (JDK 1.4.1 or higher) is

Required if you are

installed that is used by the JMX Metric Builder on the

using the JMX Metric | OVO management server. The JDK must be version 1.41
Builder or higher.
JMX_CLASSPATH Conditional The location of the jar files implementing JMX.

Required if you are

Example: SERVER]_JMX_CLASSPATH = /JMX/Sun/lib/

configuring a JMX jmxri.jar
collector
LOGFILE Conditional A comma-separated list of fully qualified filenames of
Required only if there | WebSphere server logfiles.
are WebSphere logfiles | Example: SERVER1_IOGFILE =
to be monitored that /opt/WebSphere/myserver/websphere.log
are not the default ones| sgrvER2 TOGFILE =
C: /WebSphere/myserver /websphere. log
LOGIN Conditional A WebSphere-defined user (not a system user) that is used

Required if security is
enabled on WebSphere

to monitor a WebSphere server.

Example: SERVER]1_LOGIN = janedoe

MAX ERROR_LOG_SIZE

Optional

Required if you want an
error logfile larger than
2MB

Default: 2MB. The maximum number of MB allowed for
the error logfile. When the error logfile reaches the
maximum limit, it is renamed as a backup file and logging

resumes. When a new backup file replaces an old backup
file, the old backup is deleted.

Example: MAX ERROR_LOG_SIZE = 20
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Property

WBS-SPI
Requirements

Description

NAME?

Required

The server name as defined in WebSphere. Use the
WebSphere administrative console to obtain this
information.

Example: SERVER1_NAME = exampleServer

NUM_SERVERS

Optional

The number of WebSphere servers on the managed node.
Example: NUM_SERVERS = 3

PASSWORD

Conditional

Required if security is
enabled on WebSphere

The password for the WebSphere-defined user (USER or
SERVER<n>_USER).

Example: SERVER1_PASSWORD = janedoel23

PORT

Required

For WebSphere server version 4

Default: 900. The bootstrap port number for the
WebSphere administrative server. Verify that this is the
same as the port number configured in admin.config.

Example: SERVER1_PORT = 900

For WebSphere server version 5

Default: the bootstrap port number of the application
server. The bootstrap port number for the WebSphere
application server. Verify that this is the same as the port
number listed in the administrative console.

Example: SERVER1_PORT = 2809

PROFILE_HOME

Conditional

Required for
WebSphere server
version 6

For WebSphere server version 6 only.

The directory for the application server profile
(<WebSphere Home>/profiles/default).

Example:

PROFILE_HOME = /opt/WebSphere/AppServer/
profiles/default or

PROFILE_HOME = C:/WebSphere/AppServer/profiles/
default

RMID_PORT

Conditional

Required if the default
port on which rmid
listens is already in use

Default: WebSphere Application Server 4: 9243;
WebSphere Application Server 5: 9242;JMX connector:
9241

The port on which rmid listens. By default, if an OVO
managed node is monitoring application server(s) and
MBean server(s) using the JMX connector, the SPI uses
two ports (one for the application server(s) and one for the
MBean server(s)). For example, if you are monitoring a
WebSphere Application Server version 5 and an MBean
server, the SPI uses port 9242 and 9241. If RMID_PORT
is set, the SPI uses this one port for all servers (this
property cannot be set at the application server level). For
example, if you are monitoring a WebSphere Application
Server and an MBean server and set RMID_PORT to
9250, the SPI uses port 9250 only.

Example: RMID PORT=9250
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WBS-SPI

Property Requirements Description
RMID_START TIME Conditional Default: 30 (seconds)
Required if rmid takes | The amount of time, in seconds, to wait for rmid to start

longer than 30 seconds
to start

before timing out.
Example: RMID START TIME=60

START_CMD Conditional A fully qualified system command that is run when the
Required if you want to| OVO Application Bank "Start WebSphere" application is
start the WebSphere used. This command is run by SERVER<n>_USER which
application server from | must be configured in order for the Start WebSphere
the OVO console application to work.

NOTE: This command must exit; that is, the WebSphere
process must run in the background or as a service, and it
must be protected from its parent process dying.
Example: SERVER1_START CMD = /sbin/init.d/
WebSphere start

STOP_CMD Conditional A fully qualified system command that is run when the
Required if you want to | OVO Application Bank "Stop WebSphere" application is
stop the WebSphere used. This command is run by SERVER<n>_USER which
application server from | must be configured in order for the Stop WebSphere
the OVO console application to work.

Example: SERVER]1_STOP_CMD = /sbin/init.d/
WebSphere stop

TIMEQOUT Optional Default: 120 (seconds). The maximum amount of time, in
seconds, WBS-SPI tries to connect to WebSphere. When
the specified time is exceeded, WBS-SPI sends an alarm to
the message browser indicating hat WebSphere is
unavailable. If metric 1002_ServerStatusRep is being
collected, the unavailability of the server is logged.
If no time limit is desired, set this property to -1.
Example: SERVER]1_TIMEOUT=30

TYPE Conditional Default: websphere. The type of JMX connector server.
Required if you are Set to websphere for WebSphere server version 5 and
configuring a JMX ovrmi for other JMX connector servers.
collector Example: SERVER]1_TYPE=ovrmi
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Property Requirements Description
UDM_DEFINITIONS_SOURCE | Optional Default: /opt/0OvV/wasspi/wbs/conf/
wasspi_wbs_udmDefinitions.xml. The fully qualified
path name to or file name of the metric definitions XML
file on the OVO management server. If a path name is set,
the wasspi_wbs_udmbDefinitions.xml file is the assumed
file name of the UDM file.
Example: SERVER1_UDM DEFINITIONS_SOURCE = /opt/OV/
wasspi/wbs/conf/udm.xml
USER Conditional The system username for starting and stopping the
Required if you want to| WebSphere server from the OVO Application Bank.
start and/or stop the The default is the username under which the OVO agent
WebSphere application | runs.
server from the OVO | Example: SERVERL_USER = websphere
console
VERSION Conditional Default: 4.0 0. The version number of the WebSphere

Required if you are
configuring remote
monitoring

server in the format Major# [Minor#] where:

Major# - The primary version number (for example, 4.0)
Minor# - The secondary version number (for example,
4.0.1). If Minor# is not specified, it defaults to 0.

Example: SERVER1_VERSION = 4.0 1

The Configuration
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a.

For WebSphere server version 4, the WebSphere administrative server displays the server names of all configured

application servers in a domain. Use these names when defining NAME.

|- 7]
Console View Tools Help
&9 @ | -
[=} 9 lebSphere Adwinistrative Domain | Name
B3 Virtual Hosts /|2 Installed EJE Modules
2 Server Groups A Installed Meb Modules
= B2 Hodes :
= @ dukat
B freelication Servers |
8 ‘| rGeneral Advanced |File |Transaction | JWH Settinas |Services |Custam |
3 Generic Servers B
0 Enterprise Applications Application Server name: *[Default Serwi
3 Resources

1S, uunay

Enviraonment: | Enviromment., .,

Working directory: |#opt.lebSphere/fppSerer/bin

Mode startup state: |Last state

Maxinum startup attempts: |2

Tup - o
G 1716/03 10:... Console Ready. - Options, ..
Details,,.

{

For WebSphere server version 5, the WebSphere administrative console displays the server names of all configured
applications servers. Use these names when defining NAME.

‘A websphere Administrative Console - Microsoft Internet Explorer provided by

ol =
| File Edt Wiew Faworites Took Help
GBak - = - () (2] 4 | Qloewrch [igravortss (Busoy | Th- S B - =]
| Agdrass [] http:fjrode2:9090/adminjsecure fogon.do x| @0 ||unks
Home | Save | P | Logout | Help | B[B]
User 1k admin Application Servers
OUrSUng 2
An spplication server |5 & server which provides services reguired to run erterprizs appbcstions. |1
B Sarvers
Applcabion Servers
B Applications Totat 1
B Resources [ Fiter
B Security B Preferences
B Erwironment New| Delete |
B System | — s
@ Troubisshoating o seerlet
| | [ |s=rver] node2
L
WebSphere Status [i] =Pravious Ned s February 24, 2004 T-45:06 P PST &
Total Workspace Flles 0 _O'TM Configuration Problems 0
[ Preferances
&7 pane [ [ BEvocaintrane:

b. For WebSphere server version 4, the default value configured for PORT is 900. However, if the bootstrap port num-
ber is configured in the HOME/bin/admin.config file, use the port number configured in this file. In admin.config,
search for com.ibm.ejs.sm.adminServer.bootstrapPort=<nnnnn>

For WebSphere server version 5, the default value configured for PORT is the bootstrap port number for the appli-
cation server. According to the WebSphere documentation, the port number can be found using the administrative
console: Servers — Application Servers — server_name — End Points
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Sample Configurations

The sample WBS-SPI configurations with entries contained in this section illustrate various
features and utilization methods.

Example 1: Single Node/Two Servers

The simple example below is for a single node running two servers: the administration server
and one managed server. The properties HOME and JAVA_HOME are global defaults that apply to
all servers and nodes. When the file is saved, passwords are encrypted.

HOME = /opt/WebSphere/AppServer
JAVA HOME=/opt/WebSphere/AppServer/java

NODE main.hp.com

{
SERVER1_NAME= adminserver
SERVER1_PORT= 900
SERVER1_LOGIN= system
SERVER1_PASSWORD = password

SERVER2_NAME= managedserver
SERVER2_PORT= 905
SERVER2_LOGIN= system
SERVER2_PASSWORD= password

Example 2: Multiple Nodes/Repeated Properties

The example that follows shows how you can configure a group of related systems that have
numerous properties in common. Some nodes, however, may have one or two properties that
you need to specify differently. You can address these kinds of situations in two steps:

1 Use the Add Group action in the configuration editor to name the group, specify the nodes
in it, and set the configuration properties. See Add Group on page 136 for more
information.

2 Use the Add Node action in the configuration editor to define individual node properties
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). See Add Node on page 137 for more information.

) Properties set for a node take precedence over the same properties set for a group. See
Property Precedence on page 130 for the complete order of property precedence.

In the example, the global default properties HOME and JAVA_HOME are overridden for node
europa.hp.com. Since the start commands are set to use the system init command “/sbin/
init.d/WebSphere start” which runs at system boot and starts all of the WebSphere
servers, we have configured USER to be root.
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HOME = /opt/WebSphere/AppServer
JAVA_HOME = /opt/WebSphere/AppServer/java

USER = root

— GROUP production

{

— 3

{

{

— 3

{

mercury.hp.com

venus.hp.com
mars.hp.com

jupiter.hp.com

— NODE production

SERVER1_NAME=
SERVER1_PORT=
SERVER1_LOGIN=

SERVER1_PASSWORD= password

SERVER1_ADMIN_HOST= earth.hp.com
SERVER1_ADMIN
SERVER1_START CMD= /sbin/init.d/WebSphere start

SERVER2_NAME=
SERVER2_PORT=
SERVER2_LOGIN=

SERVER2_PASSWORD= moresecret
SERVER2_START CMD= /sbin/init.d/WebSphere start

SERVER1_PASSWORD= differentlpassword
SERVER2_PASSWORD= different2password

SERVER1_HOME =

SERVER1_NAME=
SERVER1_PORT=
SERVER1_LOGIN=

SERVER1_PASSWORD= mypssword

partsserver

900
system

PORT= 900

orderserver

910
system

— NODE jupiter.hp.com

— NODE europa.hp.com

/opt /websphere
SERVER1_JAVA_HOME = /opt/websphere/java

testserver
920
system
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Example 3: WebSphere Servers with Virtual IP Addresses

This example shows how to configure WebSphere servers that use virtual IP addresses. The
property SERVER<n>_ADDRESS is set to the name or IP address where the server is listening.

NODE saturn.hp.com

{

SERVER1_HOME = /opt/WebSphere/AppServer
SERVER1_JAVA_HOME = /opt/WebSphere/AppServer/java
SERVER1_NAME= partsserver

SERVER1_PORT= 900

SERVER1_ADDRESS= juno.hp.com

SERVER1_LOGIN= system

SERVER]1_PASSWORD= mypssword

SERVER2_HOME = /opt/WebSphere/AppServer
SERVER2_JAVA_HOME = /opt/WebSphere/AppServer/java
SERVER2_NAME= orderserver

SERVER2_PORT= 901

SERVER2_ADDRESS= 15.15.1.1

SERVER2_LOGIN= system

SERVER2__PASSWORD= mypssword

Example 4: Administrative Privileges Using Same Login Information

The Configuration

The example below shows the location of the LOGIN and PASSWORD properties if this
information is used for all WebSphere administrative privileges. When the file is saved, the
password is encrypted.

HOME = /opt/WebSphere/AppServer

JAVA_HOME = /opt/WebSphere/AppServer/java
LOGIN = admin

PASSWORD = password

NODE main.hp.com

{

SERVER1_NAME = serverl
SERVER1_PORT = 900
SERVER2_NAME = server2
SERVER2_PORT = 905

NODE europa.hp.com

{

SERVER1_HOME = /opt/wbs/appserver
SERVER1_JAVA_HOME = /opt/wbs/appserver/java
SERVER1_NAME= testserver

SERVER1_PORT= 915
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Example 5: Administrative Privileges Using Different Login Information

The example below shows the location of the LOGIN and PASSWORD properties if this

information is different for administrative privileges. On the main.hp.com node, SERVER1 and
SERVER2 have separate administrative privileges. When the file is saved, the passwords are

encrypted.

HOME = /opt/WebSphere/AppServer
JAVA_HOME = /opt/WebSphere/AppServer/java

NODE main.hp.com
{
SERVER1_NAME = serverl
SERVER1_PORT = 900
SERVER1_LOGIN = serverl admin
SERVER1_PASSWORD = serverl_password

SERVER2_NAME server?2

SERVER2_PORT = 905

SERVER2_LOGIN = server2_ admin
SERVER2_PASSWORD = server2_password

NODE europa.hp.com

{
LOGIN = europa_admin
PASSWORD = europa_password

SERVER1_NAME= testserver
SERVER1_PORT= 915

SERVER2_NAME= anotherserver
SERVER2_PORT= 920
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C Applications

The Smart Plug-in for WebSphere Application Server (WBS-SPI) applications include
configuration and troubleshooting utilities.

WBSSPI Admin applications include:
e  Configure WBSSPI

¢ Discover

¢ Init Non-Root

e Self-Healing Info

e Start/Stop Monitoring

e Start/Stop Tracing

o Verify

e View Error File

e View Graphs

WebSphere applications include:
e Check WebSphere

e Start/Stop WebSphere

e View WebSphere Log
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WBSSPI Admin

The following applications are found in the WBSSPI Admin application group. These
applications require the “root” user permission, therefore it is recommended that this group
be assigned to the OVO administrator.

Additional WBSSPI Admin applications for user defined metrics (UDMs) are available with
the WASSPI-UDM-BLDR software bundle. Refer to the HP OpenView Smart Plug-in User
Defined Metrics User Guide for more information about how to install the software bundle and
the additional applications.

Configure WBSSPI

Launches the configuration editor and maintains the WBS-SPI configuration.

If you are configuring WBS-SPI for the first time, use the WBSSPI Discover tool to
automatically set basic configuration properties. Refer to Chapter 3, Configuring the
WBS-SPI for more information.

Purpose

Launches the configuration editor allowing the OVO administrator to maintain the WBS-SPI
configuration by viewing, editing, or setting configuration properties.

Function

Config WBSSPI does the following:

e Updates the configuration on the OVO management server and selected managed nodes.
e C(Creates the directories and files required by WBS-SPI on the selected managed nodes.

e Sets up data sources for reporting and graphing.

e Sets up the WebSphere server log files and WBS-SPI error log file for monitoring.

Configuration information for all WebSphere instances on all OVO managed nodes is
maintained on the OVO management server. Configuration information for a specific
WebSphere instance on an OVO managed node is maintained on that managed node (each
managed node maintains a subset of the configuration information maintained on the OVO
management server).

When saved, changes made with the configuration editor are always saved on the OVO
management server.

If a specific OVO managed node is selected when this application is launched, changes to the
configuration affecting any WebSphere servers on that managed node are automatically
saved on that managed node.

If no managed nodes are selected when this application is launched, changes to the
configuration are not saved on any managed nodes.

If a specific OVO managed node is selected when this application is launched and changes are
made that affect a WebSphere server on a non-selected managed node, the changes are saved
to the configuration on the OVO management server, but are not saved to the non-selected
managed node. You must select the affected managed node, re-run this application, and, upon
exiting the application, the changes are saved to the managed node.
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How to Run

1 At the OVO console, select the node(s) in the Node Bank window.

2 Select Application Bank.
3 In the Application Bank window select WBSSPI - WBSSPI Admin - Config WBSSPI. (If the

items do not appear, select Map - Reload.)

The “Introduction” window displays.

4 Select Next.
5 The configuration editor displays. Refer to Using the Configuration Editor on page 131 for

more information about using the configuration editor.

6 Optionally, select Save to save any changes made to the configuration. Once you save your

changes, you cannot automatically undo them.
7  Select Finish or Next to save any changes and exit the editor.
If you selected Next, the “Confirm Operation” window displays. Select OK.

If you select Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Config WBSSPI application, select Next from the configuration editor, and then select OK.

8 Ifyou have added an application server or added/edited the HOME and/or PORT properties,
run the Discover application on the managed nodes on which the application server/
properties were added or edited. Running the Discover application updates the service
map.

Discover

Applications

Sets basic configuration properties needed for discovery.

Purpose

Launches the configuration editor allowing the OVO administrator to configure WBS-SPI by
setting initial configuration properties.

Function

Discover does the following:
e Updates the configuration on the OVO management server and selected managed nodes.

Configuration information for all WebSphere instances on all OVO managed nodes is
maintained on the OVO management server. Configuration information for a specific
WebSphere instance on an OVO managed node is maintained on that managed node (each
managed node maintains a subset of the configuration information maintained on the OVO
management server).

When saved, changes made with the configuration editor are always saved on the OVO
management server.

An OVO managed node must be selected when this application is launched, and changes to
the configuration affecting any WebSphere servers on that managed node are automatically
saved on that managed node.
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If a specific OVO managed node is selected when this application is launched and changes are
made that affect a WebSphere server on a non-selected managed node, the changes are saved
to the configuration on the OVO management server, but are not saved to the non-selected
managed node. You must select the affected managed node, re-run this application, and, upon
exiting the application, the changes are saved to the managed node.

How to Run

1
2

At the OVO console, select the node(s) in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI > WBSSPI Admin and double-click
Discovery.
(If the above does not appear as described, select Map - Reload.)

The “Introduction” window displays. This window contains brief information about the
Discovery application.

Select Next.

A second “Introduction” window displays. This window displays information about which
properties may be required in order for the discovery process to work.

Read this information and select Next.

If you have not set the WBS-SPI LOGIN and PASSWORD properties, the “Configure Access
Info for Default Properties” window displays.

If you have already set the LOGIN and PASSWORD properties, the configuration editor
displays. Go to the next step.

Set the LOGIN and PASSWORD properties to the WebSphere login and password configured
in Task 2: Collect WebSphere Login Information on page 38. The WebSphere
administrative login information is required when security is enabled. If security is not
enabled, leave these fields blank, select Next, and go to step 9.

The LOGIN and PASSWORD properties set in this window are used as the default WebSphere
administrative login and password (they are set at the global properties level). That is, if
no NODE level or server-specific LOGIN and PASSWORD properties are set, this WebSphere
login and password are used by WBS-SPI for all administrative privileges. For more
information about the configuration structure, refer to Structure on page 129.

If the WebSphere administrative login and password are the same for all WebSphere
application servers on all OVO managed nodes, do the following:

a Set the LOGIN and PASSWORD properties in the “Set Access Info for Default Properties”
window.

b  Select Next.
¢ Gotostep9.

If the WebSphere administrative login and password are different for different instances
of WebSphere, you must customize the WBS-SPI configuration by setting the LOGIN and
PASSWORD properties at the NODE or server-specific level (for more information about the
configuration structure, refer to Structure on page 129):

a Set the LOGIN and PASSWORD properties to the most commonly used WebSphere login
and password in the “Set Access Info for Default Properties” window.

b  Select Customize to open the configuration editor.
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7 From the configuration editor, set the configuration properties. Refer to Using the
Configuration Editor on page 131 for more information about using the configuration
editor.

8 Select Next to save any changes and exit the editor.
9 The “Confirm Operation” window displays. Select OK.

) If you select Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Discovery application, select Next from the configuration editor, and then select OK.

Init Non-Root

Updates the /var/opt/0V/bin/instrumentation/wasspi_wbs_platdef.pmn file and
generates the wasspi_wbs_sudoers configuration file on the selected managed node(s).

Purpose

Simplifies the configuration of a non-root HT'TPS agent on a UNIX managed node (OVO 8.x
only). Refer to Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x
Only) on page 47 for all the steps necessary to configure a non-root HTTPS agent on a UNIX
managed node.

Function

Init Non-Root does the following for the selected managed nodes:

1 Runs the wasspi_wbs_perl -S wasspi_wbs_makePlatdef -force command to set the
proper SPI path configuration and updates the
/var/opt/OV/bin/instrumentation/wasspi_wbs_platdef.pm and
wasspi_wbs_platdef .prop files.

2 Generates the wasspi_wbs_sudoers configuration file.

How to Run

1 At the OVO console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin — Init Non-Root.
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Self-Healing Info

>»

Collects data to be sent to your HP support representative.

Your HP support contract entitles you to access cross-referenced information through the HP
OpenView self-healing services web site (http:/support.openview.hp.com/self_healing.jsp),
linking you to a database where similar information and subsequent problem solutions
increase troubleshooting effectiveness. Please see the SPI CD Installation Guide and the
section covering Self-Healing Services for more details.

Required Setup

If you are collecting data for a reproducible problem, do the following before running the
Self-Healing Info application:

1 Run the Start Tracing application. Refer to Start/Stop Tracing on page 161 for more
information.

2 Reproduce the problem.

Purpose

Allows the OVO administrator to collect data to be used by your HP support representative.

Function

Self-Healing Info does the following for all managed nodes:

¢ Runs and saves data using the Verify application (see Verify on page 162 for more
information).

e Recursively lists all files in the following directories:
— <OV_AGT_DIR>/bin/OpC/actions/
— <OV_AGT_DIR>/bin/0pC/cmds/
— <OV_AGT_DIR>/bin/OpC/monitor/

— <OV_AGT DIR>/wasspi/wbs/

¢ Displays the contents of the following files:
— <OV_AGT_DIR>/conf/OpC/nodeinfo
— <OV_AGT _DIR>/wasspi/wbs/conf/SiteConfig
— <OV_AGT _DIR>/wasspi/wbs/conf/SPIConfigCfgFiles
— <OV_AGT _DIR>/wasspi/wbs/conf/SPIConfigLogFiles
— <OV_AGT _DIR>/wasspi/wbs/conf/version
¢  Runs the following commands:
— opcagt -status
— codautil -obj
— <OV_AGT _DIR>/bin/OpC/monitor/wasspi_wbs_ca -m 5 -x print=on

— <OV_AGT _DIR>/bin/OpC/monitor/wasspi_wbs_ca -m 5 -x print=on -debug

Appendix C


http://support.openview.hp.com/self_healing.jsp
http://support.openview.hp.com/self_healing.jsp
http://support.openview.hp.com/self_healing.jsp
http://support.openview.hp.com/self_healing.jsp
http://support.openview.hp.com/self_healing.jsp

Applications

Copies all files in the following directories:

— <OV_AGT DIR>/wasspi/wbs/log/

— <OV_AGT DIR>/wasspil/wbs/tmp/

Copies the following files:

— <OV_AGT _DIR>/conf/0pC/le

— <OV_AGT_DIR>/conf/OpC/msgi

— <OV_AGT_DIR>/conf/OpC/monitor

— <OV_AGT_DIR>/wasspi/wbs/conf/version

On the management server, verifies the following directories exist:
— /opt/0OV/wasspi/wbs/bin/

— /opt/0OV/wasspi/wbs/conf/

On the management server, verifies the following files exist:

— /opt/OV/wasspi/wbs/bin/parseDefs.pl

— /opt/0OV/wasspi/wbs/bin/wasspi_wbs_app_graphs

— /opt/OV/wasspi/wbs/bin/wasspi_wbs_editcfg

— /opt/0OV/wasspi/wbs/bin/wasspi_wbs_1lib.pl

— /opt/0OV/wasspi/wbs/bin/wasspi_wbs_optaction_graphs
— /opt/OV/wasspi/wbs/bin/wasspi_xterm

— /opt/OV/wasspi/wbs/conf/SiteConfig

On the management server, copies the following file

— /opt/ov/wasspi/wbs/conf/SiteConfig

Self-Healing Info does the following for Windows managed nodes:

Displays the contents of the following files:
— <OV_AGT _DIR>/bin/OpC/install/opcinfo

— <OV_AGT_DIR>/conf/dsi2ddf/ddflbd.mwc

Self-Healing Info does the following for UNIX managed nodes:

Collects the following information:

— Up time

— Detailed OS version

— ulimit values

Displays the contents of the following files:

— /opt/0V/bin/OpC/install/opcinfo

— <OV_AGT_DIR>/conf/dsi2ddf/ddflbd.rc
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>»

Runs the following commands:

where

ps -ef
<OV_AGT_DIR>/bin/0OpC/cmds/wasspi_wbs_osinfo
df -k

uname -a

hostname

<OV_AGT_DIR>is:

on a UNIX managed node: /var/opt/OvV

on a Windows managed node: depends on the installation of the product

The data is saved in the following file:

on a UNIX managed node: /tmp/wasspi_wbs_support.tar

on a Windows managed node: wasspi_wbs_support.zip in one of the following
directories (the exact location is displayed):

$STEMP%

$TMP%

%SystemDrive%\temp\

C:\temp\

$temp% if JAVA_HOME or SERVER<n>_JAVA_HOME is defined
Stemp%\wasspi_wbs_support\

This file may be hidden on some Windows managed nodes. If you do not see the file,
open Windows Explorer and, from the Tools menu, select Folder Options. Click on
the view tab. Under Hidden files and folders, select Show hidden files and
folders.

How to Run

1

At the OVO console, select a node in the Node Bank window.

2 From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI - WBSSPI Admin and double-click
Self-Healing Info.

3
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Start/Stop Monitoring

Starts/stops the collection of metrics for one application server or all application servers on a
managed node.

Purpose

Allows the OVO administrator to start or stop the WBS-SPI from collecting metrics from an
application server.

These metrics generate alarms (when thresholds are exceeded) and are used to create reports
(automatically or manually generated) and graphs. The reports and graphs are used to
analyze trends in server usage, availability, and performance.

Typically, the OVO administrator would stop monitoring on a managed node if the node is not
running for a known reason (for example, the node is down for maintenance). Stopping the
monitoring prevents unnecessary alarms from being generated.

Run the Verify application to determine if monitoring is started or stopped. By default,
monitoring is on.

Function

Start Monitoring starts the collection of metrics for one or all application servers on a managed
node.

Stop Monitoring stops the collection of metrics for one or all application servers on a managed
node.

How to Run

1 At the OVO console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click Start
Monitoring or Stop Monitoring.

Start/Stop Tracing

Starts/stops the tracing of the collection of metrics.

Purpose

Starts/stops the tracing of the collection of metrics into a file. Run this application only when
instructed by your HP support representative.

Run the Self-Healing Info application to collect the file(s) created by this tool as part of the
data to be used by your HP support representative.

Function

Start Tracing saves information about the collection of metrics into a file.

Stop Tracing stops saving information about the collection of metrics.
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How to Run

1 At the OVO console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click Start
Tracing or Stop Tracing.

Verify

Verify that WBS-SPI is properly installed on the server or managed node.

Purpose

Allows the OVO administrator to verify that the WBS-SPI is properly installed on the server
or managed node.

Function

Verify does the following for all managed nodes:
¢ Prints the name and version of the WBS-SPI.
¢ Prints all environment properties configured on the managed node.

e Checks the configuration for the following configuration properties and that their values
are valid:

— SERVER<n>_HOME
— SERVER<n>_JAVA_HOME
¢ Displays a list of signals and signal handlers.
e Checks that the following directories exist:
— <OV_AGT _DIR>/wasspi/wbs/conf/
— <OV_AGT _DIR>/wasspi/wbs/datalog/
— <OV_AGT _DIR>/wasspi/wbs/history/
— <OV_AGT _DIR>/wasspi/wbs/1lib/
— <OV_AGT _DIR>/wasspi/wbs/log/
— <OV_AGT _DIR>/wasspi/wbs/tmp/
e Checks that the following files exist:
— <OV_AGT _DIR>/wasspi/wbs/conf/MBeanReports.dtd
— <OV_AGT _DIR>/wasspi/wbs/conf/MBeanReports.xsl
— <OV_AGT_DIR>/wasspi/wbs/conf/MetricDefinitions.dtd
— <OV_AGT_DIR>/wasspi/wbs/conf/MetricDefinitions.ser
— <OV_AGT _DIR>/wasspi/wbs/conf/MetricMap
— <OV_AGT_DIR>/wasspi/wbs/conf/OVTrace.sample
— <OV_AGT _DIR>/wasspi/wbs/conf/ReportsHeader.xsl

— <OV_AGT _DIR>/wasspi/wbs/conf/ReportsUtil.xsl
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<OV_AGT_DIR>/wasspi/wbs/conf/SiteConfig
<OV_AGT_DIR>/wasspi/wbs/conf/SPIConfig
<OV_AGT_DIR>/wasspi/wbs/conf/SPIConfigCfgFiles
<OV_AGT_DIR>/wasspi/wbs/conf/SPIConfigLogFiles
<OV_AGT_DIR>/wasspi/wbs/conf/trigger
<OV_AGT_DIR>/wasspi/wbs/lib/GraphSP.xsl
<OV_AGT_DIR>/wasspi/wbs/lib/JspiCola.jar
<OV_AGT_DIR>/wasspi/wbs/lib/MetricMap.xsl
<OV_AGT_DIR>/wasspi/wbs/lib/xalan.jar

<OV_AGT_DIR>/wasspi/wbs/lib/xerces.jar

Verify does the following for Windows managed nodes:

Checks that the following files exist:

Checks that the following files exist and the version is higher than A.01:

<OV_AGT _DIR>/bin/OpC/cmds/wasspi_wbs_admin.exe
<OV_AGT _DIR>/bin/OpC/cmds/wasspi_wbs_debug.exe
<OV_AGT_DIR>/bin/OpC/cmds/wasspi_wbs_spiapps.exe
<OV_AGT_DIR>/bin/OpC/cmds/wasspi_wbs_udmgraphs.exe
<OV_AGT _DIR>/bin/OpC/cmds/wasspi_wbs_verify.exe
<OV_AGT _DIR>/bin/OpC/monitor/wasspi_wbs_ca.exe
<OV_AGT _DIR>/bin/OpC/monitor/wasspi_wbs_config.exe
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_files.exe
<OV_AGT _DIR>/bin/OpC/monitor/wasspi_wbs_le.exe
<OV_AGT _DIR>/bin/OpC/monitor/wasspi_wbs_logdata.exe

<OV_AGT _DIR>/bin/OpC/monitor/wasspi_wbs_setpath.exe

<OV_AGT_DIR>/bin/OpC/monitor/ddfcomp.exe
<OV_AGT_DIR>/bin/OpC/monitor/ddfcomp_coda.exe
<OV_AGT_DIR>/bin/OpC/monitor/ddflog.exe
<OV_AGT _DIR>/bin/OpC/monitor/ddflog_coda.exe
<OV_AGT_DIR>/bin/OpC/monitor/ddfutil.exe

<OV_AGT _DIR>/bin/OpC/monitor/ddfutil_coda.exe

Verify does the following for UNIX managed nodes:
Checks that the following files exist:

<OV_AGT_DIR>/bin/OpC/cmds/wasspi_wbs_admin
<OV_AGT_DIR>/bin/OpC/cmds/wasspi_wbs_debug
<OV_AGT_DIR>/bin/OpC/cmds/wasspi_wbs_spiapps
<OV_AGT _DIR>/bin/OpC/cmds/wasspi_wbs_udmgraphs

<OV_AGT_DIR>/bin/OpC/cmds/wasspi_wbs_verify
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Checks that the following files exist and the version is higher than A.01:

where

<OV_AGT_DIR>/bin/OpC/monitor/wasspi_setpath
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_ca
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_config
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_config.pl
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_files
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_1le
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_lib.pl
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_wbs_logdata

<OV_AGT_DIR>/bin/OpC/monitor/wasspi_xterm

<OV_AGT_DIR>/bin/OpC/monitor/ddfcomp
<OV_AGT_DIR>/bin/OpC/monitor/ddfcomp_coda
<OV_AGT_DIR>/bin/OpC/monitor/ddflog
<OV_AGT_DIR>/bin/OpC/monitor/ddflog_coda
<OV_AGT_DIR>/bin/OpC/monitor/ddfutil
<OV_AGT_DIR>/bin/OpC/monitor/ddfutil_coda

<OV_AGT _DIR>1s:

on a UNIX managed node: /var/opt/0OV

on a Windows managed node: depends on the installation of the product

How to Run

1

At the OVO console, select a node in the Node Bank window.

2  From the Window menu, select Application Bank.

3

In the Application Bank window select WBSSPI - WBSSPI Admin and double-click Verify.

View Error File

View the WBS-SPI error log file.

Purpose

Allows the OVO administrator to view the contents of the error log file.

Function

View the contents of the WBS-SPI error log file <OV_AGT DIR>/wasspi/wbs/log/errorlog
where <OV_AGT_DIR> typically is:

/var/opt/0vV on UNIX managed nodes

/Program Files/HP OpenView/Installed Packages/
{790 ...} on Windows managed nodes

Appendix C



How to Run

1 At the OVO console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click View
Error File.

View Graphs

View OpenView Performance Manager (OVPM) graphs in a web browser.

Required Setup

OVPM must be installed and you must edit the ovweb. conf file (see Task 1: Configure the
Management Server to Launch your Web Browser on page 33 for more information) before
this tool can run successfully.

If you are using Netscape Navigator, use version 6.0 or higher. Do not use Netscape Navigator
4.79 with this application.

Purpose

Allows the OVO administrator to view WBS-SPI graphs in OVPM from the OVO console.

Function

Launches a web browser to display WBS-SPI metric data in OVPM graphs.

How to Run

1 At the OVO console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin — View Graphs.
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WebSphere

The following applications are found in the WBSSPI WebSphere application group.

Check WebSphere

Displays a status report for the WebSphere instance(s) on the selected managed node(s).

Purpose

Allows the OVO administrator to quickly check the status of each application server running

on a managed node.

Function

Check WebSphere displays the following information for each application server on the

selected node(s):

Information

Description

Server Name

The server name as defined in WebSphere.

Server State

The status of the WebSphere server.

Start Date

The date when the WebSphere server was started.

Port

The port on which the WebSphere server listens.

Admin Server Host

The location of the WebSphere administration server for this
WebSphere instance.

Admin Server Port

The port of the WebSphere administration server for this
WebSphere instance.

Current Open Socket Count

The number of open sockets for the WebSphere server.

WebSphere Version

The version number of the WebSphere server.

If the WBS-SPI has been configured to not collect metrics for a WebSphere server, the
message Collection is temporarily OFF for <server_ name>is displayed.

How to Run

1 At the OVO console, select a node in the Node Bank window.

2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WebSphere and double-click Check

WebSphere.
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Start/Stop WebSphere

Starts/stops a WebSphere application server from the OVO console.

Required Setup

The START CMD, STOP_CMD, and USER configuration properties MUST be set before this tool
can run successfully.

Purpose

Allows the OVO administrator to start and stop a WebSphere application server from the
OVO console. The OVO administrator can start and stop an application server or all
application servers on the selected managed node(s) and does not have to log in to each
WebSphere Administration Server to perform these functions.

Function

Start/Stop WebSphere starts or stops an application server or all application servers on the
selected managed node(s).

How to Run

1 At the OVO console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WebSphere and double-click Start
WebSphere or Stop WebSphere.

View WebSphere Log

View the WebSphere server log files.

Purpose

Allows the OVO administrator to select a WebSphere server log file to view without having to
log in to the system on which a WebSphere server is running.

Function

View WebSphere Log does the following:

e  When View WebSphere Log is run without entering a parameter, a numbered list of
available log files for a managed node is presented.

e  When View WebSphere Log is run with a parameter entered, if the parameter is not valid
(a non-numeric value is entered or the number entered does not correspond to the list of
available log files), a numbered list of available log files for the managed node is
presented.

e  When View WebSphere Log is run with a valid parameter, the contents of the
corresponding log file for the managed node is presented.
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You may only enter one numeric value in the parameter field. This is the number used to
designate the log file to view for all managed nodes selected. Select one log file per managed
node to view each time you launch the application.

If you keep the Application Status window open and re-launch the application, the output in
the Application Status window accumulates.

How to Run

1
2
3

10
11

12
13

14
15

At the OVO console, select a node in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI - WebSphere and double-click View
WebSphere Log.

Select the managed nodes on which you want to view the WebSphere server log file.

Select Launch. The Edit Parameters window appears. If you know the number of the log
file you want to view, enter it into the Parameters field. Otherwise, leave this field blank
to list available log files to view.

Select Launch. The Application Status window displays.
In the Launched Applications field, check the Status of the application for each node:
e Started/Starting - The application is running.

e Succeeded - A list of available log files to view displays. Highlight the node in the
Launched Applications field and scroll through the Application Output field to view
the list of available log files.

e Failed - The tool did not succeed. Highlight the node in the Launched Applications
field and scroll through the Application Output field for more information about the
problem.

Double-click on View WebSphere Log.
Select the managed nodes on which you want to view the WebSphere server log file.
Select Launch. The Edit Parameters window appears.

In the Parameters text box, enter the number of the log file you want to view. Only one log
file can be selected.

If you do not remember the number of the log file, go to the Application Status window,
highlight the node in the Launched Applications field, scroll through the Application
Output filed to view the list of available log files, and enter the number of the log file you
want to view in the Edit Parameters window.

Select Launch.

In the Application Status window, highlight the node on which to view the selected log file
and scroll through the Application Output filed to view the log file.

Repeat steps 8-11 for each log file you want to view.

Select Close to close the Application Status window.
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Index

A

actions
customizing, 50

Add Application Server action, 133, 134
Add Group action, 133, 136

adding
nodes to WBS-SPI node group, 44

Add Node action, 133, 137
ADDRESS property, 143
ALIAS property, 143
annotation reports, 63

Application Bank
reports, 17

application bank
reports generated, 64

applications, 15, 153
Check WebSphere, 16, 166
Configure WBSSPI, 154
Config WBSSPI, 16
Deploy UDM, 18
Discover, 16, 42, 155
Gather MBean Data, 18
Init Non-Root, 16, 157
JMX Metric Builder, 18
Self-Healing Info, 16, 158
Start Monitoring, 16, 161
Start Tracing, 16, 161
Start WebSphere, 16, 167
Stop Monitoring, 16, 161
Stop Tracing, 16, 161
Stop WebSphere, 16, 167
Trace JMB, 18
UDM Graph Disable, 18
UDM Graph Enable application, 18
Verify, 16, 162
View Error File, 16, 164
View Graphs, 16, 165
View WebSphere Log, 16, 167
WBSSPI Admin group, 15
WBSSPI Reports group, 17
WebSphere group, 16

application server
verifying status, 37

Application Servers tree item, 132
Application Servers view, 140

assigning operator responsibilities, 26, 34
AUTO_DISCOVER, 139
AUTO_DISCOVER property, 143

automatic action reports, 13, 63

B
bundles, 22

C
Cancel button, 133

Check WebSphere application, 16, 166
how to run, 166
what it does, 166

CODA
using, 68

collecting
WebSphere login information, 38

collection intervals
changing, 55
changing for selected metrics, 56

collector templates, 19

conditional properties
configuring, 46
requirements, 46
setting, 46

configuration
properties, 141
structure, 129
syntax, 129

configuration editor, see Config WBSSPI application
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configuration example Config WBSSPI application, 16

different login information, 152 actions, 133

global defaults, 149 Add Application Server action, 133, 134
global login information, 151 Add Group action, 133, 136

group and node properties, 149 Add Node action, 133, 137

single node/two servers, 149 Application Servers tree item, 132
virtual IP addresses, 151 Application Servers view, 140

configuration files AUTO_DISCOVER, 139
location, 127 buttons, 133
Cancel button, 133

Configurations view, 140 Configurations view, 140

Configuration tree item, 132 Configuration tree item, 132
Configure WBSSPI application, 154 Default Propert}es ttjee item, 132
how to run, 155 Default Prope‘rtles view, 140

what it does, 154 Defaults tree item, 132
) Defaults view, 140
configuring, 33 Exit action, 134
conditional properties, 46 Finish button, 133

managed nodes, 37

Groups tree item, 132
management server, 33, 39

Groups view, 140

OVPM, 33 modifying a property, 139
ovweb.conf, 33 Next button, 133
prerequisites, 33 Nodes tree item, 132
remote systems, 60 Nodes view, 140

Remove ALL App Servers action, 134, 137
Remove ALL Groups action, 134, 137
Remove ALL Nodes action, 134, 138
Remove Application Server action, 134, 137
Remove Group action, 134, 137

Remove Node action, 134, 138

removing a property, 139

Save action, 134

Save button, 133

Set Configuration Properties tab, 134, 138
setting a property, 138

tree, 131

using

View Configuration Settings tab, 134, 139
View Inherited Properties, 140

creating
template groups, 57

customizing
creating new templates, 57
metrics, 14
templates, 49, 52
thresholds for different servers, 56

customizing template groups, 14

customizing templates, 14

D

data collection, 11
data interpretation, 12

Default Properties tree item, 132
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Default Properties view, 140
Defaults tree item, 132
Defaults view, 140

Deploy UDM application, 18

Discover application, 16, 42, 155
how to run, 156
setting LOGIN and PASSWORD, 42
what it does, 155

discovery process
verifying, 43

discovery template, 19
displaying graphed metrics, 33

distributing
templates, 44

duration
customizing, 50

E
enabling PMI, 39

error logs
location, 127

error messages, 87 to 125
undocumented, what to do, 125

Exit action, 134

F
filesets, 22
Finish button, 133

G

Gather MBean Data application, 18
global properties, 129
GRAPH_URL property, 144

graphs
example, 73
metrics used to generate, 74
OVPM, 67
pre-defined for OVPM, 74

GROUP block, 129
Groups tree item, 132

Groups view, 140

H
HOME property, 144

Init Non-Root application, 16, 157
how to run, 157
what it does, 157

installing, 21
bundles, 22
filesets, 22
report package, 69
software requirements, 21
swinstall, 21

instruction text, 12
location, 12

J

JAVA_HOME property, 144
JMB_JAVA_HOME property, 144
JMX_CLASSPATH property, 144
JMX Metric Builder application, 18

L

license count, 66

limitations
remote systems, 62

logfile monitoring
remote systems, 61

LOGFILE property, 144
logfiles templates, 19

LOGIN
setting, 42

LOGIN property, 144

M

managed nodes
configuring, 37

management server
configuring, 39

MAX_ERROR_LOG_SIZE property, 144

MeasureWare
using, 68

message browser messages, 12

messages
instruction text, 12
message browser, 12

message template, 19

message text
customizing, 50
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metrics prerequisites
customizing, 14 configuring, 33
data collected, 11 PROFILE_HOME property, 145
graphs generated from, 74

modifying collections in the collector template, properties, 141
53 global, 129

listed by WBS-SPI requirements, 142
precedence, 130
server-specific, 130

OVPI reports generated from, 72
Reporter reports generated from, 70

metrics templates, 19

modifying R
collection intervals, 55, 56

templates, 14 reinstalling

o templates, 63
modifying a property, 139
remote systems, 58

configuring, 60
limitations, 62
N logfile monitoring, 61

NAME property, 145 overview, 59
requirements, 58

Next button, 133

NODE block, 130

Nodes tree item, 132

Nodes view, 140

NUM_SERVERS property, 145

monitor templates, 19

Remove ALL App Servers action, 134, 137
Remove ALL Groups action, 134, 137
Remove ALL Nodes action, 134, 138
Remove Application Server action, 134, 137

Remove Group action, 134, 137

(o) Remove Node action, 134, 138
ov.envvars.sh, 33 removing
. . swremove, 23
OV_CONF environment variable, 33 WBS-SPI, 22
OVPA,. 67 removing a property, 139
using, 68
Reporter
OVPI pre-defined reports, 70
pre-defined reports, 72 using, 69
OVPM

. . . Reporter reports, 13
integrating with WBS-SPI, 33, 73

pre-defined graphs, 74 report package
b ¢ installing, 24, 69
ovweb.con
reports

configuring, 33

OV_CONF environment variable, 33 anno.tati.on, 63
application bank, 64

Application Bank generated, 17

P automatic action, 13, 63
PASSWORD generated from alarms, 17
setting, 42 generated from HP OpenView Reporter, 70
PASSWORD property, 145 generated from OVPI, 72
HP OpenView Reporter, 13
PMI included, 13
enabhng, 39 metrics used to generate in OVPI, 72
metrics generating WBS-SPI Reports, 64 metrics used to generate in Reporter, 70
template groups level, 19 OVPI, 67
PORT property, 145 pre-defined for OVPI, 72

pre-defined for Reporter, 70
Reporter, 67
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reports (automatic action)
how they are generated, 63

requirements
remote systems, 58

resetting thresholds, 52
RMID_PORT property, 145
RMID_START _TIME property, 146

S

Save action, 134
Save button, 133

Self-Healing Info application, 16, 158
how to run, 160
required setup, 158
what it does, 158

server-specific properties, 130
Set Access Info for Default Properties window, 42
Set Configuration Properties tab, 134, 138

Set Configuration Settings tab
AUTO_DISCOVER, 139
modifying a property, 139
removing a property, 139
setting a property, 138

setting a property, 138

severity
customizing, 50

software requirements, 21
START_CMD property, 146

Start Monitoring application, 16, 161
how to run, 161
what it does, 161

Start Tracing application, 16, 161
how to run, 162
what it does, 161

Start WebSphere application, 16, 167
how to run, 167
what it does, 167

STOP_CMD property, 146

Stop Monitoring application, 16, 161
how to run, 161
what it does, 161

Stop Tracing application, 16, 161
how to run, 162
what it does, 161

Stop WebSphere application, 16, 167
how to run, 167
what it does, 167

structure
configuration, 129

swinstall, 21
swremove, 23

syntax
configuration, 129

T

tag option
creating custom template groups, 57

template groups
changing collection intervals, 56
creating, 57
creating with tag parameter, 57
customizing, 14
PMI level, 19
WBSSPI Discovery, 19
WBSSPI-Logfiles, 19
WBSSPI-Metrics, 19
WBSSPI-Monitors, 19

templates, 18
collector, 19
continuously setting, 52
customization, 14
customizing, 49, 52
customizing actions, 50
customizing duration, 50
customizing message text, 50
customizing severity, 50
customizing thresholds, 50
discovery, 19
distributing, 44
logfiles, 19
message, 19
metrics, 19
modifying, 14
monitor, 19
reinstalling, 63
resetting thresholds, 52
thresholds without reset, 52
WBSSPI-Messages, 19

thresholds
customizing, 50
resetting, 52
settings for different servers, 56
without reset, 52
TIMEOUT property, 146
Trace JMB application, 18

TYPE property, 146
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UDM_DEFINITIONS_FILE property, 147
UDM Graph Disable, 18

UDM Graph Enable, 18

uninstallilng, 22

unsupported platforms, 58

upgrading, 25
management server, 26
WBS-SPI report package, 30, 31
WLS-SPI report package, 24

user defined metrics
graphing, 83
USER property, 147

using
Config WBSSPI application

V'

Verify application, 16, 162
how to run, 164
what it does, 162

verifying
application server status, 37
discovery process, 43

VERSION property, 147

View Configuration Settings tab, 134, 139
View Inherited Properties, 140

View Error File application, 16, 164
how to run, 165
what it does, 164

View Graphs application, 16, 165
how to run, 165
required setup, 165
what it does, 165

View Inherited Properties, 140

View WebSphere Log application, 16, 167
how to run, 168
what it does, 167

virtual IP addresses
example configuration, 151

w

wasspi_wbs_ca command, 53
parameters, 54
tag option, 57
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WBS-SPI
capabilities, 11
components, 15
concepts, 11
overview, 12
removing, 22

WBSSPI Admin application group, 15, 154
WBSSPI Discovery template group, 19
WBSSPI-Logfiles template group, 19
WBSSPI-Messages template, 19
WBSSPI-Metrics template group, 19
WBSSPI-Monitors template group, 19

WBS-SPI node group
adding nodes, 44

WBSSPI Reports application group, 17
WebSphere application group, 16, 166

WebSphere login information
collecting, 38
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